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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.

1-1 ORACLE



1.4

1.4.1

When you invoke the application, the Sign In screen is displayed.
ORACLE: B O

Financial Services Lending and Leasing

sign In

Please enter userid and password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
o Left Pane

1-2 ORACLE



e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

DashBoard
4 Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

About

Orade Financal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1885,2017, Oracie andior fs afflstes. Al ights reserved.

Oracle and Java are registered trademarks of Oracke andlor s af flates. Other names may be trademarks of ther respective owners.

property laws. Except as expressly permited in your lense agreement or albowed by law, you may not use, copy, reprodce, ranslate, broadcast, modify, license,
transmi, distribute, exhibd, perform, publish or display any part in any form, o by any means. Reverse engineering, disassembly, or decomplation of tis software,
unless required by law for nteroperabifty,is prohibted.

The information is subject Ifyou find any errors, please report them o us in wriing.

that U, Government or behalf of the U S. Govemment, the following notice s
appicatle:

U.S. GOVERNMENT END USERS: g tem, any. hardware, andior
documentation, delivered o U.S. - Jation and agency-
‘specific supplemental reguiations. As Such, use, duplication, disclosure, modificaton, and adaptation of the programs, including any operating system, inegrated
software, any programs installed on the hardware, and/or documentation, shal be Subject o icense terms and icense restrictons applicable to the programs. o
other rights are granted to the U.S. Government

hardware is ger na variety r use in any inherently
dangerous applications, including appiications that may create a risk of personal inury. i you use this software or hardware in dangerous applications, then you shal
be responsibe totake all appropriate faisafe, backup, redundancy,
liabity for any damages caused by use of this Software or hardware in dangerous appiicafions.

may information on content, products and services from third parties. Oracle Corporation and ts
y respect o third-party content, products, and services. Oracle Corporaton and
s affilates wil not be responsile for any loss, costs, or damages incurred due o your access to or use of ird-party conten, products, or Services.

[ Gose |

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

ibility [ GO

Change Password

m  UserInfo i

— Change Password — Click to change the current password.
=~ A - o O]

vt
-
L v
-
men

[T——

FE

"’il
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone  JSER TIME ZONE v
Division US01 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
) st Branch Time TIME)
Responsibility SUPERUSER e
GL Post Date 02/10/2016 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|3 Submit | 3E Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on := List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
Batch Jobs  Jobs | Services Database Server Log Files | Parked Transactions | Users A
Database Server Log Files
View v Format~ Freezz i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 lob 5706 02/18/2016 06:14: 11 AD »
ALERT lob 395 02/22/2016 03:59: 16 AN_|
CSYPRC_EN_100_01 DB12C_3794335 lob 6390 02/22(2016 04:53:00 AP =
CSVPRC_EN_100_01 DB12C_3854338 lob 116750 02/22/2016 05:36:42 A}
JSYPRC_EN_000_01_DB12C_2094362 lob 5708 02/18/2016 10:57:09 AP =
e = ‘ :
r
File Content
View = Format v Freeze & Detach &l Wrap o0} 7 Beginning @) End  # of Lines ' 50 [E] show File
Text i
0
o cmnsyp_cl_000_D1.get_syp parameter value value: weblogic
o

: 45:FLL:1v_use BI::¥ [
cunsyp_cl_| get_syp parameter value value: http://ofss2221142.in.oracle.com:.

cmnsyp_cl_ .get_syp_parameter_value valus: http://ofss2221142.in.oracle.com:

emnsyp_cl_

cunsyp cl 000 Ol.get syp parameter value parameter: JSV BI USER
J5V_REPORT_ARCHIVE_DIRECTICRY
JSV_REPORTS_SERVER_TIMECUT

1.get_syp parameter value value: /scratch/work area/DEV/QA143REL/r.. |~
cmnsyp cl_000_0l.get syp parameter_value parameter

o oo oo

: cmnsyp_cl_000_01l.get_syp_parameter value parameter:

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
e Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.
e Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and < to collapse them.

> DashBoard
> Origination
Servicing
Eles 5
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions

m

Account Documents d
Collateral Management
Reparts
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions -
> Collections
> WFP
» Tools

> Setup
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the

tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is

displayed in the main window/work area.

ORACLE’
Financial Services Lending and Leasing

A @8 | Access

Appiication Documents (Crigination)

»» Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

Application Retrieval(Criginator) Data | Sceen | Reports || Correspondence | Transaction

Asset Types(Setup Products) —

Account Documents(Servicng) e Freese Efipetadh
Beess e ey d Organization Division

AP Transactions(Servicng Interfaces) e ot

Applcation Entry(Origination) e e

Audit Tables{Setup System) B B

Advances(Servicing Batch Transactions) = e

Company Branch Alowed

AL
AL
AL
AL

(3] Close:

add | ZEdt | Fvien || o Audit

ALL
ALL
AL

i
2
Y
AL Y

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,

you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left

pane, system displays the corresponding screen in the right pane.

RACLE
Financal Services Lending and Leasing

Sales Lead x

/'Le;aknl’l’v Follow-up | Maintenance
g Fresze

Applicant Information

> DashBoard

L-00003002 121772015

Te
CAR/MOBILE PHONE

a0 | P | Elwew || & avae

HowE UNITED STATES

e |[ Z e ][ Blyew || o aui

Phone Current
(0015323123 ¥

ORACLE



You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ol

RACLE"
Financial Services Lending and Leasing
el

2 Edt || Elview || & avsie

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications at the same time as separate tabs in the right
window, provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'="Y’
in MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Applications in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Origination Module Master
Tab. In the Left Menu of Origination Module Master Tab, you can open multiple applications
by clicking on the following links. Each successive click, opens a new Origination tab.

e Simple Application Entry
e Application Entry

e Underwriting

e Funding

ORACLE’
Financial Services Lending and Leasing

a‘| Origination x || Origination x | Grignation x | Origination x (36 Close
Search/Task  Funding: 0000001010  Review Requests (Pending: 0) o
> DashBoard
Origination Application: 0000001010: MILLEN JOHN Elven || o2 pust
- - Freeze {fiDetach Vi v Wam v
r— View = Format B o P W overide ok jarning OK MANUAL Contract
ot Ap = Sub Unit Status nanasen SE8E  produce Name mrd‘::fr COMBEL e geting Customer  Dupicate Appication Cantact 3
imple Application Entry

07/25/2016 0000001010 UNDEFINED APPROVED - FUND... FUNDED MN-00004:SOUT.. (612)451-2211 N E
Applcation Entry < &

»
Undernriting
Funding
Application Retrieval
Sceruaris Ans Summary | Appicant | Request | Decision | Contract | Colateral | Comments | Trackng  Document | Verification | Correspondence | Tools
Application Documents
Image Mantenance Appicaat
Reports
Producers Applicant
weswda “« Relation Type First Name LastName Brth Dt Oun fRented
2| PRIMARY JoHN MILLEN 07/17/1991 UNDEFINED
Ratios
Ratios
Grade Score What IfPmt Amt Assets Amt Lisbilties (- Net-Worth Amt
> 0 0.00 0.00 0.00 0.00
Bureau
> Servicing
> Collections Bureau
> WFp Bureau Report Name FICO Score Tradelnes # Auto Tradelines & P B Notces (LIFE)  Type ot
> Tools i ee CREDIT REFORT ... JONATHAN JENKINS 536 = B o 0 MANUAL 07/26)
> Setup El . ;
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Few screens in Origination are identical and are linked. Hence, when multi tab option is not
enabled, you can open only one screen at a time from the group. A sample of the grouping
structure is given below, based on stages of the screens:

Origination:
e Simple Application Entry
e Application Entry
e Underwriting
e Funding

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.
Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |:to toggle the view of Right Splitter/Action Window.

Origination Screens
In Origination > Application screens, you can use the Right Splitter/Action Window to do the

ORACLE" ) ) 3 Welcome, VAVAIDVA +  pccessivitty  ENETEIGN] ©
Financial Services Lending and Leasing
fose
e Origination x 3L
. Search/Task | Funding: 0000000378 Review Requests (Pending: 0)
origination '9: L 5 Quick Search
Application: 0000000378: TIFFANY RUSSEL / GRACE B view | o auit B

Vieww Format~ B 1] Freeze i Detach wap | @) OvemdeOK ¥ WamingOK ¥

Origination Stage

uplicate
oo Contact:

ou %
Applicaton S sibmit [ @ cea
01/01/2012 0000000378 UNDEFINED /APPROVED - FUNDED FUNDED GA-00004 : ADVANCE LEA. N N

Pre
3 app Sub Unit Status Producer Name Co Evisting Customer
i

» Summary
Requested  Approved
1500000 15,000.00
8.9900 49900
36 3

Summary | Applicant | Request || Decision || Contract | Collateral | Comments | Tracking | Document || Verfication | Correspondence | Tools

Vendors

> Applicant

‘ > Ratios

» Bureau
Queue FUNDED APPLICATIONS QUELE
b Checklist Change Status

Status APPROVED - FUNDED

Collateral

Collateral
Asset Type SubType Primary  Year Hake Model Hileage Hew Wholesale Value
~ Servidng VEHICLE car # 2012 CHEVROLET MONTE CARLO on 10,000.00

> Collections Tie v

3 Sub v
RWER. Trade-Tn ™

* Comment

Add Comment
= Alert

> Tools

> Setup Trade-In

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
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Servi

cing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

ORACLE
Financial Services Lending and Leasing
Customer service (e
search
Quick Search
Account(s): 20170100010097: Elyen | Pt s
Veww Fomate B ||Feee Eiveh o @ @ O CurentShonAlO Grow Falowen
oo s Subunt sccount + Frodct Dayspastoue Gurency PayOffAnt  Amuntue Satus Odestouent  DiQResson
sox usq UOEIED | 00100010057 | LOAN VEHICLE ) 270 15,8155 20,21 (ST N 020017 1STPAYMENTORL
(B st | [ Qe
Summary | Colectons | Custumer Sevee | AccountDetals | Cutomer etals | Cstomr refrences | Transacn istory | Ptiodes | Garknotcy | Repofroredonre | Defoency | Colstrsl | ureau | Timene | CrossUp Sl Acites | Extems Inefaces
3]
At Conditons
[ tiet Accont
Rerts Conditions
Hert AccauntCondien ConditonStartD Folowip 0t .
N — T (b e ezt
o dta to deplay REpOSSESSION capzz0t oejarmi
oanquen cmpy osjem Add Comment
Type RECULAR =
STy =
Account Detais Other nformation B
Dues Colateral Information
opomy oy ooy osiopn  osiop prmsry Desarpton Methcston s Yew  AsetChm  AsmetTpe  SbTpe
g 003 003 3 o 155012 v DECEROETHONECARLO DR BAGPASGIRIAZ2 2006 NEW Wi om
Customer Information B rostgoment | | @ Cear
“““““  Name Relaten s Natonsi D st Gender Add Call Activity
00000, MADHANORACLE PRmRY w0 oopsises | woemed e =
=
DM SRSIGHAL COM v . =
N =
N
Colecor DEMOCOLL
Address Information =
nnnnnnn
Tee  Gment TS g addess hane )
v vy Y snemokmasnm ses 337 &
]
Employment Information
Brestcalaciy | [ @ dex

The h

Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search
and listed in Queue Assignment section.

Use Add Comment section to post an alert or comment based on Type and Sub Type.

Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

eight of Header and width of the Left and Right Panes do not change, with resizing of

application screen.

The s

ystem facilitates toggling Header and Left and Right Panes of the home screen to

increase the visible area of the screens. Click =u to toggle upper pane and j to toggle left

pane.

To un-toggle click == and |: respectively.
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Time Zone Preference

Oracle Financial Services Lending and Leasing %
User Info
Organization DMC Time Zone |JSER TIME ZONE v
Division S0 Level
First Hame VARSHA User Time Zone UNDEFINED
Last lame VAIDYA Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)

Responsibility SUPERUSER Zone

G Bost Lere IR 20 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT b skin Family Skyros (Default) il

Debug Enabled Ind

DE Submit || ¥ Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e In the Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.
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To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

1.4.2 Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘Sea\ch Customer Service: 20120200010231 Pmewﬂeque:t‘\?endmg:0)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE Ely\w.' o Audit

View Formatv (5 Freeze fDetach | ¢ Wrap W & @ curent O ShowAll O Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Uso1 USR1 UNDEFINED 2012020010231 LEASE VEHICLE 0 USD. 0.00 0.00 ACTIVE 02/10/2015

‘Eunr\'al‘f Customer Service  Account Details | Customer Details | Transaction History | Pmt Modes =~ Bankmuptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\u::,‘bpSEHAftmliE:‘

‘CallAdi\lilies Maintenance ~ Comments Promises = Checdists Tracking Attributes ~ References  Correspondence  Letters  Document Tracking

Call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Adtion Result Contact Reason Cancel Promise Dt Promise Amt. Condition Appointr Follovup D Time Zone Adj Followup Dt Cor
AT PH ANSWERING MACHINE N 12/30f2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
AT P ANSWERING MACHINE N 123002015 1,000.00 NONE N 127302015 12/29/2015 12:30:00 P

b

You can click # to view the hidden tabs, if any.

1.5 Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations
e Basic Actions
e Personalization Options

1.5.1 Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
e Audit

e add | A Edit | S view | o Audit
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1.5.2

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

E Save and Add

E Save and Stay

E Sawve and Return

{3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.
')

Click to navigate to the previous record.

= [F[E

Click to navigate to the next record.

Click to navigate the last record.

A

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬁ' Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

Columns ’ Show Al

|  Freez= + Product |
Detach + Description |
Sort v ¥ StartDt
Reorder Columns... + End Dt

+ Direct
+ Enabled

Query By Example

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| =
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column =

Column DESCRIPTION

width | 100 ] [Pixels  [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format’ Freeze i Detach o1l Wrap 0
¢ i i G| B [
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options Description

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

loan  lne  lesse
Product Definition dpadd | Sedt | Evew | Lot
view - [Faimats] | B | [Freee ffivetach | [EIWRBN | @ NewProduct Create Copy
! I | | |cotiateral Sub Tyoe |CreditBureau
Jproduct et Jenao [prea |Fextle Repayment |enabied Jocdateraype  |cotatera subype [hedtBuens |
o+ LOANHOME () p1/01/1800 12/31/4000 B 12 Y 'HOME COLLATERAL  REAL PROPERTY HOM INSTALLMENT
LOAN SECLRED
LOAN-SG 12/31/4000 N N Y HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
LOAN-UN i &1 /01/1800 12/31/4000 Y Y Y UNSECURED COLLATIUNSECURED INSTALLMENT
LOAN-VE LOANVERICLEFR)Y p1/01/1800 12/31/4000 N Y La VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MDP1 MOP1. 3/08/1863 12/31/4000 Y N id VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA ) A LMY 1/01/1800 03/13/2013 Y N Y HOME COLLATERAL REAL PROPERTY HON INSTALLMENT
s NORMDSER. 3/11/1853 12/31/3000 v N v UNSECURED COLLATIUNSECURED INSTALMENT
o1 e 1oy/201 12/31/000 v N v HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

View Last (2 1Day (7 1 Week(©) 1Month @) By Date  StartDt  07/01/2017 I'_?'@ EndDt 09/20/2017 E"@ &

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt’ and ‘End Dt fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.

Detach
oRACLE
Financial Services Lending and Leasing

> DashBoard % SN PR % [® Close
 Origination Search | C1 : quest (Pending: 0) .
Servicing
Senvcing Account(s): 20120200010231: YUTAKA OZAKA / AKANE Bl view | «2 Audt
F— Viewv Fomaty [ [[lFrecze Gfivetach Jwap @ & © Curent O ShowAll O Group Follow-up
Securitization Company Branch Sub Unit Account Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Authorization usot Usk1 UNDEFINED 0120200010231 LEASEVEHICLE 01D 000 0.00 ACTIVE 02j10/2015

Post Date Checks
Escrow Transactions =
i Summary || Customer Service | Account Details | Customer Details | Transaction History | PmtModes || Bankuptcy | Repo/Foreclosure  Deficiency  Collateral | Bureau | Cross/up Sell Activiies
ccount Documents

Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence  Letters Document Tracking
Repoits
Producers i i
Veridors Transaction Batch Information P add | AEdt | B view | o Auit
Batch Transactions View~ Formatv [ Freeze 5 Detach Wrap o Frrost [ vod
s Date Honet Transaction status Batch
02/10/201 'ADD CUSTOMER ADDRESS PHONE POSTED N
AT TTS015 v TERMINATE ERROR ]
Iterfaces 01/06/2016 v TERMINATE vom N “
P Trancact 01050016 EXTENSION vom "
Detached Table %
View~| Format v [ Freeze (DR vap @ ot [5hvoid
Date Honetary Transaction Status Batch
02/10/2016 N ADD CUSTOMER ADDRESS PHONE POSTED N
01/07/2016 Y TERMINATE ERROR N
01/06/2015 Y TERMIATE vom ]
01/06/2016 Y EXTENSION Vo N
12/242015 Y PAYOFF QUOTE LEASE POSTED N
View~ Formatv [ Freeze Gl Detach wep @
> Collections Transaction Processing Details
>wee ||| | W= Direct Record Update, Transaction Posting Successful **++%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:
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e Drop-down list — Provides the selection option. You can either select a record from the

list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal

drop-down arrows, thus enabling easy identification.

ORACLE"
Financial Services Lending and Leasing

= Welcome, VAVAIDYA v Accessibility o

c

> Callections
> WFP

No data to display.
> Tools

EiSehp Result

Transaction Batch Information

Close
Ereee Customer Service x [
S Orgmation seach | @ : # Request (Pending: 0)
Servicing
cenicing Account(s): 20151200010012; MADHU BOBBURT Elview | <2 audt
Viewv Formatv Freeze 4 Detach Nrap @ & ©curent O showall O Group Follow-up
Company Branch sub Unit Account = Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
ust ustQ 2015120004012 LOAN VEHICLE (FR) S031881 EEEEN s crive:oeLo:non erro... BRI
Post Date Ched
Estioy Iiaiuat Summary || Customer Service | Account Details | Customer Details | Transaction History | Pt Hodes | Bark RepoForedos
e Summary || Customer Service || Account Details | Customer Details || Transaction Hitory | Pmt Hodes || Bankuptcy | RepojForedos o _ 41—
Collateral Management
& Call Adtivities Maintenance Commen ts | Promises | Checklists | Tracking Attributes | References || Correspondence || Letters [ Jgenrch H
® a1 D any
Transaction Batch Information ke cod b add | Edt || B view | & audit
View~ Format - recze etac 1 wrap £ pos Void
=3 F glivetach ¢ ) [} i Bost g Vai eription
Date Wonetary Transaction AGCO\RT Ci e 3
e cooumsuTRATER focralld =
‘ 25/ v ACCOUNT SUB UNIT TRANS apausTH
s search
A sactions 01/07/2016 N ACH ONE TIME PHONE PAY o il i A
/ ADIUSTI Match @ All © Any
G Transactions /1502015 Y ADJUSTMENT TO ADVANCE / PRINCIPAL - ADD Spalial
c 5

| [ Reset | [ AddFields || Reorder

Date 02/10/2016
* Monetary (@

oK || Cancel

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this

Basic Click ‘Basic’ for normal search.

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual

ones.
| * Channel | WEB ENTRY = * Producer Name [
NY-02 ¢ PR : HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR B 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
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1.6

1.6.1

Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a

combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the

keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Operating

monic

Browser Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click

monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
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1.7

1.8

1.8.1

1.8.2

Shortcut Action

Ctrl+- To decrease zoom level.
Ctrl+0 To set zoom level to default level.
Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Application

n? VORI
s B

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled. You can set the
accessibility preferences after login. On the landing screen using 'Accessibility’ link on the
right end of the header set the following preferences as required

Screen Reader

Screen reader provides assistance to the visually impaired users. It interprets the screen
elements by reading them aloud.

High Contrast

High contrast feature increases contrast level to make the screen more appealing for the
reader with low vision.

Large Fonts

Large fonts feature increases font size to ensure clear display and appropriate spacing. This
benefits the reader with low vision.
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1.8.21

1.8.2.2

1.8.2.3

For Visual Challenges

The visual challenges varies widely, however it generally includes, blindness, low vision or
color blindness. To make the application more accessible, following features are provided.

Blindness:

In order to interpret the visual display information in the audible form, Screen reader
compatibility is provided.

In places where Screen reader technology cannot obtain information from images, text
equivalents for images are provided.

For Users with difficulty in using mouse, since it requires hand and eye coordination,
Keyboard navigation is provided. Details of keyboard navigation is provided in ‘Section 1.8.3.2
Keyboard Compatibility’.

Low vision:

For Users who cannot view the content that has small font size and cannot be enlarged,
Software magnifier is provided to enlarge text and images beyond normal font enlargement.

Also, there is no information presented using attributes such as depth, size, location, font etc.

For high contrast requirements Screen setting can be adjusted.

Color blindness:

Oracle Accessibility guidelines have been followed and hence accessibility issues relating to
color blindness are addressed.

Also, high contrast colors have been used to address difficulty in identifying shades of colors.
For example, Black text in white background.

For Hearing Challenges

People with hearing challenges or hard of hearing might encounter problems accessing the
information presented using sounds. Some application features minimize their concerns.

Visual representations of audible information is provided so that Users with this challenge do
not miss information presented using audio.

For Age-related Challenges

Apart from the above, there can be aging issues like week eye-sight or hearing.

Issues related to weak eyesight can be addressed through Application features for Visual
Challenges provided in ‘Section 1.8.2.1 For Visual Challenges’.

Issues related to hearing can be addressed through Application features for hearing
challenges provided in ‘Section 1.8.2.2 For Hearing Challenges’.

For Users who are less familiar with computers, the simplified user interface with easy

navigation options, uniform layout and design and commonly used terminology in the
application is of great advantage.
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To address issues relating to understanding complex information, User manuals are provided
for online help and tool tips at all required places are provided. In addition, system messages
like error, warning or information helps you through.

1.8.3 Other Accessibility Considerations

1.8.3.1 Documentation Accessibility

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate

1.8.4  Setting up Accessibility Preferences

You can setup or change the accessibility preferences.
To edit accessibility settings

1. Click Accessibility in the header part of application. The system displays the following
screen:

Oracle Financial Services Lending and Leasing *
| Accessibility Preferences
Edit Accessibility Settings

Any setting made is saved until changed here again.' : 'Any setting must
be made for each browser session,

[T screen reader

[ High contrast
[FLarge fonts

D‘é Submit $2 Cancel

2. Select any or all of the required options to edit or change the accessibility settings.
3. Click Submit.

Note

You need to define the required Settings for each browser session and defined settings
are saved until next modification.
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2.1

2. Search Function

Oracle Financial Services Lending and Leasing allows you to search for an account, customer
or application using specific search criteria. Since this section details the general search
options available in the User Interface, some or all the parts of this section are applicable to
you as per access provisions & licensing. The following sections explain the Search options
in detail.

Search Criteria

Search criteria has a list of parameters which enables to query the application / account from
the database by providing one or more parameter values. There are 15 parameters whose
values can be specified in combination with comparison operators which are described in the
table below. The Reset button enables to clear the comparison values for a fresh search.
Apart from this, Search can also be performed using wild card characters.

ORACLE P — [=]
Financial Services Lending and Leasing

Customer Service 5 [E3k=
Search | Customer Service | Review Request (Pending: 0)
> Quick Search

Search Criteria

& Reset Critenia || @8 Search
View+ Formatv  [EH| MFresze ifivemch | o wrap [e0)

e =]
Lixe ] =
LIKE ~
EQU [~
LIKE [~
Like =2
EQUAL =
Like I~
Lixe =
Eau [~
LIKE ~]

e ~]

LIKE [~

Lixe ]

LIKE ~l

ke = =
) Lixe ~1

ke

<

Search Results
View + Format~ | B Frocze i Dotach oo | @R
> Collections Company Branch Account F Date Titke Product Status AopeenY  Amount Due
> WP Mo data to displar.
- <
> Tools
> Setup

Description | Example Expression

LESS THAN | APPLICATION DATE < 01/22/2002

Result: The system searches for all applications created before Jan.
22, 2002.

LESS THAN | APPLICATION DATE <= 01/22/2002

gg EQUAL Result: The system searches for all applications created on or before
Jan. 22, 2002.

EQUAL APPLICANT SSN = 111-22-3333
Result: The system searches for all applications with applicant social
security number 111-22-3333.

NOT APPLICANT SSN <> 111-22-3333

EQUAL

Result: The system searches for all applications except those with an
applicant whose social security number is 111-22-3333.
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Description | Example Expression

GREATER APPLICATION DATE > 01/22/2002

THAN Result: The system searches for all applications created after Jan. 22,

2002.

GREATER APPLICATION DATE >= 01/22/2002

THAN Result: The system searches for all applications created on or after
OR EQUAL | Jan. 22, 2002

IN ACCOUNT NUMBER IN (20001000012512°, <20010100012645°,
£20010300012817)

IN is used with values that are within parenthesis.

Result: The system searches for the applications with the account num-
bers of 20001000012512”, <20010100012645”, and 20010300012817.)

NOT IN ACCOUNT NUMBER NOT IN (‘20001000012512°, 20010100012645°,
€20010300012817)

NOT 1IN is used with values that are within parenthesis.

Result: The system searches for all applications except those with the
account numbers of 20001000012512°, <20010100012645°, and
120010300012817°.)

IS VIN IS NULL

IS is only used with a value of “NULL”. It enables you to search for crite-
ria that has no value; that is, fields where no information is present.

Result: The system searches for all applications without a vehicle iden-
tification number.

ISNOT VIN IS NOT NULL

ISNOT is only used with a value of “NULL". It enables you to search for
criteria that has any value; that is, fields where information is present.

Result: The system searches for all accounts with a VIN, vehicle identi-
fication number.

LIKE ASSET TYPE LIKE VEH%

LIKE enables you to search for close matches using wildcard charac-
ters.

Result: The system searches for all applications with asset type begin-
ning with the characters “veh” such as “vehicle car” or “vehicle van.”

NOT LIKE ASSET TYPE NOT LIKE VEH%

NOT LIKE enables you to search for close matches using wildcard
characters.

Result: The system searches for all applications with asset type other
than those starting with the characters “veh.”

Using Wildcard Characters

e Wildcard characters can only be used with the operator LIKE and NOT LIKE.
e % (percent) represents any number of characters, including no characters.
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e _ (underline) represents any single character.

Using Criteria Value

Search criteria values of 1234% will locate character strings of any length that begin with
“1234” for example,

e 1234ACB
e 12345678
e 1234

o 12348

e 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin with
“1234” for example,

o 12345
e 1234A
e 12340

Search criteria values of %1234 will locate character strings of any length that end with
“1234” for example,

e 1234
e 01234
e (098908LKJKLJLKJI000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” for
example,

e A1234
e 11234

Search criteria values of %1234% will locate character strings of any length that contain
“1234” for example,

e 1234
e 01234
e 12340

e AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain
“1234” for example,

e A1234B
e 012341
e A12341

Using Search Criteria examples

Result: The system searches for all applications with application date May 1, 2001.

Criteria Comparison Operator Value
APPLICATION EQUAL 05/01/2001
DATE

23 ORACLE



Criteria Comparison Operator Value
APPLICATION DATE EQUAL 05/01/2001
APPLICATION NUMBER | GREATER THAN OR EQUAL 0000000278

Result: The system searches for all applications with application date May 1, 2001 and an

application number greater than or equal to 0000000278.

Criteria

Comparison Operator

Value

FIRST NAME

EQUAL

JAN

Result: The system searches for all applications with applicant whose first name is “JAN”

e JAN ARBOR
e JAN FISHER

Criteria

Comparison Operator

Value

FIRST NAME

LIKE

JAN%

Result: The system searches for all applications with applicant’s first name starting with “JAN”

e JAN ARBOR
e JAN FISHER

e JANE MEYERS
e JANETTE NORDSTROM
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Application Status

While you are searching for an application in the Origination screens, the Search Result/
Task tab lists all the available applications and also the status of each application for edits.
The following table indicates the application status:

ORACLE’ s AKRRAQ v Accessibility o
Financial Services Lending and Leasing

AT Origination (] Close
‘Origination SeardﬂTask Application Entry: 0000001023~ Review Requests (Pending: 0)
-
;;;:ZGS'S‘E:::;” ey App # 0000001537 ssN Identification # B submit
Undernriting
Funding Queue [] | BB Next Application
Application Retrieval
Scenario Analysis » Search Criteria
Application Documents
Image Maintenance ﬂ' New Application L:} Open Application @ View Application ‘Unlock Application
Reports
Producers Search Results/Task
Vendors Viewv Fomaty [ Feze Hiveach | dwep @) vewAl M
Critical Locked  Allowsd  Company Branch App # Datz Tite Product Status Sub Status
e o1 USHQ 0000001023  12/12/2015 CHODA PHANINDRA [... LEASE VEHICLE APPROVED FUNDED
0 UsoL UsHQ 0000 12/14/2015 MADHU BOBBURI | BA... LOAN VEHICLE (FR) NEW BLANK i)
@ uso1 USHQ 093 06/01/2015 HONEYSINGH YOYO LEASE VEHICLE APPROVED FUNDED
@ usot UsHQ 56 12/15/2015 BOND JAMES LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ UsoL UsHQ 62 02/02/2016 55AM LOAN VEHICLE (FR) APPROVED FUNDED
1 @ usoL UsHQ 08/01/2015 HOOD MARK LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ Usot UsHQ 5 01/04/2016 KABADE KIRAN LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL USHQ 02/02/2016 VANKAYA JOGAIAH LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL UsHQ 94 12/19/2015 MARTINEZ ANDRES / A... LINE HE (FR) APPROVED VERIFYING
@ UsoL UsR1 58 02/01/2012 LEWISJERRY [ JEAN LOAN VEHICLE (FR) APPROVED FUNDED
%) UsoL UsHQ 03/01/2012 JONATHAN RYAN / JUL... LOAN VEHICLE (FR) APPROVED FUNDED
%] NLOZ NLRI 04/01/2012 GARCIA PETER [ SHAR... LOAN VEHICLE (FR) APPROVED FUNDED
@ usot USHQ 70 05/01/2012 WALKER SIDNEY / SAM_. LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsR1 01/01/2012 FLOWER ANDY / JEAN  LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsHQ 01/01/2012 TIFFANY RUSSEL/ GR.. LOAN VEHICLE (FR) APPROVED FUNDED
@ usot USHQ 02/01/2012 TOLMAN GREG | EVA LOAN VEHICLE (FR) APPROVED AUTO APPROVED
@ usoL UsR1 03/01/2012 STANDFORD MICHEAL.. LOAN VEHICLE (FR) APPROVED FUNDED v
@ UsoL UsR1 04/01/2012 SAXTON MARTIN / CH... LOAN VEHICLE (FR) APPROVED FUNDED
< >
» Servicing
» Collections
> WEFP
> Tools
» Setup

Description | Example Expression

CRITICAL Whenever any application is updated with dealer comments, a system
generated alert will be posted in the application and a critical icon would
be displayed in this column against that application. Once User has
acted on the critical item, the alert flag should be manually be
unchecked by the User to remove the 'Critical' flag on the application.

LOCKED An application already opened by another User will have a lock icon in
this column against the application. User with appropriate privileges can
unlock the application and proceed.

ALLOWED This field displays whether you can open the application from the
respective Origination Screen or not i.e. if the application is in decision
stage, a red flag will be displayed in Application Entry stage indicating
that the application can only be viewed and User has to open the appli-
cation in Underwriting for actioning. User can also see a green flag in
Underwriting against this application indicating that it can be actioned in
Underwriting.
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2.2

2.21

Searching for an Application

Oracle Financial Services Lending and Leasing allows you to search and retrieve a particular
application.

During application entry, queues can be created based on your user id and your user
responsibility. You can view the assigned queues in the Origination screen of DashBoard.

ORACLE’ . ; " & Welcome, PRAKRRAQ ~  Accessibility o
Financial Services Lending and Leasing
o
e DashBoard 5 [] Close.
DashBoard
DashBoard Origination Setup Admin
Users Productivity
System Monitor My User Queues Product Expiring in Next One Month Critical Batch Job Status
Producer Analysis Description Count Froduct End Date Baich Job Status
Process Files No data to display. No data to display. No data to display.
My Pending Review Requests By Applications
App % Friority
No data to display.
My Pending Review Requests By Priority
Priority Count
No data to display.
R Servicing Producer Vendor
Number of Queues Hard Assigned
A Producers Count By Status Vendors Count By Status
Queus Description Count
e i by Status Count Status Count
ACTIVE 2 ACTIVE 35
Number of Accounts L o
Queue Description e, Producers Expiring in Next One Month Vendors Expiring in Next One Month
No data to display. Producer End Date Company Name End Date
No data to display. No data to display.
My Pending Review Requests By Accounts
AcE Priority
No data to display.
P GmEston My Pending Review Requests By Priority
Priority Count v
> Servicing No data to display.
> Collections
> WFP
> Tools
> Setup

In each stage of application, the queue name to which the selected application is assigned,
appears in Queue name field in Result screen.

You can begin processing the applications in the order in which they are listed. Select the
record and click Submit.

Search/Task tab

To view the Search/Task screen during Line of credit origination

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2-6 ORACLE



Depending on the task to be performed and the link clicked, the respective screen opens
in the Search Results/Task screen.

ORACLE’
Financial Services Lending and Leasing

jinati Close
e Origination » 7}
Origination Search[Task Application Entry ~ Review Requests (Pending: 0)
Quick Search

Simple Application Entry . N B - =

Application Entry App # SSN Identification 2 [ submit

Underwriting

Funding Queue [~] | [ next Application

Application Retrieval

Scenario Analysis * search Criteria

Application Documents.

Image Maintenance P New application | | [J) Open application || 5] view application Unlock Application

Reports.

Producers Search Results/Task

Vandars View~ Format~ R freeze [fiDetach | ol wrap W viewan [

Crit Loc Allo Company Branch App # Date Title Product Status Sub Status Qu
No data to display.
< >
Columns Hidden 1
“

> Servicing
> Collections
> WFP
> Tools
> Setup

2. Click the Search Criteria tab.

ORACLE"
Financial Services Lending and Leasing

Origination

PashAoard

SenrchfTack | Applicarion rriry || Review Requests (ending: 0)
> Quick Search
Search Criteria
& Reset Criteio || @ Search
view ~ rormat~ | [ [DFresze EiDstacn | ofl wrap @
& ~]
Critaria Comparissn Opsrator S valve
Ve EQuUAL

<

EQuAL L~
TSI = =S
[ET3 =3 =
Line ~ =l
ik =
Bt =
e 1
ke L]
e 3]
ke &
ke L]
ke =
[ET =1

i =
ke <1

@ New appiicarion | | (O anen anpticarion | | (5] wiew appiicanon Linieck applicaion
Search Results/Task
View ~ Format~ [ Frecze  {iff Detach 0 wrap @ veewan O
. Branh A et Titke Product Statea Suls Status au

> Servicing
> Collections.
> wre

> Tools

> Setup

The search tab enables you to locate an application using a broad range of search criteria.

e During Line of credit origination, the results are sorted according to the priority of
application and application identification number. However you can sort the records
using any criteria.

e If you try to open an application which is already opened by another user, system
displays an alert message indicating “Application is locked by <User Name> Phone
<phone number>".

The Search Results/Task screen.

3. On the Results screen, select the application you want to load and click Open
Application.
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2.2.2

The system loads the application on the respective screen.

ORACLE
Financial Services Lending and Leasing
R Close
DashBoard Origination EE
Origination Search/Task | Application Entry: 0000001537 || Review Reauests (Pending: 0) ~
Application: 0000001537: RODRIGUEZ ROBINSON Bl iew || 2 audit
View v Format~ | P Frecze [ Detach Wrop Override OK ¥ Warning OK v
Origination Stage Producer Contact 5 Duplicate
ot App = Sub Unit Status i Producer Name  FTOdUCE! Bxisting Customer  DUBICALE Contact
0s/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACE H.. (818)-761-2277 N N
2>
Summary || Applicant || Business || Request | Dedision || Contract | | Gallateral || Comments || Tracking || Document | | Verification || Correspondence || Toals
Vendors > Applicant
> Ratios
> Bureau
4
“«
» Checkdist
Collateral
Collateral
Asset Type Sub Type Primary  Year rake Model Mileage New Wholesale Volue  Retail
VEHICLE car ¥ 2015 Aupr A oy 12,000.00 13,500
< >
Trade-In
Trade-In
Asset Type Asset Sub Type Description Identification Year Make Model BaseRetail Amt  Addons
> Servicing VEHICLE 2015 DODGE RAM... 3GCPCRECSEG145196 2015 DODGE RAM PICKUP 2500  5,300.00 200.00
verICLE 2012 CHEVROLET .. 3GCPCRECSEG145647 2012 CHEVROLET camaro 1,600.00 0.00
> Collections < >
> WFP
> Tools
> Requested -
> Setup

You are now ready to begin work on the application.

Quick Search section

Quick Search enables to search for an application using any one of the following values -
Application Number, SSN, Identification Number or Queue.

To load an application using the Quick Search section:

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. Inthe Quick Search section’s App # field, specify the application number you want to load
and click Submit.

You can also load the application by specifying the last 4 digits of the SSN Number. System
retrieves only those applications where the searched SSN is of the Primary Applicant. If
multiple matches are found, system displays an error message as ‘Multiple Matches found for
the SSN, Please use normal Search’.
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Note

Search cannot be performed using wild card characters in the Quick Search section.

ORACLE
Financial Services Lending and Leasing

Queue ~1 | B Next application

Search Results/Task
i Format+ B Freere i netach wean T viewan O
ny = Title

> Servicing
> Collections
> WEP

> Tools
> Setup

The system loads the selected application.

To load an application from a queue during application entry

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. In the Quick Search section’s Queue field, select the queue you want to work with and
click Next Application.

2.2.2.1 Other Features on the Results screen

The Results screen on the Applications screen has below listed common features (these
features are not present on the Result screen on Customer Service screen):

What is it? What does it do?

View All If you select View All check box, all applications in the system acces-
sible with your user id appear in the Results screen under search sec-
tion.

Queue Name This display only field indicates the queue in which the selected appli-
field cation is currently in. (This in normally related to one or more of the
following, based on setup: producer, state, or status.)

Secured box Indicates that the selected application is secured (that is, that the
applicant is an employee of the organization) and may only be loaded
by authorized users.

Copy Applica- | Creates a copy of the selected application. This feature is usually
tion button used when an applicant has submitted a previous application or when
an applicant submits a second application and you don’t want to
retype the information.

New Applica- | Opens a screen where a user can create a new application by provid-
tion ing required details.
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What is it? What does it do?

Open Applica- | Displays the application details for the selected application.
tion

Unlock Appli- | Unlocks the selected application locked by another user.
cation

Copying an Application

Once the application clears the pre-qualification edits successfully, it moves to the
underwriting queue. In the Underwriting/Funding screen, you can copy the information of an
existing application into a new application. using Results screen. The new application will
contain duplicated data of application information, the requested Line of credit information,
credit bureau data, and collateral information. The new application will have status/sub status
as NEW - REVIEW REQUIRED.

To copy an application

1. Open the Underwriting/Funding screen and use Quick Search screen to locate the
application you want to copy.

2. Select the application you want to copy on the Search Results/Task screen.

3. Click Copy Application.

ORACLE . . . 2 Welcome, PRAKRRAQ v Accessibility o
Financial Services Lending and Leasing

— Origination 5 (39 Gose

‘Originatis

(@ Information
Application copy successful. New application # success
Search/Task = Underwriting: 0000001537 ~ Review Requests (Pending: 0)
Quick Search

pp # | DDDODO1537 £ Identification # [ subm

Queue [~] | BB Next Application
©» Search Criteria

3 Open Application | | [E] wiew Application | | % inkock Application | § [i5] Copy Application

Search Results/Task
View~ Format~ P Frecze Gt Detach Wrap W viewar
Crit Loc Alls Company  Branch App Dat= Title Product Status Sub Status u
No data to display.

* Servicing
> Collections
> WFP

> Tools

> Setup

An Information message is displayed as “Application copy successful. New application # (new
application number).”

System creates a new application with details of the copied application with status NEW -
REVIEW REQUIRED. The new application can be accessed from the underwriting screen
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irrespective of whether it is copied in Underwriting/Funding screen. The system also notes

that this is a copied application with a system generated comment.

ORACLE" . . & Welcome, PRAKRRAO ~  Accessibility o
Financial Services Lending and Leasing
tginath Close
e Origination x 7]
Origination Search/Task  Underwriting: 0000001533  Review Requests (Pending: 0)
‘Onigination
SelesLead Application: 0000001533 SIGG MARK Zedt | Evew | o aude
simple Application Entry _—
Application Entry View - Format~ [ Freeze i Detach Wrap W overrideok v Waming Ok v
Undenwriting Origination Stage Producer Contact 3 Duplicate
i Dt App # Sub Unit Status Code Producer Nama N Existing Customer application ‘Contact
Apglication Retrieval 05/05/2015 0000001533 REJECTED - AUTO.. NEW CA-00003 : ACE H... (B18)-761-2277 N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports Summary | Applicant || Business | Request| Decision  Bureas | Collstersl Comments | Tracking | Document | Verification || Comespondence | Tools
Producers
Vendors
Comments
add || [ saveandstay | [ save and Retum || Ca Retum
View v Format~ [ Freeze (i Detach 1l Wrap @
Alert Type Sub Type ‘Comment Comment By Comment Dt
O REGULAR [v] | LOAN GRIGINATION [v] PRAKRRAQ 02/04/2016 04:35:38 AM
‘
DECISION_MULTI_OFFER LETTER GENERATED, ~ i
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: INTERNAL 02/01/2016 08:33:04 AM
CNLNCE_DEC_MULTIOFFER_FAX_VR JOB REQUEST 1D: ¥
'CONTRACT_FUNDING LETTER GENERATED.
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: CNLNCE_CON_LTR_VR 3OB REQUEST VEROUTHU 01/30/2016 12:30:35 AM
1D: 41039)
DECISION LETTER GENERATED. (CORRESPONDENCE:
O SYSTEM GENERATED SYSTEM GENERATED CNLNCE_DEC_FAX_VR JOB REQUEST ID: 41038) VEROUTHU 01/30/2016 12:06:18 AM
HAVING GOOD REFERRAL
O REGULAR LOAN ORIGINATION VEROUTHU ©£1/29/2016 11:24:13 PM
> Servicing
> Collections
> WEP
> Tools
> Setup

2.2.2.3 Unlocking an Application

When an application is opened by a user, the same would be locked for other users. Using

Results screen in the Applications screen user can unlock the application.

To unlock an application

1. Open Applications Entry screen and use Quick Search screen to locate the application

you want to work with.

Submit.

On Search Results/Task screen, select the application you want to load and click

An Information message appears with the message: “An application is locked by another
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user.”

ORACLE" . . & Welcome, PRAKRRAD +  Accessibity o
Financial Services Lending and Leasing

i Close
TR Origination x 5]

Origination Search/Task | Undenwriting | Review Requests (Pending: 0)

Origination

el Quick Search

Simple Application Entry . _ . B =
Aoslication Entry App ¥ DODODD1622 Y Identification # (3 submit
Underwriting & Warning *

Funding Queue v] | EBn

Application Retrieval [E2 - Application is locked by: KGOUDU Phane: 0 - Ext.: 0

Scenario Analysis “ Search Criteria el

Application Documents || || — L e j

Image Maintenance (] Cpen Application | | [Z] view Application Unlock Application Copy Application
Reports

Producers Search Results/Task

Vendors View v Formst~  [EF Freeze i Detach vrap W viewan ]

Critical Locked  Allowed  Company Branch  App # Dat= Title Product Status Sub Status [
No data to display.
<

> Servicing
> Collections
> WFP

> Tools
 Setup

3. Click Unlock Application.

4. Click Open Application. The system loads application on the Underwriting screen.

2.2.2.4 View Application

2.3

The View Application button is available in all origination screens (Application Entry,
Underwriting and Funding). You can view a selected application in the search results by
clicking on the View Application button even when the application is locked by another User.

The application will be opened in ‘View Mode’ only and no edits are allowed. However in Tools

sub tab, the 'Initialize' and 'Calculate’ buttons will be enabled allowing you to use the calculator
options.

Searching for an Account and Customer

You can search or retrieve a particular account or customer through Customer Service
screen. The search tab available in the screen enables you to locate an account or customer
using a broad range of search criteria.

To view the Search screen during Line of credit servicing

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform a customer service task on the application, click Customer
Service link.
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Depending on the link clicked, Customer Service screen appears, opening at Results

screen.

ORACLE"
Financial Services Lending and Leasing

@ somout ©

@ Customer Service x (%] Close
Search | Customer Service  Review Request (Pending: 0) | Queve Assignment 2
et Quick Search
- Origination
Servicng Ac# Customer Id ==t Identification # [ submit
Serviding =
Customer Service Queue/ Condition [=] mutorun [ [ (B NextAccount | | [ Fltered Accont
Secritization
Transaction Authorization I Search Criteria |
Post Date Cheds e 3
Escrow Transactions 3
Account Documents 1 Search Results
G iR vien ~ Format ~ 53 Freezz 5 Detach 2 7]
Reports _ =
Producers ¢ &
Neer Company Branch Account # Date Tite Product Status DRI | mourtoye (D2End
Batch Transactons days Balance
Advarces uso1 UsHQ 00123456 01/20/2000 Downprtamt Test .. LOAN VEHICLE (<R} CHARGED OFF 0 0.00 0.00 -
e uso1 UsHQ 1005228531 01j01/2017 BAUER CHRISTIAN  LOAN VEHICLE (FR) ACTIVE:DELQ 217 158288 90700 [0
s n uso1 usHQ 11111111 01/20/2000 Downpmtamt Test .. LOAN VEHICLE (<R} CHARGED OFF 0 0.00 0.00
5 uso1 usHQ 12 012012017 ORACLEMADHAN  LOAN VEHICLE (FR) ACTIVE 35 0.00 8,226.25
O tnes uso1 usHQ 1235459789 01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF Gl 0.00 0.00
> Wrp uso1 UsHQ 2000010010385 01/20/2000 Downpmtamt Test ... LOAN VEHICLE (FR) CHARGED OFF ] 0.00 0.00
> Tools uso1 usHQ 2000010010533 01/20/2000 Downpmtamt Test .. LOAN VEHICLE (FR) CHARGED OFF ] 0.00 0.00
uso1 usHQ 2000010001820 01/20/2000 ALIVEPRI /DEAS... LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00
e uso1 usHQ 2000010001846 01/20/2000 ALIVEPRI [DEAS... LOAN VEHICLE (FR) CHARGED OFF 0 0.00 0.00 -

Note

Oracle Financial Services Lending and Leasing does not display the financial details of se-
cured accounts if the logged-in user is not authorized. Though the search display the re-
sults, the fields such as Status, Delinquency Days, Amount Due, and Outstanding Balance
are masked with ‘xxxxx’ and clicking on the same displays an error message indicating

‘Cannot open secured account’.

3. Click the Search Criteria tab.

ORACLE'
Financial Services Lending and Leasing

e Customer Service [#lCese
> Origination Search Customer Service  Review Request (Pending: 0) =
Sarvicing > Quick Search
Serviding
Customer Service Search Criteria
Securiization Search Options: (@) Account ) Custamer ) Business
Transaction Autherization
Post Date Checks & Reset Criteria. || @ Search
Escrow Transactions View~ Formatv [ Freeze i Detach Wrap 55 3
Account Documents Criteria Comparison Cperator Value i
Collsteral Management: N & e =
';:;::s ACCOUNT STATUS LiE [=] [=]
Vendors PRODUCT LIKE [=] HLOAN%
Advances i CUSTOMER LAST NAME LKE [=]
Payments CUSTOMER FIRST NAME LKE [+
e CUSTOMER D EQUAL [=]
Intir:a;:n;s[ o BUSINESS NAME LKE [«
GLTransactions N e =
CASA Recondliation YEAR EQUAL [=]
Conversion Accounts MAKE L &
MODEL LxE [=]
ASSETTYPE Lxe [=]
PRODUCER # LIKE =]
> Collections PRODUCER NAME LKE =
b wrR ACCOUNT CONDITION L [=] [=
> Tools 'QUEUE NAME {UNDEFINED FOR DEFALLT) LIKE [=]
> Setup QUELE DESCRIPTION LIKE [=] -

Using the Search tab

1. Create a search criteria by specifying the required details in Comparison Operator and

Value columns.

tab.

Account.

Click Search. System displays all accounts that meet the search criteria in the Results

On the Search Results/Task screen, select the account you want to load and click Open
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The system loads account on Customer Service screen.

ORACLE'
Financial Services Lending and Leasing

g Sign Qut o

; o
TR Customer Service (ol
' Origination Search  Customer Service: 0160700010141 Review Request (Pending: 0) | Queue Assignment 2
Servicing
— . Account(s): 20160700010141: KLM NAVEEN Elven | of audit
Customer Service View~ Formatv [ Freeze ifi Detach ] Wrap B & © curent® show Al O Group Folow-p
Securitization Company Branch Sub Unit Account # Product Days PastDue Currency Pay Off Amt Amount Due St
Transaction Authorization uso1 USRHQ UNDEFINED 2016070001041 LOAN VEHICLE (FR) -24 USD 27,021.00 0.00 At
Post Date Checks ' I, ¢
Escrow Transactions 3
Account Documents Summary = Customer Service | AccountDetalle  Customer Details | Transaction History = PmtModes  Bankruptcy  RepofForecoswre | Defidency  Collateral | Buresu  CrossUp Sel Activi » ¥
Collateral Management
Reports
i Alerts Conditions
Producers
Vendors
Alerts Conditions
Batch Transactions
) Alert Condition Start Dt Followup Dt
vances |
S— E No dats to dsplay. ON ACTIVE MILITARY DUTY 07/26/20%6 07/26(20%6
b g DO NOT CHARGE OFF 07/26/2016 07/26/2016 -
Fees
Interfaces
AP Transactions
GL Transactions
Conversion Accounts Account Details Other Information
Dues || Collateral Information |
Desription Identification # Year  AssetClass  AssetType
0.00 0.00 0.00 0.00 0.00 | 0 TOYQOTA CAMRY (] NEW VEHICLE |
a7 i v < i '
= DelgDue 0,00 TodaysPayoff 27,0200  AmtPaid Excess 0.00 . )
A - LCDue 0.00 Future Payoff 27,0500 Memo Excess 0.00 Cirstomer Tniormabon
7 Collections A e
— NSF Due 0.00 Future Payoff 08/12/2016 Amount & Name Relation 5N Mational
/ Date Paid Term 0
" Other Dus 000 ) 000000... NAVEENKLM PRIMARY Xt 5665 -
> Tools ol Due 0.0 FutrePmtDt 08/26/2016  RemairingTem 12 o = - =
» Setup OldestDue Dt 08/26/2016 Days to Time Bar - /]

2.3.1 Quick Search section

The Quick Search section in Customer Service screen enables you to load accounts using
any one of the fields Account Number, Customer Id, SSN, Identification #, or Queue/
Condition.

To load an account using the Quick Search section

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform customer service task on the application, click Customer
Service.
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2.3.2

3. Inthe Quick Search section’s Acc#/Customer Id/SSN/Identification # fields, specify the
corresponding Account number, or Customer Id, or last four digits of SSN or complete
SSN in the respective fields and click Submit.

ORACLE ) . SSHEKAR y g oo ©
Financial Services Lending and Leasing
@ Customer Service x [ Close
Search | Customer Service | Review Request (Pendng: 0) | Queue Assignment
> DashBoard Quick Search
> Origination
Servicing Acc# Customer Id SSN Identification # 3 submit
S
Customer Senvice Quete/ Coniton [#] Autorn [ | 3 NextAccount | | (5§ Fitered Account
Securitization
Transaction Authorization » Search Criteria
Post Date Chedks T
Escrow Transactions 3
A(Tun( I‘Z)n[umenfs 4 Search Results
Collateral Mz it =
S vien~ Fomat~ || [[[Frezze EiDetach U
Reports 4
Producers ¢ %
Deli Qutstandi
eriors Company Branch Account # Date Tite Product Status de'”q”E”q Amount Due B“‘ S prog
Batch Transactions ays alance
advanes Mo data to display.
‘ i v
Payments
Fess -
> Collections
5 WEP
> Tools
> Setup

4. You can also search for accounts which are mapped to a particular Queue or Condition
by selecting the same from ‘Queue/ Condition’ drop-down list and clicking ‘Next Account’
button. Clicking ‘Filtered Account’ opens the subsequent account fetched during a queue
search and listed in Queue Assignment section.

5. When the request to access an application comes from an external system, user needs
to check ‘Auto Run’ and click ‘Next’ button. System displays the customer service screen
for the respective Account.

To load an account from a queue

In the Quick Search section’s Queue field, select the queue you want to work with and click
Next Account.

Search Using Customer Details

There are different ways to search a customer account using the customer details.

To search for and load the customer details with the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria
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Select Customer as a search option.

ORACLE’

Financial Services Lending and Leasing

> DashBoard
> Origination
Servicing
Servicng
Customer Service
Seauitization
Transaction Authorization
Post Date Checks
Escron Transactions
Account Documents
Collateral Management
Reports
producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
Conversion Accounts

> Collections
> WFP

- Tools

> Setup

Customer Service 3 (3 Close

Search | Customer Service  Revien Request (Pending: 0)
> Quick Search

Search Criteria
Search Options: () Account @) Customer ) Business

& resetcritera | @ Search

View v Format~ B Freezz [ Detach Wrap ®

Criteria Comparison Operatar value

CUSTOMER # LIE [=]

CUSTOMER FIRST NAME Like [=]

CUISTOMER LAST NAME Lie [=]

CUSTOMER 55N EQUAL [=]

CUSTOMER NATIONAL ID LiE [= |=
£ CUSTOMER PASSPORT NUMBER LIKE [=]

CUSTOMER PHONE NUMBER EQUAL [=]

CUSTOMER ZIP CODE LiKE [=]

(L) Gpen Account
Search Results
View ™ Format~ [ Freeze [ Detach Wrap 5]
Customer 1d Natioral D First Name Last Name ssit Passport = )
No data to display.
View > Formatv Freeze [ Detach rap o)
Company Branch Account = product currency Pay Off Amt Amount Due Status Oldest Due Dt Type

No data to display.

1. On Search Criteria screen, use Comparison Operator and Value columns to create a
search criteria to find the account using customer details. You can click Reset Criteria at
any time to clear the Comparison Operator and Value columns.

2. Click Search.

The system locates and displays all the accounts that meet your search criteria on Search

Results screen.

ORACLE"

Financial Services Lending and Leasing

> DashBoard
> Origination
Servicing
Servicing
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
Conversion Accounts

> Collections
> WP

> Tools

> Setup

Customer Service y [3] Cose

Search | Customer Service | Review Request (Pending: 0)

Quick Search
Ac# Customer Id ssN Identification # [ Submit
Queue/ Condition [] autorun [F] | G NextAccount

> Search Criteria

(L @pen Account
Search Results
View > Format~ [ Freeze [fiDetach | ol wrap )
Customer Id National D First Name Last Name SSN Passport # Zp
31030 456321789 SATKRISHNAN K 0000E956 00775
View v Format+ [ Freeze i Detach &l wrap 05
Company Branch Account # Product Currency Pay Off Amt Amount Due Status Oldest Due Dt Type
uso1 usHQ 0160200015584  LOAN VEHICLE (FR)  LSD 5,037.08 42276 ACTIVEDELG 03/01/2016 PRIMARY

3. On the Search Results screen, view the following information for each account:

In this field:

View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Product

The Line of credit product of the account.
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2.3.3

In this field: View this:

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.
Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.
Type The type of account.

Also the ‘Customer Details’ section below displays the Customer Information along with
Addresses, Telecoms, Employments, and Tracking Attributes. You can click ‘View’ to display
the details in each section.

4. On the Search Results screen, select the customer you want to retrieve. The system
displays all the accounts pertaining to that customer Id. Select an account and click Open
Account.

The system displays the account details on Customer Service tab.

Search Using Account Details

To search for and load an account using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Account as a search option.

ORACLE
Financial Services Lending and Leasing

Close
e Customer Service x Bl
> Origination Search | Customer Service || Review Request (Pending: 0)
SHLELY » Quick Search
Senviang
Customer Service Search Criteria
Securitzation Search Options: ® Account®) Customer () Business
Transaction Autharization
- Greserciena | @@search
Escron Transactions Vien v Format~ [P Freeze i Detach Wirap 5]
Account Documents Crteria Comparison Operator Valie
Collateral Management AECONT e =]
Renats ACCOUNT STATUS LiE [=] [=]
Producers
Vendsre PRODUCT LKE [=] SLOANYE
AT CUSTOMER SSN EQUAL [+l
Advances i CUSTOMER LAST NAME LKE =
Payments CUSTOMER FIRST NAVE LKE [=]
= CUSTOMER 1D EQuAL [=]
Interfoces g
4P Traneactons BUSINESS NAME LIKE -
6L Transactons v ue =
CASAReconaliation R EQUAL [=]
Conversion Accounts MAKE e =
MODEL LIKE ]
ASSET TYPE LiE [=]
PRODUCER = LiE [=]
> Collections PRODUCER NAME LIKE =
> WP ACCOUNT CONDITION LIKE ] =]
> Tools 'QUEUE NAME (UNDEFINED FOR DEFAULT) LIE [=]
> Setup QUEUE DESCRIPTION LKe [+l -

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find an account. You can click Reset Criteria at any time to clear the
Comparison Operator and Value columns.
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3. Click Search. The system locates and displays all the accounts that meet your search

criteria on Results screen.

ORACLE’
Financial Services Lending and Leasing

> DashBoard {Customer Service

> Origination
Feviang Quick Search
Senidng

Customer Service Acc
Seauitizaton

Transaction Authorization Queue/ Conditon

Post Date Checks
Escrow Transactions e r—
Account Documents
Collateral Management
Reports
Producers Search Results
Vendors Vew Formatv [}
Batch Transactions
q Company Branch
Advances
Payments usoL usH
Fees usot usHQ
Interfaces usoL usio
AP Transactions us0L UsHQ
GL Transactions uso1 UsHQ
CASA Reconcliation usoL usHQ
Conversion Accounts UsoE usHQ
uso1L usHQ
usot uso
usoL UsHQ
usoL UsHQ
> Collections usot usHo
> WP (LT UsHQ
usoiL UsHQ
> Tools = o
> Setup |

Search Customer Service | Review Request (Pending: 0)

Customer 1d ssn Identification # [ submit
[ Auorin [ [ B NextAccount
(2] Gpen Account
Freere iDetach wap @

Account £ Date Title Broduct Status ::‘Y‘Z""E"EV Amount Due :;:::d‘”g Producer
2015120001060 12/10/2015 NATH NATH LOAN VEHICLE (FR) PENDING ) 0.00 0.00 CA-00002 : RAND!
MISI00L1331  12/18/2015 MADELLA SURESH  LOAN VEHICLE (FR) ACTIVE:DELQ 1 147182 2503000  CA-00002:RANDY |
151200012331 12/10/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND"
0151200012348 12/17/2015 SOF SOF LOAN VEHICLE (FR) PENDING 0 0.00 0.00 AK-00001 ¢ FELL
DI51200012612  12/18/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
151200012894 12/24/2015 ASHOKPADMA  LOANVEMICLE (FR) ACTIVE 2 0.00 2000000 CA-00001:DEMO
DISI00L3008  12/30/2015 ume LOAN VEHICLE (FR) ACTIVE -1 0.00 100,000.00  CA-D0DS : HARR"
0160100013092 01/06/2016 SPARROV/ MARYY  LOAN VEHICLE (FR) ACTIVE 20 0.00 S0,000.00  CA-00001: DEMO
DI0I00LI2I6  01/14/2016 JONES ANGELINA  LOAN VEHICLE (FR) ACTIVE -16 0.00 50,0000 CA-00001: DEMO
0160100013274 01/18/2016 RANADE SHWETA  LOAN VEHICLE (FR) ACTIVE 31 0.00 500,000.00  CA-00001 : DEMO
DI60100013414  01/19/2016 DALE ALAN LOAN VEHICLE (FR) ACTIVE a1 0.00 42,000.00  CA-00002: RAND'
0160100013963 01/20/2016 0 LOAN VEHICLE (FR) ACTIVE -0 0.00 15,000.00  GA-D00D2 : ADVAT
0151200014064 12/17/2015 KNAVIN LOAN VEHICLE (FR) PENDING 0 0.00 0.00 CA-00002 : RAND'
MDI60100014149  01/20/2016 HEGDE SUBHASH /... LOAN VEHICLE (FR) ACTIVE 24 0.00 15,000.00  GA-D00D2 : ADVAT
2160100014206 01/20/2016 HEGDE SUBHASH f... LOAN VEHICLE (FR) ACTIVE 24 0.00 15,000.00

i

e

B

GA-00002 : ADVA" +
3

4. On the Search Results screen, view the following information for each account:

In this field:

View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number

Date

The date the account was created.

Title

The primary and other applicant(s) attached to the account.

Product

The Line of credit product of the account.

Status

The status of the account.

Delinquency days

The number of days the account has been delinquent.

Amount Due

The total amount due for the account.

Outstanding Balance

The total outstanding balance for the account.

Producer

The producer of the account.

Secured

If selected, indicates the account is secured and may only be
loaded by authorized users.

5. On the Results screen, select the application you want to retrieve and click Open

Account.
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234

The system loads the account under the tab

ORACLE' 5 Welcome, VAVAIDVA +  cessity  ENEIRIN] ©
Financial Services Lending and Leasing
ustomer Service x Close
> DashBoard Sestomer 56 =
* Origination Search  Customer Service: 2015100011054 Review Reuest (Pencing: 0)
Servicing
F Account(s): 20151000011054: K NAVIN ElAR A
Customer Service Vieww Formatv [ [[[Frecze FiDetach | oJwap @ & @ Current O Showall O Group Follov-up
Secuntization Company Branch Sub Unit Account = Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Autherization UsHo. UNDEFINED 2015100001054 LOAN VEHICLE (FR) 531462 0.00 ACTIVE 10/01/2016.
Post Date Checks
Escrow Transactions
e Summary | Customer Service || Account Details | Customer Details | Transaction History | Prt Modes || Banksuptey || Repo/Forecosure || Deficency | Collteral || Bureau | Cross/Up Sell Atvties
Collateral Management
Reports Alerts Conditions
Producers
Vendors Alerts Conditions
Alert Condition Start Ot Followup Dt
TesT o data to dispay
Intesfaces
4P Transactions
GL Transactions
CasA Reconciiation
‘ Account Details Other Information
Conversion Accounts ‘
Dues Collateral Information
Description Ientification = Year AssetTpe  SubType
000 000 000 0.00 000 o 0 i
o 0 i i
Delg Due 0.00 Total Due 2000 Future Pt Dt 10/01/2016 ] 0 € i
LCDue 0.00 Todays Payaff 45,314.62 Oldest Due Dt 10/03/2015
F Due 2000 Future Payoff 45,376.30 Amt paid Excess 0.00 2
Other Due 0.00 Future Payoff Date 02/27/2016 Ccustomer Inforetion
: ) Costomer e Relation S5 Bith Dt Gender
Delinquency Information #
5 20 1% (80 Cateqory [baw 000000... KAVINK PRIMARY 020008677 02/12/1987
0 0 0 0 0 27 000000, RICHARD MURRAY IR PRIMARY 009332 12/08/1585 UNDEFINED
»
ep(life) 0 NSF(ife) 1 Collector DEMOCOLL
ep(vea) 0 NsF(vear) 1 Email Privacy Opt Out ¥
Language ENGLISH E Active Wiltary Duty N
5 Activities MaritalStatus stop 1 Time Zone
RaOpllecins Adive Bt 12/10/2015 Aop & 0000001013 Lask Pt Amt 000 Cortespandence
> WFP Last Actiity Dt 02/17/2016 Paid Off Dt Charge Off Dt
ue Day 1 Effective Dt 10/12/2015
> Tools Due Day i
Last Pt Dt Current Pt 3,981.80 fidiress Infurmation
> Setup Customer Grade B Last Bll Amt 0.00 Type current PEMISH wailing address Phone. %

You are now ready to begin work on the account.

You can view the accounts pending for your review by selecting Receiver in the Review

Request tab.

Search Using Business Details

To search and load an account with specific business using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Business as the search option.

ORACLE"
Financial Services Lending and Leasing

@ Customer Service
Search

5
> DashBoard + Quick Search
> Origination
et Search Criteria
Servidng
Customer Service
Securitization
Transaction Authorization
Post Date Checks.
Escrow Transactions

View ¥ Format ¥
Criteria
BUSINESS #

Account Documents BUSINESS NAME

Collateral Management

TRXD &
il START DATE
Producers q
’ PHONE NUMBER
Vendors
Batch Transactions 2 cone
Advances
payments
Fees
Interfaces

Search Results
AP Transactions

6L Transactions
Business =
Mo data to display.

Conversion Accounts

Customer Service

54

Vew~ Fomatv | B

Review Request (Pending: 0)

Fresze [ Detach

Freeze it Detach

Business Name

Branch

> Collections

> wep View ™ Formatv [
Company

> Tools Mo data to display.

> Setup

Freezs [liDetach

Account =

Queue Assignment.

wep | @
w | @

we | @
Product

Comparison Cperator

LIKE =
e =
e =
cEATRTHANOREQUA  [2]
EQUAL =

e =

Taxd

Currency Pay OFf Amt

[ dose
Search Options: Account(®) Customer @ Business
& Resetciiteria | @8 search
Value
(10pen Aceount
Start Dt Phone Number Zp
Amount Due Status Oldest Due Dt

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find the business type. You can click Reset Criteria at any time to clear
the Comparison Operator and Value columns.

ORACLE



3. Click Search. The system locates and displays all the records that meet your search
criteria on ‘Search Results’ section.

ORACLE'
Financial Services Lending and Leasing
T e— @ dose
Search Results i
View > Format » Frezze i Detach ap
> DashBoard H @
: Business # Business Name: Tax1d Start Dt Phone Mumber  Zp
» Origination oooo021005 oFsiL 55236 02/08/2010 (co0y000-0000 01152
Servicing
Servidng
Customer Service View ¥ Format ¥ Freeze g Detach Wrap @
searitzaten Company Branch Account # Product Currency Pay Off Amt Amount Due Status Oldest Due Dt
s MM uso1 usHQ. 170200029956 LOAN VEHICLE (FR) usn 10,000.00 0.00 AcTIvE 03/15/2017
Post Date Checks
Escrow Transactions
Aczount Documents -
Business
Collateral Management
Reports
Producers i Business Details
Vendors Elew
Batch Transactions
Advances View v Format~ P Freeze i Detach Wrap W
Payments
i OrganizationType  Type of Business  Business Category  Name of the Business LegalName TacD = startdt ofEmployess(Cur)  #of
Interfaces coore CORPORATE CORPORATE orsiL oFslL s0000:5236 02/08/2010 20 E
AP Transactions <[ m T
6L Transactions
Conversion Accounts Addresses | Telecoms | Parters | Affiates | Tracking Atibutes
i view
ST TS Address Information ) B
o view~ Fomatv Freeze Efpetach | ol wiap 5}
»
Adress Type Current Country Address # aty State Postal Type Steetpre Street Name Steet Type st
7 Tools WORK Y UNITED STATES SPRINGFIELD MASSACHUSETTS ~ NORMAL ADDRESS
> Setup 3 i ’

You can view the view the following information for each business record:

In this field:

View this:

Business #

The registered business number of the company.

Business Name

The name of the business.

Tax ID

The taxation identity number of the business.

Start Dt

The date when the business was initiated.

Phone Number

The contact number of the business.

Zip

The zip code where the business is established.

4. Onthe Results screen, select the business type of your interest. The sub section displays
the accounts associated with the selected business with the following details:

In this field:

View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Line of credit product of the account.
Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.

Amount Due

The total amount due on the account.

Status

The status of the account.

Oldest Due Dt

The oldest payment due date on the account.
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Also the ‘Business’ section below displays the Business Details along with Addresses,
Telecoms, Partners, Affiliates and Tracking Attributes. You can click ‘View’ to display the
details in each section.

5. Select the required account and click Open Account. The system loads the account
associated with the business type in the tab
ORACLE:

Financial Services Lending and Leasing

Close
e CustomerService x EE
= Oapination seach| : 2015100011054 quest (Pending: 0)
Servicing
Renid Account(s): 20151000011054: K NAVIN Eluew || Pt
Customer Senvice View Fomat~ [ [lFrece BiDetach  Jwp | G & © Curent O showAll O Group Follov-up
securitzation Company Branch Sub Unit # Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
Transaction Autharization uso1 us UNDEFINED 2015100011054 LOAN VEHICLE (FR) 27 U 4531462 0.00 A 10/01/2016.
Post Date Checks
SSon Teteactong s Customer s¢ Account Details | Customer Details || Transaction History || Pm Modes | Banruptcy || RepoFored D Collateral | B Cross/Up Sell Activties
P ummary || Customer Service | Account Details | Customer Details | Transaction History | Pt Modes | Bankruptcy || Repo/Foredosure | Deficiency | Collteral | Bureau | Cross/Up Sell Activities
Collateral Management
Reports Alerts Conditions
Producers
Vendors Alerts Conditions
s Alert Condition Start Dt Followup Dt
TEST Mo data to displa.
GLTransactions
CasA Reconcilation q e DeaE T -
Conversion Accounts i< g ‘<
Dues Collateral Information
Description Hentification = Year AssetClass AssetTpe  SubType
000 000 000 000 000 0 0 1 i
0 0 1 i
Delg Due 0.00 Total Due 2000 Future Pt DE 10/01/2016 0 0 x i
LCDue 0.00 Todays Payoff 4531462 Oldest Due Dt 10/01/2016
NSF Due 2000 Future Payoff 45,376.30 Amt Paid Bxcess: 0.00 5
Other Due 0.00 Future Payoff Date 02/27/2016 Customer Lnformation
: i Costomer ame Relation o Bith ot Gender
Delinquency Information B
e = o B [ sy o 000000... KAVIN K PRINARY soc10068677 02/12/1587
e o o 5 4 c o = 000000... RICHARD MURRAY JR PRIMARY 00009332 12/08/1585 UNDEFINED
< ,
Be(lfe) 0 NSF(Life) 1 Collector DEMOCOLL
ep(Year) 0 sF{vear) 1 Email Privacy Opt Out Y
Language ENGLISH Skip N Active ity Duty N
Activities Warital Status stop N Time Zone
BaCollections Adive Dt 12/10/2015 App # 0000001013 Last Pt Amt 000 Correspondence
> WrP Last Actiity Dt 02/17/2016 Paid OFf Dt
Due Day 1 Effective Dt 10/12/2015 g
> Tools
Last Pt Dt Current Pt 3,981.80 jAddress Information
» Setup Customer Grade B Last Bil Amt 0.00 Type current PEMS wailing Address Phone. =
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3.1

3.2

3. Dashboards

Introduction

This document is designed to help acquaint you with the features of Dashboard, on the
landing screen of Oracle Financial Services Lending and Leasing. Information from multiple
products is integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present
in the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing. Besides providing these details, the manual also provides a brief description of
other features associated with Dashboard link. The Dashboard main Menu further provides
links to the following screens:

e Dashboard

e Users Productivity
e System Monitor

e Producer Analysis

Dashboards

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the ‘User
Role’, who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards
Click Dashboard > Dashboard > Dashboard.

[e=]

P — o

RACLE
Financial Services Lending and Leasing

DashBoard (36 Close

Origination Setup Admin

My User Queues Product Expiring in Next One Month Critical Batch Job Status
Count. End Date Batch Job Status
No data to display. No data to display. No data to display.

My Pending Review Requests By Applications
App = Priority
No data to display.

My Pending Review Requests By Priority
Priorty Gount
No data to display.

Servicing Producer Vendor

Number of Queues Hard Assigned A Producers Count By Status ‘Vendors Count By Status
Queue Description Count. Status Count Status Count
No data to display. ACTIVE 82 ACTIVE 35

Number of Accounts Producers Expiring in Next One Month Vendors Expiring in Next One Month
ueue Description Count Producer End Date me £nd Date
No data to display. No data to display.

My Pending Review Requests By Accounts
Acc = Priority
No data to display.

> Origination My Pending Review Requests By Priority -
> Servicing | prienty Count

> Collections

> WFP

> Tools

> Setup

Features

Following are the features of Dashboard:

3-1 ORACLE



3.3

3.3.1

3.3.1.1

e The system organizes Dashboards to provide comprehensive and consolidate snapshot
in tiny windows, to access information easily. Thus, helping to; analyze, monitor and
make better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

e The height and width of all Dashboards are fixed; however, you can expand or collapse
the Dashboards. Click the arrow heads at the top left corner of the Dashboard windows
to expand or collapse the dashboard windows.

e Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

e Each window in the dashboard is provided with a Refresh button and clicking on the
same would fetch the latest status of the dashboard being viewed.

User Productivity

Oracle Financial Services Lending and Leasing User Productivity Setup screen is a
supervisor feature that allows you to monitor the daily performances of users completing Line
of credit origination and servicing tasks.

These tasks are categorized as underwriting funding tasks (loan origination).The system
updates these details on daily basis.

Using the User Productivity Setup screen, you can review the following daily tallies:

e Number of applications entered, by user

e Number of underwriting decisions (approved, rejected, conditioned, or withdrawn), by
user

e Number of funding decisions (verified or funded), by user
e Number of applications entered, by queue

This chapter explains how to use the User Productivity Setup screen to view this information.

Navigating to User Productivity Screen
1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > User Productivity.

2. The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding
e Customer Service/Collection

Viewing Underwriting/Funding tasks

Daily tallies from the

e Collector Activity

Collector Activity

The Collector Activity screen displays the number of accounts worked and call activities by
collector for the day. It also displays details regarding calls and total number of calls per
queue.
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To use the Collector Activity

1. Click Dashboard > Dashboard > User Productivity > Collector Activity. The details
on this screen are grouped into two:

e Users
e Activity Details

2. In the Users section, you can view the following information.

ORACLE # Welcome, PRAKRRAD ~  Accessibiity o
Financial Services Lending and Leasing

e Users Productivity 3 [ Gose
DashBoard Apglication Ertry | Underwiting || Funding || Origination Queues | Collector Activity: | Senvice/Collection Queuss:
DashBoard
Users Productivity
System Monitor Users
Producer Analysis View~ Fomaty [ Frecze Tt Detach Wrap 5]

Process Files User Neme Accourts Call Activities

No data to display.

Activity Details
Viewv Format~ [ Freeze [t Detach J wrap i

Queue Name LeftMessages  Promisa To Pay Mo Answer Gther Total
No data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Accounts Displays the number of accounts worked.
Call Activities Displays the number of call activities.

3. Inthe Activity Details section, you can view information for the selected user. A brief
description of the fields is given below:

Field: View this:

Queue Name Displays the queue name.

Left Messages Displays the left message activity count.

Promise To Pay | Displays the promise to pay activity count.

No Answer Displays the no answer activity count.

Other Displays the other activity count.
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3.4

3.4.1

Field: View this:

Total Displays the total activity count.

System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

e Batch Jobs

e Jobs

e Services

e Database Server Log Files
e Parked Transactions

e Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor.

Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:
e Batch Job Sets
e Batch Jobs
e Batch Jobs Threads
e Request Details
e Request Results

To Monitor Batch Job
1. Click Dashboard > Dashboard > System Monitor > Batch Jobs.
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2. Inthe Batch Job Sets section, you can view the following information

ORACLE’ % Welcome, PRAKRRAC v Accessibility o
Financial Services Lending and Leasing

V Close
DashBoard System Monitor —

Batch Jobs | Jobs | Services | Database Server Log Files | Parked Transactions | Users

Users Productivity

System Monitor Batch Job Sets
Producer Analysis Vieww Formatw [} Fresze i Detach Wrap T BB Re-submit Job Set
Process Files Set Code Job Set Description  Status Fraquency Frequency Value  Start Time Enzbled Critical Last Run Dt Next Run DI
SET-AAD ACCOUNT CREATL.. READY DAILY DAILY 10:00 AM N N 08/08/2003 08/09/2003 A
SET-ACR ACCRUALS AND D... READY DAILY DAILY 10:30 PM N ¥ 08/07/2003 08/08/2003
<
Batch Jobs
Vieww Format~ [ Freeze ) Detach & wrap @ BB re-submit Job
Seq Job Type Job Code Status Job Description Threads Commit Count Errors Allowed Weskend Holiday
1 PROCEDURE AAIPRC_B1_100_01 COMPLETED APPLICATION TO. i ¥
2 PROCEDURE TXNACT_E]_100_01 COMPLETED ACCOUNT ACTIVA 1 100 50Y Y
< >
Batch Job Threads
U View- Fomat~ & Freeze ) Detach ¢l wrap (65
Thread Status Errors Records Trace Level Enzbled
1IDiE 0 ] ok
Request Details
View ~ Format+ [ Fresze ) Detach Wrap (5]
Request Type Status Start Dt End Dt Run Start Dt Run End Dt Process Dt
No data to display.
>
Request Results
View» Fomate [ Frezze ! Detach Wrap ®
Requast Result Description
> Origination No datz to display.
> Servicing
> Collections
> WEP
> Tools
> Setup

A brief description of the fields is given below:

Field: View this:

Set Code Displays the code for batch job set.

Job Set Description | Displays the description for batch job set.

Status Displays the job set status.

Frequency Code Displays the frequency at which the job set is to be executed.

Frequency Value Displays the value of frequency code chosen for the job set.

Start Time Displays the start time for the job set.

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.
Parent Displays the preceding job set.
Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set
Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused

the failure. Resubmitting a set causes system to re-perform the batch job set and dependent
batch jobs.
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e Inthe Batch Job Sets section, choose the batch job set to resubmit (only a batch job
set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.

The Batch Job screen also allows you to resubmit jobs which are in READY or COMPLETED
or FAILED status if you have access key privileges define for your user responsibility. If
provisioned, then a ‘Force Re-Submit Job Set’ button is available instead of ‘Resubmit Job
Set’ button to resubmit the jobs with above status.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are
shown for each job.

A brief description of the fields is given below:

Field: View this:

Seq Displays the batch job sequence number.

Job Type Displays the batch job request type.

Job Code Displays the batch job request code.

Status Displays the job status.

Job Description Displays the batch job description.

Threads Displays the number of threads used by the job.

Commit Count Displays the number of rows after which auto-commit is
triggered.

Errors Allowed Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on weekend or
not.

Holiday Displays if the batch job will execute job on a holiday or
not.

Enabled Displays if the job is enabled or not.

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.

Command Displays the command line for the job.

Rollback Segment Displays the rollback segment for job.

To resubmit a batch job
Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused
failure. Resubmitting a set will cause system to re-perform the batch job.

e In the Batch Jobs section, choose the batch job to resubmit (only a batch job with a
status of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.
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A brief description of the fields is given below:

Field: View this:

Thread Displays the name of thread.

Status Displays the status of thread.

Errors Displays the number of errors in the thread.
Records Displays the number of records in the thread.
Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).
Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run started.

Run End Dt Displays the date and time at which the job run ended.

Process Dt Displays the transaction is posted with this General Ledger effec-
tive date.

Description Displays the job request description.

If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Field: View this:

Request Results | Displays the result of job request.

Description Displays the result details.

3.4.2 Monitoring Jobs

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.
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To Monitor Job Details
1. Click Dashboard > Dashboard > System Monitor > Jobs.

ORACLE’

Financial Services Lending and Leasing

System Monitor x

Job Details

View ~ Format ~

Request Type

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE

PROCEDURE
«

>

BatchJobs | Jobs | Services | Database Server LogFies

Batch  BackGround | CreditRequest

[ close
Perked Trensactions | Users =

B Frecz fiDetach rap | ) Vewlest ® 1Day 1Week© 1Month @ ByDate  startDt EndDt @ View © Faied @ Al

Valid Execution
Status Job Set Job Description Thread Errors Records Run Start Cate/Time Run End Date/Time  Process Dt Period Start

Date[Time
COMPLETED sErTE TXNDDT_BI_100_... TWNDDT_BI_100_ i 0 2 08/19/017 11:52:... 09/18/2017 11:52:... 03/20/2017 09/1/2017 11:5%
COMPLETED seTTE TUNDOT_BI_100_... TYNDDT_B3_00_ 1 0 5 09/19/2017 11:40:... 09/13/2017 11:41:... 09/20/2017 09/19/2017 11:40
COMPLETED SET-QRT QESPRC_BI_100_.. QCSPRC_BI_100_ 1 0 2 03/18/2017 08:31: .. DS/19/2017 08:31:... 08/20/2017 03/19/2017 09:31:
COMPLETED SETORT QESPRC_BI_100_. QSPRC_BI_100_ 1 0 2 08/18/2017 08:31:... DS/19/2017 08:31:... 08/20/2017 09/19/2017 08:31:
COMPLETED SETGRT QESPRC_BI_100_.. QCSPRC_BI_100_ 1 0 2 08/18/2017 07:31:... 08/19/2017 07:31:... 08/20/2017 03/19/2017 07:31:
COMPLETED SETQRT QESPRC_BI_100_. QSPRC_BI_100_ L 0 03/18/2017 06:31. 03/19/2017 05:31:

2 08/18/3017 06:31;

09/20/2017

S

Job Detail Description
THNDDT_E_100_0 L TXNDDT_B]_100_01(6006)

Job Results
View = Formatv [

Request Result
in Ani i

Freeze i Detach

Description

2. Onthe Job screen, you can select any of the following type of jobs which are available in

separate tabs:

Select:

System Displays:

Batch

Batch jobs (used primarily for the nightly processes).

Back Ground

User submitted requests, such as reports and payment posting.

Credit Request

Credit bureau requests.

3. Inthe Job Details section, select the time frame based on elapsed days. You can select
any of the following options:

Select: System Displays:

1 Day All the types of jobs selected in Jobs Type section in last one-day.

1 Week All the types of jobs selected in Jobs Type section in last one-week.

1 Month All the types of jobs selected in Jobs Type section in last one-month.

By Date All the types of jobs selected in Jobs Type section for specific duration.
You can specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’
fields using the adjoining calendar and click ‘Search’.

4. If you select Failed option in the View section, the system displays failed jobs on the type
and time frame you have selected.

5. In the Job Details section, you can view the following information about jobs matching
the contents of Job Type, View Last and Failed boxes:

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.
Status Displays the job request status.
Job Set Displays the job set code.
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3.4.3

Field:

View this:

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.

Records Displays the number of records processed by the job.

Run Start Date/Time

Displays the job run start date time.

Run End Date/Time

Displays the job run end date time.

Description

Displays the job request description.

Process Dt

Displays the job process date.

Valid Execution Period

Start Date/Time

Displays the job start date/time.

End Date/Time

Displays the job end date time.

6. Inthe Job Results section, you can view the following information about the Job selected

in Job Details section:

A brief description of the fields is given below:

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.

Monitoring Services

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start
or stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service
1. Click Dashboard > Dashboard >System Monitor > Services.
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2. Inthe Services section, you can view the following information about the system’s
processing services:

ORACLE" _ . # Wekome, PRAKRRAO »  Accessibiity o
Financial Services Lending and Leasing

. Close.
DashBoard System Monitor 3 -
Dich Bl Batchiobs | Jobs | Services  Datobase Server Log Fles  Parked Transactions || Users
DashBoard
Users Producivity )
System Monitor Services

Producer Analysis View ~ Format~ [Ep Freeze  Ef Detach Wrap W @ sttus Dstet Ostop

Binks rkes Service Company Branch Description Status
v AL AL CREDIT BUREAU SERVICE (EFX TEST FILES)
csv AL ALL CREDIT BUREAL SERVICE (EXP TEST FILES)
csv AL ALL CREDIT BUREAU SERVICE (TUC TEST FILES)
Xsc AL ALL JOB SCHEDULER
v ALL ALL 0B SERVICE

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.

Description Display the service description.

Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose
one of the following commands in Action section.

Choose: System:

Status Refreshes (updates) the status of service. The Service screen does
not update the status in real time. You must choose Status after
choosing Start or Stop to perform that command.

Start Starts the job service.

Stop Stops the job service.

344 Database Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
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3.4.5

so on). The Database Server Log files tab lists and describes all such log files within the
system on the database server.

To view a log file on the database server
1. Click Dashboard > Dashboard > System Monitor > Database Server Log Files.

ORACLE ) ) : v @ sean O
Financial Services Lending and Leasing
@& Svstem Monitor ] Close
BaichJobs | Jobs | Services Database ServerLog Files | Parked Transactions | Users 2
DashBoard
DashBoard - Database Server Log Files
Dashboard | \L‘e"'t D102y © LWieek® 1Month QY Date oy End Dt % @8 View © Aert® Debug O Interfaces
asi
Users Productivity -
View = Format = Fresze i Detach Wrap IS UistFiles Download File =
System Monitor & s @ 3= &
PG Akl L File Name File Type File Size File Time
o 7 xaeprc_em_100_02_FMW116_7033906.log fie 159179 08/31/2017 02:28:52 AM -
JSVPRC_EN_000_01_DB12102_6974056.log file 171338 08/29/2017 07:42:07PM [
1SVPRC_EN_000_01_DB12102_7283869.log file 19897 09/10/2017 10:39:59 AM
g YAEUPD_EM_100_02_FMW116_7203940.log file 46704 03/07/2017 03:50:43 AM
RDNLOG_EW_100_01_FMW116_7284144.log file 1108 09/08/2017 06:00:34 AM -
> Origination File Content
View ~ Format v & Detach Nrap @ Beginning ' End 2 of Lines 50 Show File
> Servicing = 50} =
- Text
i Calertions 08/31/2017 12:35:32: cmnini cl 000 0i.initialize svc -
> WFP 08/ :32: cmnsyp_cl get_syp_parameter_value paramecer: XAEPRC_EM_100_02_DESUG_LEVEL
 Tools 2: xaeprc_em submit for Zpp No:
: User code: INTERNAL
> Setup -
2: 1v_statement - SELECT ptc_cur_currency code FROM xae_ptc_evw WHERE PTC_COMBANY = :bl 1

2. In the Database Server Log Files section, you can sort the list of logs to be displayed
based on following options:

e Select the ‘View Last’ option to display the logs based on elapsed days by selecting 1
Day /1 Week /1 Month / By Date. If ‘By Date’ option is selected, you can specify a date
range (within 3 months) in ‘Start Dt’ and ‘End Dt’ fields using the adjoining calendar.
Click ‘Search’.

e Select the ‘View’ option to further filter the list based on the type of logs to be displayed
by selecting Alert / Debug / Interfaces.

3. Click on = List Files button to view the list of logged files. A brief description of the fields
are given below

Field View this:

File Name Displays the name of file.

File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the date and time stamp of file.

4. To extract a local copy of debug details, click & Download File button and save the file.

5. Inthe File Content section you can view the content of the file selected in the Database
Server Log Files by clicking & Show File button.

6. To sortthe view of file contents, select the order as either ‘Beginning’ or ‘End’ and specify
the value for ‘# of Lines’ to be displayed (default 50).

Monitoring Users

The Users Logins section allows you to view all users who have logged on to the system,
along with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.
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To monitor users who have logged on to the system

1. Click Dashboard > Dashboard >System Monitor > Users.

ORACLE’ ¢, ABSHEKAR ity g Sgnout O
Financial Services Lending and Leasing

System Monitor [®Close
Batch Jobs || Jobs  Services  Datsbase Server Log Files | Parked Transactons  Users 2
User Logins
View v Formatv P Freeze i Detach 1 Wrap ) ViewLast © 1Day © 1Week © 1 Month ) By Date  start Dt £nd Dt @ View User ©) Current User @ Al Users
User User Name: Detaiis Login Date and Time 102247021 and
SURABHI SURABHI DESAL 09/20/2017 04:56:... 12/30/4000 12:30:...
SURABHI SURABHI DESAT 09/20/2017 04:44:... 12/30/4000 12:30:...
ABSHEKAR ANAND SHEKAR 09/20/2017 04:38:... 12/30/4000 12:30:...
PRITAM PRITAM JENA 09/20/2017 04:30:... 12/30/4000 12:30:...
SKSK SALSK 09/20/2017 03:54:... 12/30/4000 12:3
> PRITAM PRITAM JENA 09/20/2017 03:47.., 12/30/4000 12:30:... | (%
NAVEEN NAVEEN RECDY 09/20/2017 03:47:... 09202017 04:55:...
IAYANTA JAYANTA C 09/20/2017 02:37:... 12/30/4000 12:30:
SKSK SATSK 09/20/2017 02:35:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/20/2017 02:08:... 12/30/4000 12:30:
PRITAM PRITAM JENA 09/20{2017 01:45:... 12/30/4000 12:30:
IAYANTA JAYANTA C 09/20/2017 01:45:... 09/20/2017 02:37:
PRITAM PRITAM JENA 09/20/2017 01:27;.. 12/30/4000 12:30:
Svsv SHRIVATS SINGH 09/20/2017 01:20:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/20/2017 01:14:... 12/30/4000 12:30:
NAVEEN NAVEEN RECDY 09/20/2017 12:39:... 12/30/4000 12:30;
ABSHEKAR ANAND SHEKAR 09/19/2017 11:45:... 12/30/4000 12:30;
PHACHCODA PHANINDRA CHODA 09/19/2017 11:37:... 12/30/4000 12:30
NAVEEN NAVEEN RECDY 09/19/2017 11:32:... 12/30/4000 12:30
NAVEEN NAVEEN RECDY 09/19/2017 11:21:... 09132017 11:32: 5

2. Inthe User Logins section, sort the list of records to be displayed based on elapsed days
by selecting 1 Day / 1 Week / 1 Month / By Date. If ‘By Date’ option is selected, you can
specify a date range (within 3 months) in ‘Start Dt and ‘End Dt’ fields using the adjoining
calendar. Click ‘Search’.

A brief description of the fields is given below:

Field: View this:

User Displays the user ID.

User Name Displays the user name.

Details Displays the details.

Login Date and Time | Displays the login date time for the user.

Logout Date and Time | Displays the logout date time for the user.

3.5 Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications
sourced by different Producers.
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Navigating to Producer Analysis
Click Dashboard > Dashboard > Producer Analysis.

ORACLE" 2 Welcome, PRAKRRAO »  Ac

Financial Services Lending and Leasing

Producer Analysis 5

oard

Select Criteria
Users Productivity
System Monitor Company ALL [v] Teritory 2 Funder ALL ]
Producer Analysis Branch ALL[¥] Salles Agent ALL [v] Status >
Process Files

Region AL [v] Undenwriter ALL [v] zip &
Producers | Terrtories Activity | Volume || Mix
> Dealer

Recent Activity
No data to display. e Roiad Approved Funded
No data to display.

Recently Approved Applications
Applicant Name  Application # Amt. Collateral Desc
No data to display.

Recently Funded Applications
Applicant Name Application # Amt Collateral Desc
No data to display.
4

Recent Comments
&F petach
Date Comment Desc
No data to display.

> Origination
> Servicing
> Collections
> WEFP

> Tools

> Setup

B submit

Comments

You can filter producer details based on any or all of the following criteria:

e Company

e Branch
e Region
e Territory

e Sales Agent
e Underwriter
e Funder

You can select the values from the adjoining drop-down list. Click ‘Submit’ button. System

displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:

e Producer #
e Name

e Company
e Branch

e Type

Select the producer you need to view the statistics. The system displays the statistics under

‘Summary’ sub tab and the status and sub status of various applications under ‘Applications’

sub tab, of the selected producer.

The system displays the following details under ‘Summary’ sub tab:

e Year
e Total Apps
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Approved
Conditioned
Rejected
Withdrawn
Funded
Amount

The system displays the following details under ‘Applications’ sub tab:

Company
Branch
App #
Date

Title
Product
Status

Sub Status

Process Files

The Process files screen allows you to view the incoming and outgoing files exchanged
between OFSLL and other interfaced systems for processing and also perform a bulk upload
of required files.

The Process files interface also provide information on the type of files uploaded along with
other attributes. In-order to facilitate the process files handling, the following parameters has
to be enabled in Setup > Administration > System > System Parameters screen. For more
information on enabling system parameters, refer to ‘System Parameters’ section in Setup
Guides.

CMN_FILE_PROCESS _TO_LOB

On enabling the above parameter, system stores the incoming / outgoing documents in
the relevant tables and not in the file system.

UIX_INCOMING_FILE_PATH

UIX_OUTGOING_FILE_PATH

On enabling the above two parameters, the incoming and outgoing file path of
application server need to be defined to the required folder path by updating the
‘Parameter Value’ which by default is ‘SETME’. (For example: /tmp)

If both the parameter ‘CMN_FILE_PROCESS_TO_LOB’ and ‘OUTBOUND_CALL_Q’
are enabled (status ='Y"), system automatically handles upload/download of files from
Weblogic configured process files.

Depending on the CLOB parameter option, if set to ‘Y’ the incoming/outgoing file directories
are to be manually created in Web Logic server. For details of directories, refer to ‘Creating
Application Home directory’ section in Database Installation Guide.
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Incoming Process File

The incoming process file screen displays the list of files being shared from an external
system along with other attributes such as directory path, file name, type, size, date and
status. You can select the file required and upload it into the system forimmediate processing.

ORACLE’

Financial Services Lending and Leasing

y 1§ sgnour O

SHEKAR ~

Process Files

Incoming Process File  Outgeing Process File

Incoming Process File

View ~ Format = %
¢n

select Al [

Freeze  FfiDetach

Directory Name

" uploaded Files
View * Format~  [E

File Name

SampleR esponseAssets.json
SampleResponseAssets. json
LookupResponseWithLookupDescPassedAs_CALC.json
LookupRespanse\WithLookupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json
LookupResponseWithLookupDescPassedAs_CALC.json
LookupRespanselithLookupDescPassedAs_CALC json
LookupResponseWithl okupDescPassedAs_CALC json
LookupResponseWithl ookupDescPassedAs_CALC json

Freeze  EfiDetach

@

2= List Files

File Name

[} Jscratchfwork_area/DEV/DE. . callactivity_test XV.tet

B upload

File Type

W) Viewlast © 1Day®) 2Days@ 5Days@ Al Days

Fie Type

FACTORY DATA LPLOAD
FACTORY DATA UPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD
FACTORY DATA LPLOAD

File Dt

08/14/2017 12:41:17 PM
08/14/2017 12:39:22PM
08/04/2017 01:07:23 PM
08/04/2017 11:45:18 AM
08/04/2017 01:26:24 AM
08/04/2017 01:20:29 AM
08/03/2017 09:37:30 PM
08/03/2017 09:34:58 PM
08/03/2017 02:23:56 AM
08/03/2017 02: 18:27 AM

[E@ Download Bad Data
Status
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED
UPLOADED

File Size(bytes)

3 08/12/2016 05:23:01 AM NONE

[ Download Log Data

File Date

[® Jlose

)

Status

User
INTERNAL INT %
INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT

INTERNAL INT =

View the list Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming

files.

A brief description of the fields is given below:

Field:

Description:

Select All

Select this option to select all the listed files.

Directory Name

View the directory path where incoming file is stored.

File Name

View the name of the file.

File Type

View the type of incoming file. The file type is auto populated
based on ODD (Output Data Definition) details maintained for
the specific file type in INCOMING_FILE_TYPE_CD lookup.

File Size(bytes)

View the size of incoming file.

File Date

View the date and time when the incoming file was placed in

the directory.

Status

View the status of the file.

Upload Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L2l to refresh the grid data.

3. Select the check box adjacent to the required file and click Upload. You can also click

Select All check box to perform a bulk upload of all the listed files.
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3.6.2

The uploaded files are listed in below ‘Uploaded Files’ section and the status of the files
are changed from ‘Generated’ to ‘Uploaded’. In case of a processing error, the status of
the file is indicated as ‘Processed Error’.

Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You
can sort and view the list of files depending on the number of days based on Last 1 Day / 2
Days / 5 Days / All Days. You can click 2 to refresh the grid data.

On selection, you can view the following information:

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date and time when the file was uploaded.
Status View the status of upload.

User View the login ID of User who performed the file upload.

In the Uploaded Files section, you can do the following:

e Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.

Outgoing Process File

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

Financial Services Lending and Leasing
Process Files (%] Close
Incoming Process Fle | Outgoing Process File =
Outgoing Process File
View v Format~ & Freeze o Detach o] virap @R G Download  ViewLast © 1Day (@ 2Days(D) 5Days(@ Al Days
selectal O] File Name File Type File Date: File Size(bytes) Status
& customer_ach OUT PUT DATAFILE 07/10/2017 05:209:20 PM 533 GENERATED &
customer_ach OUT PUT DATAFILE 07/10/2017 05:26: 19 PM 533 GENERATED A
0B customer_ach OUT PUT DATAFILE 07/10/2017 05:29:18 PM 533 GENERATED 1
(s customer_ach OUT PUT DATAFILE 07/10/2017 05:29:17 PM 533 GENERATED
[} customer_ach OUT PUT DATAFILE 07/10/2017 05:29:15PM 533 GENERATED A
M (& customer_ach OUT PUT DATAFILE 07/10/2017 05:29:15 PM 533 GENERATED
[ data_change_lien_07102017_172914.dat OUT PUT DATAFILE 07/10/2017 05:20: 14PM 0 GENERATED
B customer_ach OUT PUT DATAFILE 07/10/2017 05:29: 13PM 533 GENERATED
E customer_ach OUT PUT DATAFILE 07/10/2017 05:20: 12 PM 533 GENERATED
] customer_ach OUT PUT DATAFILE 07/10/2017 05:20: 11 PM 533 GENERATED -
History
View ¥ Format~ [ Freeze ifiDetach gl Wrap [50)]

User Download Dt

DILEEP GRANDHI 08/10/2017 06:42:22 PM

DEMO SUPERUSER 07/31/2017 03:28:20 PM -

You can sort and view the list of files depending on the number of days based on Last 1 Day
/ 2 Days / 5 Days / All Days.
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On selection, you can view the following information:

Field: Description:

Select All Select this option to select all the listed files.

File Name View the name of upload file.

File Type View the type of file shared for upload. The file type is auto pop-

ulated based on ODD (Output Data Definition) details main-
tained for the specific file type in OUTGOING_FILE_TYPE_CD

lookup.
File Date View the date and time when the file was shared for upload.
File Size(bytes) View the size of upload file.
Status View the status of upload file.

Download Outgoing Process File

1. Click Dashboard > Process Files > Outgoing Process File.

System displays the list of files shared for upload. You can click ¥ to refresh the grid
data.

2. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.

History

The history section displays the following details:
Field: Description:
User View the login ID of User who downloaded the file.
Download Dt View the date and time when the file was downloaded.
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4. Sales Lead

The Sales Lead screen enables you to record information gathered during a sales query or a
call from a potential borrower. A sales representative can then use the Sales Lead screen to
follow-up with the borrower. This is not a mandatory screen. You can always begin the Line
of credit origination process directly using the Application Entry screen.

Information on the Sales Lead screen can be attached to the Application Entry screen as
optional information. Attaching a lead to an application can help the sales department analyse
the effectiveness of following-up with prospective borrowers. Once a lead is attached to an
application from the Sales Lead screen, Oracle Financial Services Lending and Leasing
changes its status to COMPLETED.

Lead Entry screen

The Lead Entry screen enables you to record information regarding prospective borrowers
from a sales query or a call to be used in a follow-up call. The initial status for the lead can be
set as NEW or FOLLOW-UP.

To complete the Lead Entry screen

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination
underSales Lead.

2. Onthe Sales Lead screen, click the Lead Entry.

ORACLE"
Financial Services Lending and Leasing

# Welcome, PRAKRRAO v Accessibility I

Sales Load (36 Glos=

vashBoard

Lead Entry | Follow Up | Maintsnance

Applicant Information 4k add || 7 Edit | view || <7 Audit
View - | Format+ | ER Freeze ] Detach wrap 51
Lesd = Lesd ot Company Eranch Frst Name Last Name sirth De Channal Sourca
UNDEFINED. 02/04/2016
15/2015 CONSULTATION  WEB ENTRY
ESTATE AGENT  FAXIN

nLoz nLHQ ROSEMARY BLACK.
uso1 usHQ TeST TEST LAST NAME  01/01/

CONSULTATION  WEB ENTRY
WEE ENTRY

CONSULTATION ~ OFFLINE APPLIC

CONSULTATION  WEB ENTRY,

L-00004004 uso1 usHg ANDRES MARTINEZ
<

Applicant Information

TE Ry T[] = ey v (reyr—
Address
‘

[~ =z
=) L sursi [~ =
= NORMAL ADDRESS [~

=]

=2
= [~]
= [~ = Followup Dt 2

Telecoms || Comments || Documents || Requests

- - Telecom Information 4= add || 2 Edit ] view | <7 Audit
> Servicing View > Format~ B Freeze §i Detach vrsp (5]

> Collections
> WEP

> Tools
> Setup

3. If you are entering a new applicant, click Add in the Applicant Information section.
_or'_
If you want to edit an existing applicant, select it in the Applicant Information section.

If you click Previous, Oracle Financial Services Lending and Leasing displays
information for the previous applicant. If you click Next, the system displays information
for the next applicant.

4. In the Applicant Information section, enter, view or edit the following information:

In this field: | Do this:

Lead # View the sales lead number (display only).
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In this field:

Do this:

Lead Date View the sales lead date. System defaults the current date
(display only).

Company Select the company name (required).

Branch Select the branch name (required).

First Name Enter the applicant’s first name (required).

Birth Dt Specify the date of birth. (required).

Last Name Enter the applicant’s last name (required).

Channel Select the channel of the sales lead (required).

Source Select the source of the sales lead (required).

5. Inthe Address section, enter, view or edit the following information:

— For creating a new record, click Add.

In this field: | Do this:
Type Select the address type (required).
Postal Type | Select the postal address type (required).
Apt# Enter the building number (optional) .
Pre Select the street prefix (directional) (optional).
Street Name | Enter the street name (optional).
Street Type | Select the street type (optional).
Post Select the street postfix (directional) (optional).
Apt # Enter the apartment number (optional).
Address 1 Enter the first address line (optional).
Address 2 Enter the second address line (optional).
City Enter the city (required).
St Select the state (required).
Zip Select the zip code (required).

Note: For non US country, you have to enter zip code.
Country Select the country code (required).
Email Enter the e-mail address (optional).
Alternate Enter the Alternate e-mail address (optional).
Email
Status Select the status for the sales lead (required).
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In this field: | Do this:

Assigned View the user code creating the sale lead (display only).
By

Status Dt View the last sales lead status change date (display only).
Follow-up Enter the sales lead follow-up date (required).

Dt

— If you enter a new record in the Address section, click Save.

411 Telecoms sub tab

The Telecoms sub screen records additional phone numbers for the sales lead.

To complete the Telecoms sub tab

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. Onthe Sales Lead screen, click the Lead Entry tab, then click the Telecoms sub tab.

ORACLE i i 2, Welcome, PRAKRRAO ~  Accessibility =)
Financial Services Lending and Leasing

Clnee
DashBoard Sales tead [Ef=

ongmaton Lead tntry | rollow-up | Mamntenance
g

- i i Faid | P o | PR T
Application Entry Applicant Information 4= Ac Y 3] Ve > &

[ — oz [ Detach wen @R
Lcad & Company Sranch st tiame Last Name sirth Dt channel
UNDEFINED:
L-00002006 NLO2 NLHQ ROSEMARY BLACK 12/08/1987 CONSULTATION ~
Loo001002 usox usta esT TeST LasT name o = cent
L 00003002 uso usHo sonp James
L-o0002002 usos usra FrANINDRA crooa UL raTion
L 00002004 usos usHo BoREN RoBERT
L 00008002 uso1 usta TN JosH CoNsULTATION ucw
Cogoosoos uso1 usha AnDRES MARTINEZ oa/os/1988 consuTATION e enTRY

& save and dd <A Retum
Address
= =
. UNITED STATES [~]
< = =]
NORMAL ADDRESS -
= =
[~
=
= ﬁ
(=]
Telecoms || Comments || Documents || Requests
— Telecom Information 4 add | A Edn v <7 Auds
D Sennicing eze 5 Detach wrsp =Y

> collections Phone Current
> wer

> Tools
> Setup

3. On the Telecoms sub tab, enter, view or edit the following information:
— To create a new record, click Add.

In this field: | Do this:

Telecoms section

Telecom Select the type of telecommunications device
Type (required)

Phone Enter the phone number (required)

Current Select the Current check box to indicate the phone

number is in service.

— If you enter a new record in the Telecoms sub tab, click Save.

4.1.2 Comments sub tab

The Comments sub tab records any comments regarding the sales lead.
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To complete the Comments sub tab

1. On the Oracle Financial Services Lending and Leasing home screen, click Sales Lead.

2. Onthe Sales Lead screen, click the Lead Entry tab, then click the Comments sub tab.
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& Welcome, PRAKRRAO ~ _ Accessibilty =]
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L-00002004 1271 usot usrg BOREN E8 ENTRY
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38 Close.

3. Onthe Comments sub tab, enter, view or edit the following information:

— If you are creating a new record, click Add..

In this field:

Do this:

Comments section

Comment Select the comment type (required).

Type

Sub Type Select the comment sub type (required).

Comment Enter the comment (required).

Comment View the date the comment was entered and saved (dis-
Dt play only).

Comment View the user id of the person who entered and saved
By the comment (display only).

e If you enter a new record in the Comments sub tab, click Save.

Documents sub tab

The Documents sub tab needs to be completed if:

e The customer had requested any documents.

e Any document has been sent to the customer during sales lead entry.

To complete the Documents sub tab

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.
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2. Onthe Sales Lead screen, click the Lead Entry tab, then click the Documents sub tab.
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3. On the Documents sub tab, enter, view or edit the following information:

— If you are creating a new record, click Add.

In this field: | Do this:

Documents section

Document Select the document type (required).

Type

Sub Type Select the document sub type (required).

Documents | Enter the document (required).

Document View the date the document was entered and saved (display
Dt only).

Document View the user id of the person who entered and saved the
By document (display only).

— If you enter a new record in the Documents section, click Save.

Requests sub tab

The Requests sub tab records the product the customer is interested in and the requested
amount for each product.

To complete the Requests sub screen

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. On the Sales Lead screen, click the Lead Entry tab, then click the Requests sub tab.

3. On the Requests sub screen, enter, view or edit the following information:

— If you are creating a new record, click Add.

In this field:

Do this:

Requests section
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In this field: | Do this:

Product Enter the requested product as Line of credit
(required).

Requested Enter the requested amount (required).
Amount

e If you entered a new record in the Requests section, click Save.

Follow-Up screen

The Follow-Up screen enables you to update customer information based on sales lead
follow-ups with the customer.

To use the Follow-Up screen

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. Onthe Sales Lead screen, click the Follow-Up tab.

3. Inthe Status section, click:
— New to view all leads on the Follow-Up screen with the status of NEW.
-or-
— Follow Up to view all leads on the Follow-Up screen with the status of FOLLOW UP.
-or-
— All to view all leads on the Follow-Up screen.
4. Inthe Assigned section, click:
— Assigned By to view all leads on the Follow-Up screen assigned to the current user.
-or-
— All to view all leads on the Follow-Up screen assigned to any user.

5. On the Follow-Up screen, enter, view or edit the following information:

In this field: | Do this:

Company View the company name of the sales lead (display only).

Branch View the branch name of the sales lead (display only).

Followup Dt | Select the follow-up date of the sales lead (required).

Lead # View the sales lead number (display only).
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In this field: | Do this:

Lead Date View the creation date of the sales lead (display only).
Name View the applicant’s name (display only).

Last Name View the applicant’s last name.

First Name View the applicant’s first name.

Assigned View the user assigned to the sales lead (display only).
by

Status Select the status of the sales lead (required).

Status Dt View the last sales lead status change date (display only).

6. Click Save on the Follow-Up screen.

Maintenance screen

The Maintenance screen enables you to attach a sales lead to a different or missed
application or change status of lead as NEW.

To attach a sales lead to an application

1. On the Oracle Financial Services Lending and Leasing home screen, click the Sales
Lead master tab.

2. On the Sales Lead screen, click the Maintenance tab.

3. Inthe Lead Details section, view the following display only information:

In this field: | Do this:

Select If selected, indicates this is the current record.

Lead # View the sales lead number.

Last Name View the last name of the sales lead.

First Name View the first name of the sales lead.

Status View the status of the sales lead.

Company View the company of the sales lead.

Branch View the branch of the sales lead.

Days of View the number of days of inactivity regarding the sales
Inactivity lead.

4. Inthe Lead Details section, select the sales lead you want to attach to the application.
5. Inthe Action section, click Attach to an Application.

6. Inthe Action section, select the application number to which you want to attach the sales
lead in the unlabelled App # field.

7. In the Action section, click Post.
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8.

In the Application section, view the following display only information:

In this field: View this:
Select If selected, indicates this is the current record.
Priority The priority of the sales lead.
Application # The application number of the sales lead.
Date The date of the application.
Title The title of the application.
Product The product of the application.
Status The status of the application.
Producer The producer of the application.
Note

If a wrong sales lead is attached to an application, detach it from the existing application
by clicking Change to New Status in the Action section. You can then attach it to the cor-
rect application clicking Attach to an Application, completing the App # field and clicking

Post.
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5.1

5.2

5. Simple Application Entry

Introduction

The first step in the Line of credit origination process is entering credit application data into
Oracle Financial Services Lending and Leasing Application. The Simple Application Entry
screen enables you to specify information from the credit application into the system and
request a credit bureau report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in the Applications
section. The product defines the type of credit application: Line of credit as well as any
collateral, such as vehicles or homes, associated with the Line of credit. When you save
the application, system activates the links on Applications screen that are associated with
the product, streamlining the application process. The producer is the dealer supplying
the application. When selected, the status of the Producer is displayed along with
Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Line of credit such as Line of credit
amount and number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by the credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications

section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.
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To enter a new application

1. Click Origination > Origination > Simple Application Entry.

ORACLE

Financial Services Lending and Leasing

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Undenwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Verdors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination

Review Requests (Pending: 0)

Application
Vieww Formate [ Freeze  &ff Detach J Wrap B Overrideok _  Waming OK _
ot app= Sub Unit Status g‘i"’a""" S8 producer Name
No data o display.
Applicant || Request || Comments | Tracking | Verification
Applicant  Customer Search
Applicant
View = Formatv [ Fres i Detach
Relation Type First Name M1 Suffix 5N
No data to display.
<
Address  Employments | Telecoms
Addresses
View ~ Format~ [P Freeze  FfiDetach | ol wrap (5]
Current Permission to Call  Qvn/Rent Address Type Addresslinel Gty

No data to display.

[3 Close
Fodd || Lede | [Eview | o avde
Producer Contact z Duplicate
Sy Busting Customer (RS Contact
>
Elyiew | o at
Birth Dt License # License State Lang
2>
‘
Fpadd | Aedt | Elview | &2 audic
State Zip Stated Years
>

2. The Simple Application Entry screen appears, opened at the Search link’s Results

screen.
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DashBoard
Origination
Origination
Sales Lead
simple Application Entry
Application Entry
Underuriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination x

Search/Task | Simple Application Entry || Review Requests (Pending: 0)
Quick Search

Bpp & B Identification &

Queue ] Next Application

> Search Criteria

o New Application

Search Results/Task

View ~ Format- [P e & Datach W vewan [

Critical Locked  Allowed  Company Branch  App % Date Titie Product

No data to display.
<

[ Close:
Submit
(L gpen Application ‘View Application Unlock Application
Status Sub Status @
>

The Recreate Instance button appears only when the BPEL parameter is YES.
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3. Inthe Results tab’s Quick Search section, click New Application. The Search link’s
Applications Entry screen opens at the Simple Application Entry tab.

ORACLE" . . 2 Welcome, PRAKRRAO v Accessibility o
Financial Services Lending and Leasing

igi Close
IR Origination x [E3]e
Origination Search/Task | Simple Application Entry: 0000001536 | Review Requesis (Pending: 0) ~
Origination
Sales Lead el 5 T =
pplication: 0000001536: RODRIGUEZ MILDRED i E View | o Audit
Simple Application Entry || L e
pplication Entry View w Formatw (5 Fresze EfiDetach ¢ Wirep B OverideOK ¥ Waming OK v
Originatien Stage Producer Contact o Duplicate
Dt App # Sub Unit Status e Producer Name  HO0MCS! Bristing Customer [ RS Contact
0/05/2015 0000001536 APPROVED - FUN... FUNDED CA00003 : ACEH... (818)}761-2277 ¥ ¥
= < >
Applicatior
Image Maintenance
Reports Application
Producers Ga e

Vendors

App # 0000001536 Billing Cycle WEEKLY Class SMALL BUSINESS
Purposs VEHICLE LOAN OR LEASE Sales Agent DEMOSUPR

Producer DEALER

Producer Namea  CA-00003 : ACE HEADQUARTERS ING{ ACTIVE )
Producer (818)-761-2277
Contact

Lead #
CRB Pull ¥

! Branch USHQ

«
Sub Unit PI1 Override OK ¥
tus APPROVED - FUNDED Warning OK ¥
n Stage Code FUNDED
Applicant | Business | Request | Collatersl | Comments Tracking | Verification
Applicant
Applicant Elview || o2 audit
View v Fomatw [ Freeze  EA| Detach Wrap 50
" = Relation Type First Name M Last Name Suffix SN Birth Dt License License State L
> Servicing
N PRIMARY MILDRED BURKETT RODRIGUEZ ® xem0ed417 01/03/1965 COLORADO ]
> Collections
< >
> WFP
> Tools Address = Employments  Telecoms
5 v
» Setup

For field description refer Applications of the Underwriting chapter:

Copying Lead details

After selecting the sales lead number in the Lead # field and on clicking Copy Lead Details,
the applicant details which were captured in the Sales Lead screen are populated in the
Simple Application Entry screen. The Copy Lead Details button will be enabled only when you
select the lead number in the Lead # field.

Pre-qualifying an Application

After entering the basic details of the applicant like identification and demographic details
along with the address, employment, assets, liabilities and other income information and
requested details, the user has to check whether the application pre-qualifies or not by
clicking Pre-qualify Application button. This is governed by a set of Pre-qualification edits.

If pre-qualified edits are satisfied, the status is changed to NEW-PREQUALIFY APPROVED
and user can modify or update any further details in the Application Entry screen.

If the edits are not satisfied, application will be pushed to REJECTED APPLICATIONS queue
with a status update to REJECTED-PREQUALIFY REJECTED. You can also view rejected
pre-qualification in the Underwriting screen.

When specific services listed in Dashboard -> System Monitor -> Services tab are 'stopped’,
the application status will display 'NEW PRE-SCREEN APPROVED' and user will not be able
to change the status manually to move it to Underwriting queue. In such cases, services
should be started post which the application is processed automatically by the system and
falls in the appropriate queue as per work flow.
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5.3 Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Financials

e Liabilities

e Other Incomes

e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts.

The system uses information on Financial and Liabilities sub tabs to determine the applicant’s
net worth. The system uses information on Employments tab and Other Incomes sub tab to
calculate applicant’s debt-to-income ratio.

Note the following while completing frequency fields:

e Biweekly in the system means ‘once every two weeks’ and not ‘twice a week’.
e Bimonthly in the system means ‘once every two months’ and not ‘twice a month’.

For more information, refer appendix Payment Amount Conversion.

To complete the Applicants Details screen

1. On the Simple Application Entry tab, click Applicant > Applicant.

ORACLE"
Financial Services Lending and Leasing

F—— Close
> DashBoard rigination i 3]
Origination
5 Applicant Elvew | « Audt
Origination e
Sales Lead View v Formatv [P Freeze & Detach ol virap (o0}
simple Application Entry Relation Type First Name. ML Last Name Suffix 55N Birth Ot License & License State Language
applcation Entry
15 i No data to display
Underwriting | Pr— 5
Funding
Application Retrieval
Scenario Analysis Applicant
Appication Documents CaRetun
Image Maintenance
g Relaton Type Prior Appicant _ Bankruptey Discharge Dt
Producers Salutation Existing Customer _
Vendors First Name Existing Customer ID Kyc
Mt Existing Customer #
Last Name Reference #
g Famiy Name Other Details Status 4
Suffix E
Birth Dt Name in Local Language FATCA
Gender
s
Class Mother's Maiden Name Birth Place
e Education Birth Country
i Permanent US Resident Status _
Time Zone ouag
Dependents
Power of Attorney
Identity Information Marital Status
Eeon Power of Attorney __
Nationality Race Holder Name
National ID Ethnicity
> Servicing Address
Passpart # Disabiity _ ey
> Collections Passport Issue Dt Peiacy OPLOUE. Nationality
> WP Passport Expiry Dt nsrence OptOut. Telephone Number
5 Visa # Marketing Opt Out _
> Tools s arketing Opt Out
License # Share Credit Opt Out __
> setu 5 i
2 License State Prior Bankruptey _ a
Copyright © 1338, 2016, Oracle and/or its affiiates. All rights reserved. About

2. For details on this screen refer Applicant Tab of the Underwriting chapter.
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5.4 Business Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving Line of credit
application during underwriting. The Business Applicant screen is available for Line of credit
and contains the following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

o Affiliates

e Other details

To complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on Application Entry screen.

2. On the Application Entry screen, click Business.

ORACLE . . | & Welcome, PRAKRRAQ =  Accessibility o
Financial Services Lending and Leasing
e Close.
e Origination 5 ma
‘Origination Search/Task  Simple Application Entry: 0000001537  Review Reguests (Pending: 0) A
Origination
Sales Lead Application: 0000001537: RODRIGUEZ ROBINSON Bl view || o Audit
simple Application Entry N -
Application Eriry View~ Fomaty [ Freeze T Detach Wrap @) Overide OK ¥ Woming OK v
Underwriting Origination Stage Producer Contact istir Duplicate
iy Dt App # Sub Unit Status e Producer Name i Existing Customer Appication Contact
Application Retrieval 09/05/2015 10000001537 APPROVED - FUN... FUNDED CA-D0003 : ACE H. (818)-761-2277 N N
Scenario Analysis >
Application Documents
Image Maintenance
Reports applicant Business  Request  Collateral | Comments | Tracking | Verification
Producers
Vendors Business  Business Search
Business Details [ Elvew | o audit
View » Formatw B3 Freeze  Eff Detach Wrap 50}
Organization Type  Business Type: Business Catogory Business Name Legal Name TaxID# Start Dt Ao E”""“’(VS:S # of Employess
CQORP SERVICE SETME INTERSHELL INTE... INTERSHELL INTE... x00x0987 01/01/1968 12 32
< < >
“
Business Details
<3 Retum
Organization Type C CORP
Business Type SERVICE
Business gory SETME
Business Name INTERSHELL INTERNATIONAL Business Checking Bank CITI
CORP Bank Acc # 735334066
Legal Name INTERSHELL Currency USDOLLAR
INTERNATIONAL Avg Chacking Balance 87,750.00
PR il wvg Checking Balance 87,790,
Start Dt 01/01/1968
Address | Telecoms Financials  Lisbilities = Partners  Affiliates  Other Details
> Servicing Address Information Elvew | o audit
> Collections View~ Formatv [ Freeze B Detach wee | @
> WFP Address Type Country Address City State Owin/Lease Comment Postal Type Street Pre
BUSINESS UNITED STATES 100 CORPORATE CANTON MASSACHUSETTS ~ RENT NORMAL ADDRESS  NORTH
> Tools 7 >
v
> Setup

For details on this screen, refer Business Tab of Underwriting chapter.

5.5 Request Tab

Depending on the type of product you select, the following screen will be available from
Requested tab

To complete Request tab:
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5.6

1. On the Application Entry tab, click Request tab.
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ssibility o

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination x

Search/Task  Simple Application Entry: 0000001536 Review Reguests (Pending: 0)

Application: 0000001536: RODRIGUEZ MILDRED

View~ Format~ [ Freeze i Detach
ot App# Sub Unit
05/05/2015 0000001536

Status
APPROVED - FUN.. FUNDED

@) OverideOK v  Waming OK v

Ongination Stage
e Producer Name

Applicant | Business || Request | Collateral | Comments || Tracking | Verification

Requested
View v Format~ [ Freeze  Eff Detach
Credit Limit Advance Promotion
16,900.00 18,500.00 NONE
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Credit Limit 18,900.00

Ttemization  Trade-In | Subvention
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Vieww Fomatv [Ep Freeze 54 Detach
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TTM OTHER FEE +

ITM AMOUNT PAID TO OTHERS ON M.

ITM AMOUNT PAID ON MY LOAN ACC... +
ITM AMOUNT GIVEN TO ME DIRECTLY  +

Advance 18,900.00
wep B
Reguested Amt Comment
0.00
18,900.00
0.00
0.00

Existing Customer  DUAICatE Contact

CA00003 : ACE ... (818)-761-2277

[ Gose:

view || < Audit

Application
¥
>

[ Elven || o mat

<A Retum

Promotion UNDEFINED

B vew || o audit

Total Requested 18,500.00

For details on this screen refer Request Tab of the Underwriting chapter:

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screens: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
screens share. If you are entering an unsecured Line of credit, the Collateral tab is present
but inactive; in which case, skip this step.
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To enter vehicle information from the Collateral tab

1.

On the Application Entry link bar,

click Col

ORACLE
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lateral.

DashBoard
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Funding
Application Retrieval
Scenario Analysis
Application Documents
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Application: 0000001536: RODRIGUEZ MILDRED fiew || o Audit
View » Format— [ Fre & Detach p W Override 0K v Waming OK v
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Valuation  Tracking
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Loan Currency Usage Value Amt
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To enter home information from the Collateral tab

1.

RACLE’
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On the Application Entry tab, click Collateral sub tab.
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If collateral is any other, the Collateral link displays information about that collateral.
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For details on this screen, refer Collateral Tab of the Underwriting chapter.

Comments Tab

When using the Simple Application Entry screen, you can add comments to an application at
any time in the application entry process by clicking Comments tab.
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To complete the Comments tab

1. On the Application Entry tab, click comments.

ORACLE
Financial Services Lending and Leasing
DashBoard Oexielion x
Origination Search/Tesk  Simple Application Entry | Review Requests (Pending: 0)

Origination
Sales Lead Kplication
Simple Application Enfry -
‘Application Entry View v Format~ cze I Detach ] Wrap @ Override 0K _  Warning OK __
tileieiiy ot Aop 2 Sub Unit Status Onigination Stage  progcer Name | Froducer Contact
Funding e e
Application Retrieval o (” SO
Scenario Analysis
Application Documents.
Image Maintenance
Reports Applicant | Request = Comments Tracking | Verification
Froducers
Vendors

Comments
View v Formatv [ Freeze i Detach J wrap 5]
et Type Sub Type Comment
O REGULAR [v] | Loan oRIGINATION [v]
o

> Servicing

> Collections.

> WFP

> Tools

> Setup

dpadd | Aedi || 5 view || o audie

Duplicats
Application Conkact

| B sove and stay saveand Retum || GaRetum

[ Close

>

Comment Dt
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For details on this screen, refer Comments Tab of the Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.

What items you choose to track are setup during implementation.
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To track attributes

1. On the application entry screen, click the Tracking tab.

ORACLE" 2 Welcome, VAVAIDYA ~  Accessibility o
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For details on this screen, refer Tracking Tab of the Underwriting chapter

Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you to change application’s status and approve Line
of credit until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

To validate a credit application

1. Enter all the information associated with the application on the Application Entry screen.
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2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.

ORACLE’
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> Servicing
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For details on this screen, refer Verification Tab of the Underwriting chapter.

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.
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5.10 Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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6.1

6.2

6. Application Entry

Introduction

The first step in the Line of credit origination process is entering credit application data into
Oracle Financial Services Lending and Leasing Application. The Application Entry screen
enables you to specify information from credit application into the system and request a credit
bureau report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in Applications
section. The product defines the type of credit application: Line of credit as well as any
collateral, such as vehicles or homes, associated with the Line of credit. When you save
the application, system activates the links on Applications screen that are associated with
the product, streamlining the application process. The producer is the dealer supplying
the application. When selected, the status of the Producer is displayed along with
Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Line of credit such as Line of credit
amount and number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen. Pre-
qualification edits can be viewed from the 'Verification' sub tab.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications

section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.
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To enter a new application

1. Click Origination > Origination > Application Entry.

ORACLE
Financial Services Lending and Leasing
F— dlose
> DashBoard Grigmation h o
Origination Search/Task Application Entry: 0000001394  Review Requests (Pending: 0)
Orignation
SalesLead Application: 0000001394: MEHTA SHRIVA ZEdt || E]vien || o audt
:"”'i'ﬁ CW";E‘;”" Entry Vew v Formatv [ Freeze {fiDetach @) OverrideOK ¥ WarningOK v 8} Process Applicaton  §€% Pre-Qualify Application
ppiication Entry
) Sub Origination Producer Existing  Duplicate
\:nd;r/vrmng Dt App £ o Status Stage Code_ Producer Name oo s O s (o Sales Agent
unand 1 01/19/2016 0000001394 NEW - BLANK. NEW. CA-00001 : DEMO{ ACTIVE ) (000)-000-0000 ¥ % DEMOSALES
Application Retrieval o = i v
Scenario Analysis .
Application Documents
Image Maintenance
Reparts summary | Applcant Request = Colatersl | Comments | Tracking | Verficaton | Tools
Producers
Vendors
Requested A Edit View | o Audit
View v Formatv [y Freeze pfiDetach | ol Wrap %] [l Calaate
Eagected "dva‘:;ft Pt Amt Term  RequestedRate Down Prit % Down Pt Approx Pre Promotion Balloon Amt Sigring Dt
0.0 0.0 0 0.0000 0.00 0.00 0.00 NONE 000
« 1 | L3
i
L3
Ttemization Trade-ln  Subvention
Itemization it || [ ven || of Audt
View v Formatv [y Freeze  fiDetach ®
Ttemization +- Requested Amt Comment
- ITM DOWN PAYMENT | 0.00
TTM AMOUNT PAID TO OTHERS ONMY . + 0.00
TTM DOWN PAYMENT PAYOFF + 0.00
TTM AMOUNT PAID ON MY LOAN ACCO... + 0.00
TTM DOWN PAYMENT TRADEIN . 0.00
ITM CREDIT INSURANCE LIFE + 0.00
ITM CREDIT INSURANCEDISAEILITY  + 0.00
> Servidng ITM INSURANCE GAP + 0.00 -
= Coléctins Total Requested Amt 0.00
7 WP
> Tools
> Setup

2. The Application Entry screen appears, opened at the Search link’s Results screen.

ORACLE’
Financial Services Lending and Leasing

e Origination x
Origination SearchfTask | Appication Eniry | Review Requests Pending: 0)
Orignation Quick Search
Sales Lead
Simple Applcation Entry App # Ssh Identification =
Appiication Entry
Underuriting
Funding Queue [=] | (B bext application
Application Retrieval
Seenario Analysis > Search Criteria
Application Documents
Image Maintenance
Reports
Producers Search Results/Task
Vendors vewr Fomaty [Ef] (lFees et durep | @ viewal [
GritLodl Al Company  Branch App Date Titke Product
No data to display.
] i
Colums Hidden 1
4
> Servicing
> Collections
> WFP
> Tools
> Setup

[/ dose

Submit

o New application | | [[] Open Application

%FUNDED %
Status Sub Status

The Recreate Instance button appears only when the BPEL parameter is YES.
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3. Inthe Results tab’s Quick Search section, click New Application. The Search link’s
Applications Entry screen opens at the Application Entry tab.

ORACLE'
Financial Services Lending and Leasing

T Origination [ Cose
Origination Search/Task ~ Application Entry: 0000001810  Review Requests (Pending: 0) l‘
Origination %
SalesLead Appiication: 0000001810: AGRAWAL PRACHI St | o Auit
Simple Application Entry View~ Fomatv [ Freeze fiDetach | ol Wrap W overdeox v wamngok ¥
Application Entry 5
U:Zarwrmng / Dt App # Sub Unit Status 2:3':““” e Producer Name ;LD::: et Existing Customer  Duplicate Application ~ Con L
Funding 02/25/2016 0000001810 51 APPROVED -FUNDED  FLUNDED CA-D0009 : HARRY M... (618) 8879876 ¥ ¥ |
Application Retrieval < I [
Scenario Analysis | i
Application Documents |
Image Maintenance: Appﬁfﬂﬁﬂﬂ
Reports CaRetum
Producers
Vendors
1 App = 0000001810 Billing Cyde WEEKLY Class INDIVIDUAL
Dt 02/25/2016 Purpose VEHICLE LOAN OR LEASE Sales Agent DEMOSALES ¢
Product LINE HE {FR) Producer DEALER Joint _
Chamnel WEB ENTRY Producer Name  CA-00009 : HARRY MOTORS( ACTIVE) CoSigned __
Priority NORMAL Producer Contact (518)-887-9876 Contact
Company US01 Number Lead #
Branch USHQ Region ALL CRBPUl _
SubUnit 51 Territory AL Override OK ¥
Status APPROVED - FUNDED Existing Customer ¥ Warning OK ¥
- Origination Stage Code  FUNDED Duplicate Application '
 Servidng Loan Currency USD
> Collections
> WEP Summary Applicant  Request Decsion Contract Colateral Comments Tracking Document  Verification = Correspondence
»» Tools Applicant
> Setup o

For details on this screen refer Applications section in Underwriting chapter.

Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Financials

e Liabilities

e Other Incomes sub screens
e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts
e Tracking Attributes

The system uses the information on the Financial and Liabilities sub tabs in determining the

applicant’s net worth. The system uses information on the Employments screen and Other
Incomes sub screen to calculate the applicant’s debt-to-income ratio.
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To complete the Applicants Details screen

1. On the Application Entry tab, click Applicant > Applicant.

ORACLE’
Financial Services Lending and Leasing

e Close
» DashBoard e u
origination Applicant
Save and Stay Save and Return Retum
Origination = a d =
Sdlestead | | B R o
= . = rior Applcant ; E,
Simple Applicat] Relation Type | COSIGNER [=] ool Bankruptzy Discharge Dt 73
Existing Customer _
Appiication Ent| salutation [+
L Existing Customer ID NONE [0] kv
i *First Name | RAF Existing Customer # 0000000000
Funding
Mt Reference ¥
Application Ref|
ppicationie Other Details
Scenario Analy| * LastName | GERWYH] Status [+l
| “
Application Dod Family Name Name in Local
Image Mainten| FATCA
Qe Suffix EI Language I}i
Reparts . @ Gender UNDEFINED [=
Producers Brth Dt 07/04/1380 B Birth Place
5 E Mother's Maiden
Vendors *SSN XX 004564 siiatian i Birth Country =
. Education [=] =
Class NORMAL [=] Permanent Us Resident [
*L ENGLISH -
i Email age E‘ Status
. *Dependents 0
Time Zone [=] Power of Attorney
Marital Status [=]
Identity Information ECOA INDIVIDUAL = Power of Attorney [ .
Race = Holder Name
* Nationality USA .2 Address
Ethnicity [+l
*MNational D 4-654-1561 Loanlry
B * Disabity [7) Nationality
@ *Privacy opt out [ Telephone Number
A Passport Issue Dt * Insurance Opt out [
. ’ Passport Expiry Dt ) *Marketing Opt out [T
> Servicing Visa = * Share Credit Opt out 1]
’ Collections o =prior Barkruptcy [
> Wrp License State [l
> Tools Address | Employments | Telecoms | Summary || Credit Scores | Duplicate Applicant | Existing Accounts || Tracking Attributes
> Setup

Copyright © 1998,2016, Oradle and/or its affiiates. Al rights reserved About
For details on this screen refer Applicant Tab section in Underwriting chapter.

6.4 Business Applicants Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving the Line of
credit application during underwriting. The Business Applicant screen is available for Line of
credit and contains the following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

e Affiliates

e Other details

To complete the Business Applicant screen

1. If SME business information is included on the application, select SMALL BUSINESS
inClass field on Applications section and click Save.

The Business tab appears on the Application Entry screen.
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6.5

2. On the Application Entry screen, click Business.

ORACLE & Welcome, DEMOSUPR +  ccesspiity 8 sgnout O
Financial Services Lending and Leasing
> DashBoard Origination [ Close
Origination Result/Task Application Entry: 0000002668 Search Review Requests (Pending: 0) ES
V' Origination
i Edit View Audit
Sales Lead Appiication et | Elven | e |
Simple Application Entry View v Format v | Ep Freeze  ffivetach | o wrap B overrice ok [] warning 0K {83 rocess Appicaton | 83 Pre-uaify Applcation |
Application Enry | | Producer ‘
- |arigination Stage Existing
Underwriting Dt App # |5|atus foae Producer Name Contact ‘ e |8
Funding _ = | - - Number_
Applaton Retrieval [ Bz 0000002568 NEW -BLANC New AE-00002 : TIN TAN PRO( ACTIVE ) (14785238570
Scenario Analysis Al L ~ k
Application Documents
Image Maintenance
Rt Summary Applicant Business Request Collateral Comments Tracking Verification Tools
Producers -
i Business Details Fradd | PEdt | [Sven | o audt
Wiew =] Fomat ~ | Freeze  GfiDetach e | B
Organization Type  |Business Type Business Name [Legal Name TaxID £ Start Dt # of Employees(Cur) #of Employees ContactPer
o o
[ i | v
il -
Business Details ﬂ
H seveand add | [ saveandstey | [ saveandRetum | Gametm |
* Orgarization [+] *Start Dt & * Bank Acc #
Type
_ ihw *2of =ava[p
Business [=] Employess(cur) Chedking
Type *40f[g Balance
5 5“5;‘”“5 Employees *#of
ame
Contact Person A
*Legal Name *Management [
* Business S
*TaxID # Checking Bank
5 P — = . '
Address | Telecoms Financials Lizbilties Partners Affiiates Other Details
Address Information dp add | 7 it =] view | o Audit
2| Servicing view  Format v | Ep Freeze £ Detach Il Wrap 5]
>/ Collections |address Type |country |address # |ty |state |ownpLease |comment |Postal Type |streetpre
> WFP Mo data to display.
< m *
>/ Tools % -
Columns Hidden 1
»| setup o

For details on this screen refer Business Tab section in Underwriting chapter.

Request Tab

Depending on the type of product you select, the following screen will be available from

Requested link

To complete the request tab:
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6.6

1. On the Application Entry tab, click Request tab.

ORACLE
Financial Services Lending and Leasing

T — Origination » [ Close.
Origination Search/Task  Application Entry: 0000000382 | Review Requests (Pending: 0)
Origination
Sales Lead Application: 0000000382: TOLMAN GREG / EVA 2t || Elven || o audt
i\mp‘\e :PP“;E‘:“ Entry View v Formatv [ Freeze i Detach ] irap B overideOK ¥ WamingOK v {g}Process Appiicaton  {§} Pre-Qualify Appication
\pplication Entry :
, Sub Origation Praducer Existing  Duplicate
:ndsmnhng ot hpp o stas Chage Code  ProducerName oot e b e e A (St Sales Agent
e 02/01/2012 UND... APPROVED - AUTO APPR... NEW GA-00004 : ADVANCE LEA .. (770)-424-6450 N N
Application Retrieval 7 = i P
Seznario Analysis
Application Documents
Image Mantenance
Reports Summary || Appicant  Request | Dedsion || Contract | Collateral | Comments | Tracing | Document  Verification | Correspondence | Tools
Producers
Vendars
Requested et || [ vew || o audt
View v Formatv [} Freere  fiDetach | ol Wrap 5] [=] [B caaiate
Eedested “d"a:;ft Pmt Amt Term  Requested Rate Down Pmt % Down Pt Approx Prc Promation Balloon Amt Signing Dt
15,000.00 47,77 % 8.9900 0.00 0.00 15,000.00 NONE 0.00
« i R
4
»
Itemization  Tradedn  Subvention
Itemization St | [Fvew | o Audt
View = Format~ (5 Fresze [fiDetach | ol wrap o]
Itemization 4 Requested Amt Comment
ITM DOWN PAYMENT - 0.00 A
ITM DOWN PAYMENT PAYOFF + 0.00 E
ITM DOWN PAYMENT TRADEIN - 0.00 3
ITM CREDIT INSURANCE LIFE + 0.00
[TM CREDIT INSURANCE DISABILITY  + 0.00
ITM INSURANCE GAP + 0.00
ITM FILING FEE + 0.00
> Servicing ITM LICENSE FEE + 0.00 -
b Collechions Total Requested Amt 15,000.00
 WFP
> Tools
> Setup

For details on this screen refer Request Tab section in Underwriting chapter.

Bureau Tab

The Bureau tab displays credit report (if pulled) for an applicant. If there is a need for another

pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab

1. Open the Application Entry screen and load the application you want to work with.
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2. Click Bureau

ORACLE’
Financial Services Lending and Leasing

mr—— Close
e Origination ]
Origination Search/Task | Application Entry | Review Requests (Pending: 0) -
Origination *
Sales Lead
Simple Appication Entry
Application Entry Applicalion padd || ZEdt | [Fven | of Audt
Underwriting view = Format v [f5H| Freeze EfiDetach ol Wrap W overideock _ WamingOK _
Funding S
Application Retrieval ¢ % = sy — e e
; 4 u rigination roducer xistng  Duplicat
Scenario Analysis Dt A = it Status Stage Code  Producer Name Contact Number Customer Appication Contact Sales Agent
Application Documents No data to dsplay.
Image Maint=nance i = ™ D
Reports =
Producers
Vendors
Summary Applicant  Request | Decsion  Bureau  Contract| Comments | Tracking Document | Verificstion — Correspondence
Consumer
Bureau Details qpadd | ZEdt | [ view | o Audit
q IMPORTANT: Access to credit reporting agency systems is for authorized users and only for permissble purposes. Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable
by a $2500 fine and/or 1 year in Federal prison per occurrence 4
View v Formatv  Ep Freeze [ffiDetach | ol Wrap @) 3 submitRequest
Type Bureau # Status Dt Report S’Eﬂ;“gﬁ“
No data to display.
< il 3
Bureau Details
CaRetum
Bureau Details
Type Status Credit Bureau Reorder #
Bureau ot AppInd _
= Report
> Servicng Applicant/Customer Details
> Collections i Brevious Next Last
> WFP
Type Suffix Address Line 2
> Tools First Name Include Debt State
> Setup ML Popuiate Debt 7p L

For details on this screen refer Bureau Tab section in Underwriting chapter.

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screen: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
link’s screens share. If you are entering an unsecured Line of credit, the Collateral link is
present but inactive; in which case, skip this step.

To enter vehicle information

from the Collateral tab
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Collateral link displays information about the vehicle

ORACLE

Financial Services Lending and Leasing

On the Application Entry link bar, click Collateral. If the collateral is a vehicle, the

DashBoard
Origination
‘Origination
Sales Lead
Simple Application Entry
Application Entry
Underwiting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination x

Search/Task  Simple Application Entry: 0000001536 | Review Requests (Pending: 0)

Application: 0000001536: RODRIGUEZ MILDRED

View - Formate [Ep Freeze i Detach J wrap W overideoK v  Warning OK v
Dt hpp 2 Sub Unit Status ?L‘dg‘e"a“"" S0 producer Name ;{j’d“‘e’ oMt Ericting Customer
[ osjosy2015 0000001536 APPROVED - FUN... FUNDED CADOD03 : ACE ... (818)-761-2277 ¥
Applicant | Business || Request | Collateral | Comments | Tracking || Verfication
Collateral
Home
View v Format~ [ Freeze i Detach ol Wrap o)
DP  EustngAssetld  Primory  Asset Cless st b oty Hontfication'®  |Coury:
in i NEW VEHIGLE HOME SINGLE FAMILY H.. OCCUPIED BY OW. . E26A119602
4 <
valuation | Tracking
Valuation
View v Formatw  [Ep Freeze i Detach ol Wrep @
an Currency i Usage Value Amt
Cument R e Retail Base Amt {1 veluation Dt Source Currency Edition
¥ 19,000.00 19,500.00 0.00 03/05/2015 INVOICE Us DOLLAR
<
Addons
View v Formatw G Freeze  Eff Detach Wrap [}
Description Value Amount
ANTI THEFT 290.00

UNITED STATES 480 NEPONSET ST
>

[ Close.
Bl Wiow || 2 pudit
Duplicate
Application e
¥
>

Address #

view || < Audit
Supplement Wholesa

>

[Elviow || o audit

Loan Currency Amount:
290.00

If the collateral is a home, the Collateral link displays information about the home.

ORACLE’

Financial Services Lending and Leasing

> DashBoard

Origination

4 Origination
Sales Lead
Simple Application Entry
Application Entry
Underariting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
» Collections
> WFP

> Tools
 Setup

Origination » 3] Dlose
Search/Task | Application Entry: 0000001155  Review Requests (Pending: 0) a
Application: 0000001155: CCINQUWFOIL PIERRE / JEAN At || Elvew || o audt
View v Formatv [ Freeze i Detach ol Wrap ) overideok ¥ WamingOK ¥  {8%Process Application 48 Pre-Qualify Application
Dt App £ Sub Urit Status Origination Stage oy cer Name Pmr::;f’ Contact  picting Customer  Dupicate Applcation’ Contact
04/01/2012 0000001155 UNDEFINED  NEW - REVIEW REQUIRED REVIEW MN-00001: INHO... (3528426287 N N
< - m, | 3
Summary | Appicant | Request | Decsion | Bureau  Collateral | Comments | Tracking | Document  Verification || Correspondence  Tools
Collateral  Seller
Home dqpadd | Fedt | [Guew | o dudt
View » Format~ B} i Detach B Edsting Asset 1d ¥ o Load Detais
DOM0 exstngAssetld  Primary  Asset Class AssetType Sub Type Occupancy Identification = Country Address 2
N i USED HOME 'HOME SINGLE FAMILY H IVFPBOD43SMS 1. UNITED STATES 123 E
s i ] b
Valuation  Tracking
Valuation dpadd | Fedt || [Fven | oAt
View v Formatv Freeze EfiDetach ¢l rap [T
Loan Currency
Current \Wholesale Base Amt Retail Base Amt Usage Value Amt (+) Valuation Dt Source Currency Edition Supplement Wholes
¥ 10,000.00 10,000.00 0.00 0410/2012 INVOICE US DOLLAR
1 m I »
Addons qpadd | FEdt || [Gvew | o Audit
View v Formatv Freeze i Detach e
Desaription Value Amount Loan Currency Amount
No data to display,

If the collateral is any other, the Collateral link displays information about that collateral.
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6.9

For details on this screen refer Collateral Tab section in Underwriting chapter.

ORACLE"
Financial Services Lending and Leasing

Oniginatio 3] lose
 DashBoard s ol
b Search/Task  Application Entry: 0000000382 | Review Requests (Pending: 0)
Origination
Sales Lead Application: 0000000382: TOLMAN GREG / EVA Elyew || o Audit
Simple Application Entry = e e
View v Format Freeze fiDetach ol Wrap Override 0K ¥ Warning OK v
Application Entry & o z @ ?
Underwriting ot nop # S0 Status Crignation Stage Code  Producer Name  Producer Contact Number 0o opnd, Duplicate Application Contact
T 02/01/2012 0000000382 UND.., APPROVED - AUTO APPROVED NEW GA-00004: ADVA... (770)-424-6450 N N
Application Retrieval e e e ¥
Scenario Analysis
Application Documents
Image Maintenance
Reports Summary | Applicant | Request | Dedsion || Contract || Colstersl | Comments || Tracking || Document || Verification || Correspondence || Tools
Producers
Vendors
Comments Bl view | of Audit
View = Format~ Freeze B Detach ] virap o]
Alert Type S Type Comment Comment 8y Comment Dt

Comments Tab

When using the Application Entry screen, you can add comments to an application at any time
in the application entry process by clicking the Tracking tab.

To complete the Comments screen

On the Application Entry tab, click Comments.

ORACLE . . 3 & Welcome, DEMOSUPR ~  Accessbiity 23 Signout O
Financial Services Lending and Leasing
»| DashBoard Origination [ Dose
Origination Result/Task Application Entry: 0000000266 Search Review Requests (Pending: 0) z
V Origination
i Edit View Audit
Sales Lead Application L | Buen | Pt |
Simple Appiicaton Entry View = Format v | B Freeze ffiDetach | o Wirap W overide ok Warning OK {83 Process Appication | {8} Pre-Quailfy Appiication |
Application Entry \ ‘ | | Producer |
e |Origination Stage | |Existing
Underwriting Dt iAw- = e [producerNeme cm:n [cummer =
Fundng E | ) | | : |Mumber
vt .(wuumu 0000000266 'APPROVED - AUTO APPROVED  DECISIONED 'MN-00001 : IN HOUSE (DIRECT DEAL)( ACTIVE ) (952)-942-6297 N
« il [
Scenario Analysis
Application Documents
Image Maintenance
Reports Summary Applicant Request Dedision Contract Comments Tracking Document Verification Correspondence Tools
Producers
Vendors Comments
GaRewmn
View v Formatv | Ep Freeze i Detach 1l wrap 5]
| mlert [Type |sub Type |comment: Comment By |comment pt |
No data to display.
4
; !

For details on this screen refer Comments Tab section in Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.
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6.10.1

To track attributes

1. On the application entry screen, click Tracking tab.

ORACLE ) .
Financial Services Lending and Leasing
Originat [ Ciose
> DashBoard RO X
Origination SearchfTask  Application Entry | Review Requests (Pending: 0)
Origination
Sales Lead Application e add | AEdt | 5] view || o Audit
Semple Apicaton Bty View » Format~ [ ol Wrap @) OverideOK __ WamningOK __
Application Entry = 5 =
= sul Origination Producer Existng  Duplicate
ur\dda\ wiriting Dt App # Unt  Status Stage Code _ Producer Name ContactNumber Customer Application Contact Sales Agent
Frdng No data to display.
Application Retrieval o [ r
Scenario Analysis
A tion Documents
Image Maintenance
Reports Summary Appicant Request Dedsion Bureau Confract Comments Tracking Document Verification = Correspondence
Producers
Vendars Tracking Attributes  Field Investigation
Tracking Attributes A Edit || of audt
View v Fomatw B Freeze EfiDetach | ol Wrap (5] o Load Tracking
Sub-Parameter Parameter Value
No data to display.
“
»

For details on this screen refer Tracking Tab section in Underwriting chapter.

Document Tab

Document Sub Tab

Application Entry’s Documents screen enables you to view Application Documents and

Application Documents Details.

ORACLE’
Financial Services Lending and Leasing

e Origination
Origination SearchfTask | Application Entry | Review Requests (Pending: 0)
Origination
Sales Lead Application
Simple Application Entry i = - :
ew = Format ~ resze ] Detach ] Wurap Override OK Warning OK
Appiication Entry & e 2 @ - - Bk
Underwriting Dt App = Sub Unit Status Origination Stag2 o cor pame
Funding No data to display.
Application Retrieval 5 i
Scenario Analysis
Application Documents
Image Maintenance
Reports summary | Applicant || Request | Decson | Buréau | Contract | Comments  Trackng  Document  Venfication
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Vendors Checklist Document
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Checklist Type Checklist Comment
Mo data to display.
‘
Regular  Document
Checklist Actions
View v Formatw Freeze i Detach ol Wrap W
Action Comment
No data to display.
> Servicing
> Collections
> WFP
> Tools
» Setup

[ close

dpadd || Ledt | B view || o Audit

P’",:‘j:;f’ CONxt: | o Oitomier | Dot Anpicbion |Cont
v
Correspondznce
AEdt || Eyew | o audt
Complete
“
A Edt || [Gven | o audt
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For details on this screen refer Document Tab section in Underwriting chapter.

ORACLE



6.11

6.12

Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Line of credit until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move application to queue of the user with required authority.)

To validate a credit application
1. Enter all the information associated with the application on the Application Entry screen.

2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.

ORACLE’
Financial Services Lending and Leasing
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Application Entry & d.h L el = EeE o 3 "
i 2 su Origination Producer Existing  Dupiicate
Unddemmhng Dt App = tnt  Status Stage Code Producer Name Contact Mumber Customer Application CoT¢t Sales Agent
Funding No data to display.
Application Retrieval o = o 3
Scenario Analysis
Application Docments
Image Maintenance
Reports summary = Applicant = Request Dedsion  Bureau | Contract —Comments | Tracking ~Document —Verfication | Correspondence
Producers
Vendors Edits | Audits | History
Edit Types
View = Format= B Freeze fiDetach firap M Edit Type [=] {8 CheckEdits
Date Edit Type
No data to display.
4
v
Edit Details
View v Formatv B Freeze &t Detach Wrap ®
Edit Name: Result Expected Value Actual Value Override Responsibility
No datz to display.
> Servicing
> Collections
> WFP
> Tools
> Setup

For details on this screen refer Verification Tab section in Underwriting chapter.
Tools tab

The Tools tab calculates the payment amount, term, interest rate, Line of credit amount,
amortization schedule and allows for the printing of a report.

For detailed information on using the tools, refer Tools chapter.
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6.12.1

6.13

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE?” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.

Review Request

The Review Request tab facilitates to flag an Application for the attention of another Oracle
Financial Services Lending and Leasing user and ask for review / feedback. It allows the
system users to send and receive requests (including e-mail) commenting on a specific
account or application. The Review Request tab supports iterative review of selected
Application and also to process the review with multiple reviewers.

For detailed information on using this feature, refer to ‘Review Request’ section in
Underwriting chapter of the document.
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7. Underwriting

71 Introduction

Underwriting is the next step after application entry in Line of credit origination cycle. At the
beginning of underwriting process, the application has been entered into Oracle Financial
Services Lending and Leasing, receiving an application number. The application, then passes
through the initial prescreening checks, and receives a credit bureau report. (Credit bureau
pulls are based upon zip code setup.) The system assigns it a custom credit score and based
on this, the application automatically updates its status and sent to the appropriate queue. In
doing so, one of three things happen to the application:

The application passes all the prescreening requirements and is automatically approved
based on the auto-decisioning process. The system, then, automatically notifies the
producer with a decision fax. You can use the Underwriting screen to view the
application and decision information and proceed to funding.

The application fails the prescreening requirements and is automatically rejected based
on the auto-decisioning process. Again, the system notifies the producer with a decision
fax. You can use the Underwriting screen to view application and decision information.
Also, you can rehash the application.

The application receives a status requiring a manual review and is sent to the
underwriting queue. It is now up to the underwriter to verify data and manually change
the status of application using Underwriting screen.

This chapter explains how to use the Underwriting screen to complete the following tasks:

Loading an application on the Underwriting screen
Verifying the applicant information

Verifying the credit bureau data

Calculating and validate the debt-to-income ratios
Requesting a credit bureau report manually
Adding comments and tracking attributes

Making a decision about an application

Verifying the edits

Rehashing an application

Ageing an application.

Review Requests

7.2 Underwriting Screen - an overview

The underwriting process follows these basic steps:

Opening the Underwriting screen and loading the application you want to work with.
Viewing and verifying information about the applicant supplied during application entry.
Viewing information from the credit bureau report.

Viewing and verifying information regarding the collateral, if present.

Viewing and verifying information regarding the trade-ins, if present.

Calculating and validating the debt-to-income ratios.

Selecting the pricing for the application.
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7.3

7.3.1

e Specifying information regarding stipulations, itemizations, check lists, and rate
schedules (variable rate Line of credit only), if required. (The checklist can be configured
to display a list of tasks to follow when using the Underwriting screen.)

e Making a decision on the Line of credit (APPROVE, REJECT, or CONDITION).
e Performing an edits check to verify the information on Underwriting screen.

e Viewing errors and warnings from the edits check and make the required corrections to
the data.

e Changing the status of the application.

Loading an Application on the Underwriting screen

The first step in the underwriting process is to load the application you want to work with. For
details about using the Loading an application, refer Searching for an Application in the
chapter Search Function.

Applications

The Underwriting screen’s Applications section appears at the top of the screen opened from
Underwriting master tab. The screen displays the application number and name on the
header and contains information such as application purpose, product and producer.

In this section, you can perform any of the Basic Operations mentioned in Navigation chapter

ORACLE"
Financial Services Lending and Leasing

2 Welcome, VAVAIDYA v Accessbilty =)

V Clos
DashBoard Origination x —

Search/Task | Underwriting | Review Requests (Pending: 0)

Application
View~ Formatv B

No data to display.
< >

Application

Super Summary

Applicant

sssss

A brief description of the fields is given below:

Field: View this:

App # The application number

Dt The application date

Product The Line of credit product of the application.
Channel How the application information was received.
Priority The priority of the application.
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Field:

View this:

Company The company of the application.
Branch The branch of the company.
Status The status of the application.

Origination Stage Code

The origination stage code of the application.

Billing Cycle The billing cycle of the application.
Purpose The purpose of the application.
Producer The producer type and producer of the application.

Producer Name

The name of the producer of the application. The Producer
Name is displayed as a hyperlink and clicking on the same
will open ‘Producers’ page with details of the producer.

Producer Contact Num-
ber

The system displays the contact number of the producer.

Region

The region of the producer.

Territory

The territory of the producer.

Existing Customer

Indicates if the customer is an existing customer.

Duplicate Application

Indicates if the application is a duplicate application.

Line of credit Currency

The Line of credit currency of the application.

Class The class of the application.

Sales Agent The sales agent of the application.

Joint If selected, indicates this is a joint application.

Cosigned If selected, indicates this is a co-signed application.

Contact The contact of the application.

Lead # The lead number will appear in the list only if a lead is
already created using the Sales Lead link.

CRB Pull Check this box to pull an initial credit bureau report, after
the application passes the pre screen edits. Uncheck the
box, if you want to enter an application without pulling a
credit report. To use a previously pulled credit bureau
report, uncheck this box and specify the Bureau and
Bureau Reorder # fields on the Primary Applicant screen.

Override Ok Check this box to ignore the overrides.

If the application has been marked as ‘Override OK’ then
the system would allow you to change the application sta-
tus even when override condition exists.
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7.3.2

7.3.3

Field: View this:

Warning Ok Check this box to ignore the warnings.

If the application has been marked as ‘Warning OK’ then
the system would allow you to change the application sta-
tus even when warning exists.

Proxy for Underwriter If you are acting as a proxy for an Underwriter, then you
can select the Underwriter’'s name from the adjoining
options list. The list displays all the associated Underwrit-
ers, Underwriting Supervisors, and Underwriting Manag-
ers.

However, this is not mandatory and can be used while
auctioning an application on behalf of another underwriter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Changing the Status of the Application

You can use underwriting screen’s Applications master screen to change the status and sub
status of the application.

To change the status of the application

1. On the Underwriting form’s Application master screen, change the status of application
to either APPROVED, CONDITIONED, or REJECTED in the Status field and click Save.

The system checks the information on the Underwriting form using guidelines
established during implementation.

The system finds an error based on these guidelines, a Warning message appears
stating “Validation Error exist, Unable to Change the status. Please check the Edits.”

2. Click the Verification link and begin verifying edits on the Edits screen (For more
information, see the Verification link section in this chapter.)

During status change:

e Ifthereis an errorin the edit, system displays an error message as ‘Errors exist. Cannot
change status. Please Verify Edits.” and previous status is retained.

e Ifthere is an edit which requires override, the system displays an override message as
‘Override Required. Do you want to continue?’

— If you select ‘Yes’, the system will continue with OVERRIDE_REQUIRED
processing by changing the status.

— If you select ‘No’, the system will change the status back to old status.

During status change, if there is a warning in the edit, the system displays an error message
as ‘Warning Exists. Do you want to continue?’.

e If you select ‘Yes’, the system will continue processing by changing the status.
e If you select ‘No’, the system will change the status back to old status.

Rehashing an Application

Once the application moves to status of APPROVED, REJECTED, or CONDITIONED status,
you cannot amend the information. However, you can amend the application, by changing the
sub status of the application to REHASHING.
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7.3.4

7.4

To Rehash the Application

1. Open the Underwriting screen and load the application you want to change with the
APPROVED, REJECTED, or CONDITIONED status.

2. Inthe Applications master section, select REHASHING in the Sub Status field and click
Save.

After you enter the information required in the application, you can change the status to
APPROVED, REJECTED, CONDITIONED, or WITHDRAWN. (For more information,
refer Decision Tab section in this chapter.)

Once the status is changed to Approved, Rejected, conditioned, or Withdrawn, you
cannot make further changes to the information on the Decision tab.

Aging an Application

The Underwriting screen can be configured so that applications will be moved to a separate
queue after a certain amount of time. (This time frame is determined in setup). This
applications receive a sub status of AGED APPLICATION. This housekeeping function allows
you to keep your system free of stagnant application by moving them into an archive.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, you can view the following details in their respective sections:

e Super Summary

e Applicant
e Ratios

e Bureau

e Checklist
e Collateral
e Trade-In

e Requested

e Approved

e Decision Itemizations

e Decision History

e Comments

e Stipulations/Adverse Actions

To view the Super Summary

1. Open the Underwriting screen and load the application you want to work with.
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2. Click Summary tab. By default the system opens the summary tab. Expand the Super
Summary section.

i Serviss Lendi ;
Financial Services Lending and Leasing
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Contract

Term 0
> Senvicing
> Collections Actual Time at Residence
> WFP 428 Verify Address
> Tools

Employment @
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The Super Summary tab provides a snapshot of all relevant details in a single screen and
contains details of Applicant, Employment, Ratios, Bureau, Requested financials, Decision
updates, Contract updates and Primary Collateral details. You need not have to navigate to
each of these tabs for specific information on the application. Also clicking on the hyperlinks
of Address, Employment, Ratios, and Trade-In helps you to directly navigate to respective
tab(s),

During the Underwriting and Funding stages, 'verified' button is displayed just below the
address and employment details for each of the applicants. This would be enabled only when
the Verified by and Verified Dt in the respective tabs are blank. You can verify the details from
the Super Summary tab. Clicking on Verified will do the following:

1. System will copy the stated values to Actual values.

2. System will stamp the “Verified By” as 'User Name' and 'Verified Date' as 'Current GL
Date' for the respective applicant.

3. If'Verified Details' are already updated in tab or if the details are stamped, this button will
be disabled.

4. ‘'Verified' button will be available when 'Actual Amount' equal to ZERO or 'Verified By' or
'Verified Date' is NULL.

You need not navigate to Address and Employment tab for verifying applicant details.

Decision details will be displayed when application has Origination Stage as “Review,
Decisioned, Contract or Funded”. In case an application is Rehashed, only Decision
information will be displayed and Contract information will not be displayed. Contract details
will be displayed when application has Origination Stage as “Contract or Funded”.

The system displays the collateral details maintained in the collateral tab on click of navigation
button under the headings Primary Collateral and Secondary Collateral. Collateral details for
Unsecured loan also will be displayed if they are maintained.

All the trade-in details, if any, maintained in the application would be displayed on click of
Navigation button.
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7.5

Applicant Tab

Having selected and loaded an application, you can view the information about applicant in
the Applicants tab. This is information that was recorded on the Application Entry screen or
gathered during the credit pull. You can edit data from the Application Entry screen at anytime
in the following steps. Remember to save your work with each change. Information from the
credit bureau pull is available to view only.

Using the information supplied on the application, complete the Applicants tab details and the

following sub tab details:

e Address

e Employments

e Telecoms

e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts.

e Tracking Attributes

Primary Applicant details are required for SME applications also. The system uses

information on the Financial and Liabilities sub tabs in determining the applicant’s net worth.
The system uses information on the Employments screen and Other Incomes sub screen to
calculate the applicant’s debt-to-income ratio.

To verify applicant information on the Underwriting screen

1. Open the Underwriting screen and load the underwriting application you want to work

with.
2. Click Applicants tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation
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Funding
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Image Mainten FATCA
g S = Language N
Repals @ Gender UNDEFINED [=
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A brief description of the fields is given below:

Field

Do this

Relation Type

Select the relationship type from the adjoining drop-down list. For
example, primary, spouse, secondary, or cosigner.

Salutation Select the salutation from the adjoining drop-down list.
First Name Specify the applicant’s first name.

Mi Specify the applicant’s middle name.

Last Name Specify the applicant’s last name.

Family Name

Specify the applicant’s family name.

Suffix Select the name suffix/generation from the adjoining drop-down list.

Birth Dt Specify the applicant’s date of birth.

SSN Specify the applicant’s social security number.

Class Select the classification of the applicant from the adjoining drop-down
list. For example, NORMAL or EMPLOYEE. The system uses this
information to restrict access to the database by recognizing employ-
ees as ‘secured applications’.

You can create a SME (Small Medium Enterprise) application by
selecting SMALL BUSINESS. When you select SMALL BUSINESS
and save your entry, the Business Applicants link on the Applicants
link is available. (required).

Email Specify the personal Email ID of the applicant.

Time Zone Specify the time zone to which the applicant belongs. This information

appears when you enter and save the zip code for the primary appli-
cant’s current home address on the Address sub screen. You can also
manually complete this field.

Identity Informa

tion Section

Nationality Select the applicant’s nationality from the adjoining drop-down list.
National ID Specify the national identification number.

Passport # Specify the passport number.

Passport Select the date on which passport was issued.

Issue Dt

Passport Select the passport’s expiration date.

Expiry Dt

Visa # Specify the applicant’s visa number.

License # Specify the applicant’s license number.

License State

Select the state where the license was issued, from the adjoining
drop-down list.

ORACLE



Field Do this

Prior Appli- Check this box to indicate that the customer is an existing customer.

cant

Existing Cus- | Check this box to indicate that this applicant has a previous account.

tomer

Existing Cus- | Specify the customer ID if the applicant is an existing customer.

tomer ID

Existing Cus- | Specify the customer number if the applicant is an existing customer.

tomer # On saving the applicant details, the data in ‘Existing Customer # is
displayed as a link in ‘Applicant’ section header and clicking on the
same will display the customer details in Search Results section of
Servicing module.

Update Cus- Check this box to indicate if system can override the existing cus-

tomer Info tomer information and create the record with latest address and com-

munication details of the customer.

Other Details section

Name in Local

Specify the applicant’s name in local language.

Language
Gender Select the gender of the applicant from the adjoining drop-down list.
Mother’s Specify the mother’s maiden name.

Maiden Name

Education Select the education of the applicant from the adjoining drop-down
list.

Language Select the applicant’s native language from the adjoining drop-down
list.

Dependents Specify the number of dependents.

Marital Status

Select the marital status of the applicant from the adjoining drop-down
list.

ECOA Select the ECOA (Equal Credit Opportunity Act) code, from the
adjoining drop-down list. This defines the various possibilities on who
is liable; individual, joint, cosigner and so on.

Race Select the applicant’s race from the adjoining drop-down list.

Ethnicity Select the applicant’s ethnicity from the adjoining drop-down list. This
is the information the Home Mortgage Disclosure Act requires to be
reported.

Disability Check this box if the application has a disability.

Privacy Opt Check this box to indicate that the applicant has elected to refrain

Out from the non-public sharing of information.

Insurance Opt
Out

Check this box to indicate that the applicant has elected to refrain
from insurance related inquiries.
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Field

Do this

Marketing Opt
Out

Check this box to indicate that the applicant has elected to refrain
from marketing related inquiries.

Share Credit

Check this box to indicate that the applicant has elected to refrain

Opt Out from financial information and share credit related inquiries.
Prior Bank- Check this box if prior bankruptcy exists.

ruptcy

Bankruptcy Enter the discharge date of prior bankruptcy (if one exists).

Discharge Dt

KYC Section

Reference #

Specify the reference number.

Status Select the status of the applicant from the adjoining drop-down list.
FATCA Section

Birth Place Specify the birth place of the applicant.

Birth Country | Select the country of birth of the applicant.

Permanent US | Check this box if the applicant has permanent US resident status.

Resident Sta-
tus

Power of Attorn

ey Section

Power of
Attorney

Check this box if you hold a power of attorney.

Holder Name

Specify the holder name of the power of attorney.

Address Specify the address of the holder.

Country Specify the country of the power of attorney holder.
Nationality Specify the nationality of the power of attorney holder.
Telephone Specify the telephone number of the power of attorney holder.
Number

Military Service
details and can b

- this section can be used to capture applicant’s Active Military Duty
e validated with applicant Bureau Details.

Active Mili-
tary Duty

Check this box to indicate if applicant is on Active Military Duty.

Effective Dt

Select the date from when the applicant is on Active Military duty
using adjoining calendar.

Order Ref # Specify the Order Reference number which indicates the applicant’s
Active Military duty service.
Release Dt Select the date from when the applicant was released from Active Mil-

itary duty using adjoining calendar.
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7.5.1

4. Perform any of the Basic Actions mentioned in Navigation chapter.

You can verify the personal information about the applicant. Two check boxes indicate if
this is an existing customer or a prior applicant. The Existing Customer field enables you
to select the existing customer.

Address Sub Tab

You can specify more than one address for each applicant, such as a home address, second
home address, and vacation home address. However, at least one must be marked as
current. Also, only one address can be selected as the mailing address, and that address
must be marked as current. Finally, while you can have more than one Home type address,
only one can be marked as current.

To complete the Address sub tab
1. Click Address sub tab.

2. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

Based on the country chosen in the address tab, the fields for capturing the address will
vary.

A brief description of the fields is given below:

Field Do this

Address Type | Select the type of address from the adjoining option list.

Current Check this box if this is a current address.

The mailing address must be marked as current.

Confirmed Check this box if the address is the confirmed one

Mailing Check this box if this is the mailing address. Only one address entry
can be marked as the mailing address.

Permission to | Check this box if customer has provided permission to contact
Call through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as 'Y') for the successful pre-qualification of the
application. Else, an error message is displayed.

Country Select the country of mailing address from the adjoining drop-down
list.

Address Details section

Postal Type Select the postal address type from the adjoining drop-down list.

Address # Specify the address number of the mailing address

Street Pre Select the street prefix (directional) from the adjoining drop-down
list.

Street Name Specify street name.

Street Type Select the street type from the adjoining drop-down list.
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Field

Do this

Street Post

Select the street postfix (directional) from the adjoining drop-down
list.

Apt #

Specify the apartment number.

Address Line
1

Specify the first address line.

Address Line
2

Specify the second address line.

Address Line
3

Specify the third address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the extension of the zip code.

City Specify the city of the mailing address.

State Select the state of the mailing address, from the adjoining drop-down
list.

Phone Specify the phone number.

Additional Information section

Own / Rent Select the ownership type from the adjoining drop-down list.
Landlord Specify the landlord’s name.

Landlord Specify the landlord’s phone number.

Phone

Contact Specify the person contacted on behalf of landlord.
Contact Title Specify title of the person contacted on behalf of landlord.

Contact Phone

Specify phone number of the person contacted on behalf of landlord.

Extn

Specify the extension of the phone of the person contacted on behalf
of landlord.

Census Tract/

Specify census tract/BNA (block numbering area). These are defined

BNA code by the US Census Bureau code.

MSA Code Specify the metropolitan statistical area (MSA) code. These are sim-
ilar in concept to a zip code, but used mostly on government reports.

Comment Specify a comment.

Address Rent M

ortgage Stated section

Years

Specify the stated number of years at residence.

Months

Specify the stated number of months at residence.
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Field Do this

Currency Select the currency code of payment amount, from the adjoining
drop-down list.

Pmt Amount Specify the stated payment amount.

Frequency Specify the stated payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Address Rent Mortgage Actual section

Years Specify the Actual number of years at residence.
Months Specify the Actual number of months at residence.
Pmt Amount Specify the Actual payment amount.

Frequency Specify the Actual payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Verified Section

Verified By The name of the verifier.

Verified Dt The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. If there are more than one addresses associated with the applicant, click Save And Add
on the Address sub screen and add address details.

7.5.2 Employments Sub Tab

Use the Employment sub screen to record employment information about the applicant. You
can have more than one entry.

To complete the Employments sub tab
1. Click Employments sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Current Check this box if this is the current employment.

Permission to Call | Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number per application should have the
permission to call (flagged as 'Y") for the successful pre-quali-
fication of the application. Else, an error message is dis-
played.

Type Select the address type from the adjoining drop-down list.
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Field:

Do this:

Employer Specify the employer’s name.

Occupation Select the occupation from the adjoining drop-down list.
Title Specify the title.

Department Specify the department of the employer.

Employee ID Specify the employee identification.

Employer Address section

Country

Select the country from the adjoining drop-down list.

Address #

Specify the building number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the zip code extension.

City Specify the city.

State Select the state from the adjoining drop-down list.

Additional Information section

Phone Specify the work phone number.

Extn Specify phone extension.

Contact Specify the person contacted on behalf of the employer.
Contact Title Specify title of the person contacted on behalf of the employer.

Contact Phone

Specify phone number of the person contacted on behalf of
the employer.

Contact Extn

Specify the extension of the phone of the person contacted on
behalf of the employer.

Comment

Specify a comment.

Employment Details Stated section

Years Specify the stated number of years with the employer.
Months Specify the stated number of months with the employer.
Pay Day Select the stated payment day of the month using the adjoin-

ing calendar. Ensure that the date selected is greater than or
equal to current system date.
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7.5.3

Field: Do this:

Frequency Select the stated payment frequency from the adjoining drop-
down list.

Currency Select the currency code from the adjoining drop-down list

Income Amt Specify the stated income.

Salary View the salary of the customer.

Employment Details Actual section

Years Specify the Actual number of years with the employer.

Months Specify the Actual number of months with the employer.

Pay Day Select the Actual payment day of the month using the adjoin-
ing calendar. Ensure that the date selected is greater than or
equal to current system date.

Frequency Select the Actual payment frequency from the adjoining drop-
down list.

Income Amt Specify the Actual income.

Salary View the salary of the customer.

Verified Section

Verified By

The name of the verifier.

Verified Dt

The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Telecoms Sub Tab

The Telecoms sub screen only needs to be completed if additional phone numbers exist. If

not, this sub screen can be left blank.

To complete the Telecoms sub tab

1. Click the Telecoms sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the telecommunication type from the drop-down list.
Phone Specify the phone number.

Extn Specify the phone extension.

Current Check this box if this Telecom number is current.
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Field Do this

Permission | Check this box if customer has provided permission to contact through

to Call the specified phone number.
Atleast one phone number per application should have the permission
to call (flagged as 'Y') for the successful pre-qualification of the applica-
tion. Else, an error message is displayed.

Time Zone Select the applicant’s time zone from the drop-down list.

Start Time Specify the best time to start the call.

Period Select the time period for the best time to call start time, AM or PM, from
the drop-down list.

Best day to | Select the preferred day of the week to contact the customer from the

call drop-down list.

End Time Specify the best time to end the call.

Period Select the time period for the best time to call end time, AM or PM, from

the drop-down list.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Summary Sub Tab

The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the

Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub

screen, the Liabilities sub screen during application entry, and the credit bureau pull.

To View Summary sub tab

1. Click the Summary sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

What if Pmt Amt Specify the payment amount you want to use in the ratios.
Score View the credit score for the application

Grade View the credit grade for the application

Totals

Amt

Monthly Income- Stated | The stated monthly income.

Amt

Monthly Debt- Stated The stated monthly liability.

Amt

Monthly Income- Actual | The actual monthly income.
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Field

Do this

Monthly Debt- Actual
Amt

The actual monthly liability.

Assets Amt - Liabilities
Amt

The net worth amount.

Ratios

Debt - Stated Before (%)

The debt amount stated before.

Debt - Stated After (%)

The debt amount stated after.

Debt - Actual Before (%)

The actual debt amount before.

Debt - Actual After (%)

The actual debt amount after.

Disposable Inc - Stated
Before (%)

The disposable income stated before.

Disposable Inc - Stated
After (%)

The disposable income stated after.

Disposable Inc - Actual
Before (%)

The actual disposable income before.

Disposable Inc - Actual
After (%)

The actual disposable income after.

Revolving Debt - Stated
Before (%)

The stated revolving debt before.

Revolving Debt -Stated
After (%)

The stated revolving debt after.

Revolving Debt - Actual
Before (%)

The actual revolving debt before.

Revolving Debt - Actual
After (%)

The actual revolving debt after.

Pmt to Income - Stated
Before (%)

The stated income payment before.

Pmt to Income - Stated
After (%)

The stated income payment after.

Pmt to Income - Actual
Before (%)

The actual income payment before.

Pmt to Income - Actual
After (%)

The actual income payment after.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Once the payment amount is approved in Decision screen, it will be copied and

displayed in the What if Payment field in Summary sub screen.
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Calculating Debt Ratios

The system offers powerful tools to the underwriter for analyzing an applicant’s debt-to-
income ratios (total of an applicant’s debt obligation divided by that person’s regular income).
The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the
Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub
screen, the Liabilities sub screen during application entry, and the credit bureau pull.

An underwriter may also add information to the Incomes and Liabilities sections on the
Summary sub screen during the underwriting process.

The debt-to-income ratios in the Ratios section can be recalculated by including or excluding
information from the Incomes section, Liabilities section and Financials sub screen.

To calculate debt ratios
1. Open the Underwriting screen and load the application you want to work with.
2. In the Underwriting link bar, click Applicants.

3. On the Applicants Details screen, select the applicant you want to work with and click
Show in the Details column.

4. Click Summary sub tab.

5. On the Summary sub screen, view the display only data in the Totals section.

Field: View this:

Monthly Income (Stated) | The stated monthly income.

Monthly Income (Actual) | The actual monthly income.

Monthly Debt (Stated) The stated monthly liability.

Monthly Debt (Actual) The actual monthly liability.

Assets The assets.
Liabilities The liabilities.
Net-Worth The net-worth.

6. Inthe What if Pmt Amt field, enter the payment amount you want to use in the ratios.
Once the payment amount is approved in Decision screen, it will be copied in the What if
Payment field and the ratios are updated accordingly.

Whenever you modify the ‘What If pmt Amt’ field, system automatically calculates the
below ratio's:

— Stated Before DTI - if liabilities, stated income or applicant financials are updated.

— Stated After DTI - if decision payment amount, liabilities, stated income or applicant
financials are updated.

— Actual Before DTI - if liabilities, actual income or applicant financials are updated.

— Actual After DTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.

— Stated PTI - if decision payment amount, stated income or applicant financials are
updated.

— Actual PTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.
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7.5.4.1 Financials Sub Tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

To complete the Financials sub tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

1. Click Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select financial type from the drop-down list. For example, liquid
assets, retirement assets, and so on.

Source Specify source; for example, stocks, 401K, rent received, and so on.
Account # Specify the account number.
Currency Select the currency code from the drop-down list.

Line of credit | View the Line of credit currency amount.

Currency

Amount

Amount Specify amount.

Include Check this box to indicate that the Asset is included.
Comment Specify comment, if any.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.4.2 Liabilities Sub Tab

All the liabilities of the applicant that are entered during application entry are displayed in this
tab. For example: Rent. In addition, if you need to record additional liabilities for an applicant
the same can be done in this tab. Also any liability information of the applicant received
through credit pull will be displayed under 'Credit Bureau Data' in Liabilities sub tab.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Include Check this box to indicate that the liability is included.
Liability Type Select the liability type from the adjoining drop-down list.
Currency Select the currency code from the adjoining drop-down list.
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Field Do this

Amount Specify the liability amount.

Line of credit Cur- View the Line of credit currency amount.
rency Amount

Frequency Select the frequency from the adjoining drop-down list.
Account Type Specify the account type.

Account Balance Specify the account balance.

Line of credit View the Line of credit currency amount.

Comment Specify a comment, if any.

Credit Bureau Data

Bureau View the name of credit Bureau.

Open Dt View the opening date of credit account.
Pmt Manner View the mode of payment.

Account # View the account number.

Status View the current status of credit account.
Account Type View the type of account maintained.
Creditor's Name View the name of the Creditor.
Subscriber # View the Subscriber number.

ECOA View the ECOA (Equal Credit Opportunity Act) code.
Term View the term of credit.

Credit Limit View the total credit limit amount.

High Balance View the high balance amount if any.
Past Due Amt View the total past due amount if any.

30 View the number of delinquency days.
60 View the number of delinquency days.
90 View the number of delinquency days.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Dedupe Liabilities button removes duplicate (“de-dupes”) liabilities that may be
present from subsequent (manual) credit bureau pulls for nonspousal joint applications

7.5.4.3 Other Incomes Sub Tab

The Other Incomes sub tab only needs to be completed if other incomes exist on the
application. If not, this sub screen can be left blank.
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To complete the Other Incomes sub tab
1. Click the Other Incomes sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the income type from the adjoining drop-down list.
Note: In case, the other income of the applicant is from Employment,
then the details of Actual Amount specified in the Employments
Sub Tab is auto populated. Also if the income is verified in the
Employments Sub Tab, then Verified By and Verified Dt details are
auto populated. You can also verify the details here using the current
system date.

Currency Select the currency from the adjoining drop-down list.

Stated Amount Specify the monthly stated income.

Frequency Select the income frequency from the adjoining drop-down list.

Line of credit

View the Line of credit currency amount stated.

Currency

Amount Stated

Comment Specify a comment, if any.

Include By default the include check box is selected indicating that the other

income details are included. You can deselect the same if not
required.

When Include check box is selected system automatically adds the
‘Loan Currency Amount Stated’ and ‘Loan Currency Amount Actual’
details to Applicant > Summary Tab. Also system calculates the DTI
and PTl ratio's based on ‘Actual Amount’ specified.

Actual Amount

Specify the actual monthly income amount.

Line of credit
Currency
Amount Actual

View the actual Line of credit currency amount.

Verified By The Verified By field is auto populated with the logged in user name
only after the record has been verified and saved.
Verified Dt You can verify the record by selecting the current system date from

the adjoining calendar icon.

Note: System displays an error message if any other dates is
selected apart from current system date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.4.4 Rescoring a Credit Bureau Report Manually

Any manually pulled credit bureau reports can be used to rescore an application.
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To manually rescore a credit bureau report
1. Open Underwriting screen and load the underwriting application you want to work with.
2. Click Applicants.

3. On the Applicants Details screen, select the applicant you want to work with and click
View.

4. Click the Credit Scores sub tab.

In the Rescore Applicant section, select in the Credit Report ID field, the bureau report
you want to use to rescore the applicant.

6. Click Rescore.

The system displays the new information in the Credit Scores and Parameters sections.
This new score automatically appears in the System Recommendation section on the
Decision link.

7.5.5 Credit Score Sub Tab

You can view the credit score based on the system’s internal scoring models in Credit Scores
sub tab.

To View Credit Scores sub tab
1. Click the Credit Scores sub tab.

You can view the following details:

e Credit Score
— Model
— Bureau
— Credit Report ID
— Credit Grade
— Score
— Current

e Parameters
— Parameters
— Value
— Score

Note

If you select No Bureau in the Credit Bureau Report ID field and click Rescore, the best
match internal scoring is used for rescoring the applicant without credit bureau report.

7.5.6 Duplicate Applicant Sub Tab

Click De-dupe Applicants to display the existing customer details of the applicant. While
reviewing the de-dupe results, if the current applicant's credentials are exactly matching with
an existing customer record, you can attach the current application to the existing customer.
The same can be done by just keying in the customer ID in the applicants tab and clicking
save.

7-22 ORACLE



In case a particular customer has more than one account, on clicking De-dupe Applicants the
system displays only one account in ‘Duplicate’ sub tab. However, you can view all the
accounts held by customer in 'Existing accounts' sub tab.

To View duplicate applicant’s details, click Duplicate Applicant sub tab. In this section you
can view the duplicate applicant’s details.

A brief description of the fields is given below:

Field Do this

Source Type View the source type of the duplicate applicant

Applicant Id/ Cus Id View the applicant ID if the source type is applicant and the
customer ID if the source type is customer.

Application # View the application number of the existing applicant details
for the respective records.

Days since last appli- View the total number of days elapsed since the last applica-
cation tion date. System auto calculates this value as ‘Current sys-
tem date (minus) Last application date’.

ID View the applicant ID

First Name View the first name of the duplicate applicant

Middle Name View the middle name of the duplicate applicant

Last Name View the last name of the duplicate applicant

Date of Birth View the date of birth of the duplicate applicant

CIF View the CIF no of the duplicate applicant

SSN #/ National ID View the national ID or SSN number of the duplicate appli-
cant

Driving License # View the driving license number of the duplicate applicant

City View the city of the duplicate applicant

State View the state of the duplicate applicant

Zip View the zip of the duplicate applicant

7.5.7 Existing Account Sub Tab

The Existing Account Sub Tab displays the applicant's details, if it has been previously
maintained in the system. Also along with the applicant's details, the account number of the
applicant is displayed as a hyperlink. Clicking on the hyperlink will display the respective
account details through the Customer Service screen of Servicing module.

In case you do not see a hyperlink associated with the account number, then you might have
restricted access to the Servicing module. You can request your system administrator to
navigate to Setup > User > Access screen, and enable the ‘ACCESS TO SERCOLL UCS
CUSTOMER SERVICE TAB’ option in Security Access Definition section available in the
'Screen' tab. For more information, on defining user privileges, refer to ‘3.3.2 Screen’ section
in Setup guide.
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View the following details:

Field: View this:

Account # The account number.

Title The account title.
Relation The customer relationship.
Product The Line of credit product.
Payoff Amount The payoff amount.

Amount Due

The delinquent amount due.

Oldest Due Dt

The due date.

Status The account status.
Company The company.
Branch The branch.

Total Pay Off Amt

The payoff amount.

Total Amt Due

The total due amount.

7.5.8 Tracking Attributes Sub Tab

You can add tracking attribute information to an application at any time in the underwriting
process by using the Tracking Attribute tab.

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.

To track attributes

1. Click Tracking Attributes sub tab.

2. Select the item you want to track.

3. Click Edit to edit the following information:

Field

Do this

Sub-Parameter

View the sub-parameter

Parameter

View the parameter.

Value

Specify the information about the corresponding Value field.

4. Save changes you made to the account.

7.5.8.1 Create Tracking

1. Click Create Tracking, the system loads the tracking parameters.

e If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute

box.

e If your system has been configured to use the Sub Code field, only attributes in a
particular group appear in the Parameter display.
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7.5.9

7.6

2. Specify the requested parameter in the Value field and click Save.

Customer Search Tab

While creating an application for an existing customer, you can retrieve and copy the
customer details into the new application by using the Customer Search section of the
Simple Application Entry screen.

You can modify only the address, employment, financial details and not the demographic and
identification details.

To copy the Customer Details
1. On the Underwriting screen, click Applicants tab.
2. Click Customer Search tab.

3. Inthe Search Criteria screen, use the Comparison Operator and Values columns to
create the search criteria you want to use to find a customer.

4. Click the Search button.

The system locates and displays all the customer details that meet your search criteria
in the Search Results section.

Select Reset Criteria at any time to clear the Comparison Operator and Values columns
on the Criteria screen.

5. Inthe Search Results section, select a customer you want to load.

6. Select the relation type and click Copy Customer Details.

Business Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business section to assist in approving the Line of
credit application during underwriting. The Business Applicant screen is available and
contains the following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

o Affiliates

e Other details

If there are no business information associated with the application, the Business Applicant
tab is unavailable.

To complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on the Underwriting screen.
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2. Click BusinessTab.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Organization Type

Select the organization type.

Business Type

Select the type of the business.

Business Name

Specify the name of the business.

Legal Name

Specify the legal name of the business.

Tax ID

Specify the tax identification.

Start Date

Specify the business start date.

# of Employees (Cur)

Specify the current number of employees at the business.

# of Employees

Specify the number of employees at the business after
financing.

Contact Person

Specify the contact person at the business.

Business Checking
Bank

Specify the bank name of the business’s checking account.

Bank Acc #

Specify the bank account number.

Avg Checking Balance

Specify the average checking balance.

# of Locations

Specify the number of locations of the business.

7-26

ORACLE



7.6.1

Field:

Do this:

Management Since

Specify the year the current management was established.

4. Perform any of the Basic Actions mentioned in Navigation chapter

Address Sub Tab

You can enter more than one address for the business.

To complete the Address Sub Tab
1. Click Address Sub Tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Address Type Select the address type.
Country Select the country.
Address # Specify the building number.

Own /Line of credit

Select the ownership type.

Comment Specify a comment.
Postal Type Select the address type.
Street Pre Select the street prefix (directional).

Street Name

Specify street name

Street Type

Select the street type.

Street Post

Select the street postfix (directional).

Apt #

Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
Phone Specify the phone number.

3. Perform any of the Basic Actions mentioned in Navigation chapter

4. |If there are more than one addresses associated with business, click Save And Add and
add the address details.
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7.6.2

7.6.3

Telecoms Sub Tab

The Business tab’s Telecoms sub tab needs to be completed, if additional phone numbers for
the business exist. If not, this sub tab can be ignored.

To complete the Telecoms sub tab

1. Click Telecoms sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Type Select the telecommunication type.

Phone Specify the phone number.

Extn Specify the phone extension.

Current If selected, indicates that this is a current telecom.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Financials Sub Tab

The Business tab’s Financials sub screen only needs to be completed if financial assets exist
on the application for the business. If not, this sub screen can be left blank.

To complete the Financials sub tab
1. Click the Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Type Select financial type; for example, liquid assets, retirement assets,
and so on.

Source Specify source; for example, stocks, 401K, rent received, and so
on.

Currency Select the currency of the asset.

Amount Specify amount.

Line of credit The system displays the Line of credit currency amount

Currency

Amount

Comment Specify comment, if any.

Include Check this box to include this record in calculations on the Other
Details sub section.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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7.6.4

7.6.5

Liabilities Sub Tab

The Business Applicant link’s Liabilities sub screen only needs to be completed if financial
liabilities exist on the application for the business. If not, this sub screen can be left blank.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Type Select the liability type.
Currency Select the currency.

Line of credit Currency
Amount

The system displays the Line of credit currency amount

Amount Specify the liability amount.
Frequency Select the frequency.
Account Type Specify the account type.

Line of credit Currency
Account Balances

The system displays available Line of credit currency
account balance.

Account Balance

Specify the account balance.

Comment

Specify comments, if any.

Include

Check this box to include this record in calculations on
the Other Details sub screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Partners Sub Tab

You can enter more than one partner for the business.

To complete the Partners sub tab

1. Click Partners sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

First Name Specify the partner’s first name.
Mi Select the partner’s middle name.
Last Name Specify the partner’s last name.
Suffix Specify the partner’s suffix.
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Field:

Do this:

SSN # Specify the partner’s social security number.
Birth Dt Specify the partner’s birth date.

Birth Place Specify the partner’s birth place.

Title Select the partner’s title.

Ownership (%)

Specify the percentage of ownership held by the customer.

Net worth

Specify the partner’s net worth.

Gross Income

Specify the partner’s gross income.

Language Specify the partner’s language.
Nationality Specify the partner’s nationality.
Country Select the partner’s country code.
Address # Specify the partner’s address number.

Address Line 1

Specify the partner’s first address.

Address Line 2

Specify the partner’s second address line.

Zip Select the partner’s zip code.
For non-US country, you have to enter zip code.
Zip Extn Specify the partner’s zip extension.
City Specify the partner’s city.
State Select the partner’s state.
Phone Specify the partner’s phone number.
Extn Specify the partner’s phone extension.
Email Specify the partner’s email.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Affiliates Sub Tab

You can enter more than one affiliate for the business.

To complete the Affiliates sub tab
1. Choose Affiliates sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Organization
Type

Select the affiliate’s organization type
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Field: Do this:

Legal Name Specify the affiliate’s legal name

Business Name Specify the affiliate’s business name

Tax ID Specify the affiliate’s tax identification

Ownership (%) Specify the affiliate’s percentage of ownership

# of Employees Specify the affiliate’s number of employees

NAICS CODE Specify the affiliate’s North American Industry Classification
System code.

Country Select the affiliate’s country code.

Address # Specify the affiliate’s address number.

Address Line 1 Specify the affiliate’s first address line.

Address Line 2 Specify the affiliate’s second address line.

Zip Select the affiliate’s zip code.

For non US country, you have to enter zip code.

Zip Extension Specify the affiliate’s zip extension.
City Specify the affiliate’s city.
State Select the affiliate’s state.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.6.7 Other Details Sub Tab

The Other Details sub screen records information regarding monetary amounts associated
with the business such as profits, sales, and expenses.

To complete the Other Details sub tab
1. Click Other Details sub tab.
2. Click Edit.

3. Verify financial details as well as assets and liabilities linked to the business.

A brief description of the fields is given below:

Field: Do this:

Other Details section

Currency Select the currency.
Business Type Select the type of business.
Analysis Frequency Select the analysis frequency.

Line of credit Currency The system displays the Line of credit currency business’s
Gross Margin Factor gross margin factor
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Field:

Do this:

Gross Margin Factor

Specify the business’s gross margin.

Organization Type

Select the type of organization.

Line of credit Currency
Income

The system displays the Line of credit currency business
income amount.

Income

Specify the business’s income amount.

Line of Credit Currency
Collection Average

Specify the Line of Credit currency collection average.

Collection Average

Specify the collection average.

Line of CreditCurrency
Proj Coll Avg Annual

Specify the Line of Creditcurrency annual projected collec-
tion average.

Proj. Coll.Avg.Annual

Specify the annual projected collection average.

Line of CreditCurrency
Book List

Specify the Line of Creditcurrency business booklist.

Book List

Specify the business booklist.

Line of CreditCurrency
Turn Over

Specify the Line of Creditcurrency turnover amount.

Turn Over

Specify the turnover amount.

Line of CreditCurrency
Capital Amount

Specify the Line of Creditcurrency capital amount.

Capital Amt

Specify the capital amount.

Line of CreditCurrency
Earned Surplus

Specify the Line of Creditcurrency earned surplus amount.

Earned Surplus

Specify the earned surplus amount.

Line of CreditCurrency
Gross Profit

Specify the Line of Creditcurrency gross profit amount.

Gross Profit

Specify the gross profit amount.

Line of CreditCurrency
Net Profit

Specify the Line of Creditcurrency net profit amount.

Net Profit

Specify the net profit amount.

Line of CreditCurrency
Working Capital

Specify the Line of Creditcurrency working capital amount.

Working Capital

Specify the working capital amount.

Line of CreditCurrency
Annual Sales

Specify the Line of Creditcurrency annual sales amount.

Annual Sales

Specify the annual sales amount.
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Field:

Do this:

Line of CreditCurrency
Projected Sales

Specify the Line of Creditcurrency projected sales amount.

Projected Sales

Specify the projected sales amount.

Line of CreditCurrency
Equity

Specify the Line of Creditcurrency equity amount.

Equity

Specify the equity amount.

Open Delq

Specify the open delinquency amount.

Line of CreditCurrency
Business Expenses

Specify the Line of Creditcurrency business expenses
amount.

Business Expenses

Specify the business expenses amount.

Line of CreditCurrency
Personal Expenses

Specify the Line of Creditcurrency personal expenses
amount.

Personal Expenses

Specify the personal expenses amount.

Line of CreditCurrency
Total Expenses

View the Line of Creditcurrency total expenses amount.

Total Expenses

View the total expenses amount.

Line of CreditCurrency
Annual Proj Sales Amt

View the Line of Creditcurrency annual projected collection
amount.

Annual Proj Sales Amt

View the annual projected collection amount.

Line of CreditAnnual
Proj Exp Amt

View the Line of Credit annual projected expenses amount.

Annual Proj Exp Amt

View the annual projected expenses amount.

Line of CreditCurrency
Current Assets

Line of Creditcurrency current assets.

Current Assets/Liability
ratio

View the current asset to liability ratio.

Line of CreditCurrency
Fixed Assets

View the Line of Creditcurrency fixed assets.

Fixed Assets

View the fixed assets.

Line of CreditCurrency
Intangible Assets

View the Line of Creditcurrency intangible assets.

Intangible Assets

View the intangible assets.

Line of Credit

View the Line of Credit

Current Liabilities

View the current liabilities.

Line of Credit

View the Line of Credit
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Field:

Do this:

Long Term Liabilities

View the long term liabilities.

Line of Credit

View the Line of Credit

Total Assets

View the total asset amount.

Line of Credit

View the Line of Credit total net worth amount.

Total Net worth

View the total net worth amount.

Line of Credit

Line of Credit

Total Liability

View the total liability amount.

Debt Net worth Ratio

View the debt to net worth ratio.

Current Assets/Liability
ratio

View the current asset to liability ratio.

Title 1-4

Specify the title.

Signature1-4

Specify the signature.

Request Tab

You can calculate Payment, Interest Rate, Term and Line of credit Amount using Request
tab’s Calculate button. By default, system calculates for monthly repayment term basis. The
payment frequency can be changed only in the Underwriting tab during decisioning.
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To complete Request section:

1. On the Application Entry tab, click Request tab.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields are given below:

Field

Do this

Requested Advance Amt

Specify the requested advance amount

Pmt Amt

Specify the requested payment amount.

Term

Specify the requested term (number of payments).

Requested Rate

Specify the requested rate of interest.

Down Pmt%

Specify the down payment percentage

Down Pmt

Specify the down payment amount

Approx Prc

Specify the approximate cash price

Promotion

Select the promotion type from the drop-down list.

Balloon Amt

Specify the balloon amount.

Signing Dt

Specify the signing date

Probable Delivery Dt

Specify the probable delivery date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

If you want system to calculate,
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1. Select the record you want to work with and from the drop-down option, select the option
you want system to calculate:

e CALCULATE PAYMENT

e CALCULATE INTEREST RATE
e CALCULATE TERM

e CALCULATE LOAM AMOUNT

2. Click Calculate. The system displays the requested calculation in the respective field.

Itemization Sub Tab

The Itemizations sub tab enables you to add or verify any itemized amounts associated with
the application. The list of itemizations is determined by the product you select in the master
screen during the application entry process. The Itemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the Itemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub tab on the Underwriting screen.

Application request details need to be essentially entered in the itemization sub tab for pre-
screening to be successful. Else, the system displays error and application would not proceed
to the next level in work flow. The details of down payment, trade-in, insurance, fees etc. and
the total sale price are recorded under itemization.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Itemizations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
ltemization View the itemization.
+/- View whether the itemized amount is added or subtracted

from the Line of credit amount.

Requested Amt Specify the requested amount.

Comment Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)

To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.
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2. Click Request > Trade-In.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Trade-In

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.
Body Specify the body of the asset.
Identification # Specify the identification number.
Description View the asset description.
Valuation

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.

Pay Off Amt (-)

Specify the payoff amount.

Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supplement | Specify the valuation supplement.

Edition Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter

Subvention Sub Tab

With the Subvention sub tab, available only for Line of credit, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Subvention Plan section:

Plan Select the subvention plan.
Description View the subvention plan description.
Sub Plan Select the sub plan.

Sub Plan Description

View the subvention sub plan description.

Subvention Type

View the subvention type.

Include

Check this box to include this record in calculations on the
Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Decision Tab

If the application was initially approved automatically, the system displays its
recommendations on the Decision tab’s Approved section.

If the application was initially rejected automatically, the system displays its reasons on
the Decision link’s Stipulation sub tab.

If you choose to approve or reject the Line of credit manually, you must manually select
the pricing (rule) set by the portfolio company for a specific product. The system validates this
pricing against the information in the System Recommendation sections. The information in
the Requested section comes from the application entry process and can be edited.

e If the data meets your approval, change the status of the application to either
APPROVED or REJECTED and enter any stipulations.

e If you reject the application, change the status to REJECTED and enter the reasons for
the adverse action on the Stipulations sub screen.

On clicking Calculate, you can calculate the Line amount, rate, term, and payment. You
can use the calculator available in Tools section for completing this step. For detailed
information on using the Calculator tools, refer “Tools” chapter in the document.

To verify the application decision data

1. Open the Underwriting screen and load the underwriting application you want to work

with.
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2. Click Decision tab.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

— A brief description of the fields is given below:

Field:

Do this:

Pricing section

Current

Check this box to indicate that this is the current deci-
sion.

Pricing

View the pricing.

Decision Dt

View the decision date.

Underwriter

View the underwriter id.

Status

View the application status.

Sub Status

View the application sub-status.

Approved section

Index

Specify the index type.

Approved Index Rate

Specify the approved index rate.

Approved Margin
Rate

Specify the approved margin rate.

Approved Rate

Specify the approved rate.

Maturity Index

Select the approved maturity index.
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Field: Do this:

Maturity Margin Rt Specify the maturity margin rate.
Credit Limit Specify the credit limit.
Promotion Select the promotion.
Grade Select the credit grade.
Score Specify the credit score.
Draw Term Specify the draw term.
Repmt Term Specify the repayment term.
Bureau 1 Specify the Bureau 1.
Bureau 2 Specify the Bureau 2.
Bureau 3 Specify the Bureau 3.
Comments Specify comments, if any.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Click Select Pricing.

The system determines the best pricing match of all enabled Line of credit pricing strings
in the Setup menu and displays the results in the Pricing and Approved sections.

6. Re-Score

A 'Re-Score' button is available next to 'Calculate’. Whenever any sensitive Financial or
Collateral information is amended in the Application, OFSLL displays a warning
message 'Scoring sensitive information is changed. Re-score the application'. You need
to click on Re-Score to re-validate the grade and pricing accordingly.

The display of the warning message to Re-score the application can be controlled using
the respective System parameter. If the defined System Parameter is flagged 'Y, only
then the message is displayed.

If you are underwriting a Line of credit, record the following information on the Decision
tab:

7. If you are approving the application, complete the Approved section with the values you
want to approve as an underwriter. You can update the default values that appeared
when you selected the pricing string in step 3. (The system calculator may be of use when
completing this section. For more information, refer the Tools chapter.)

8. Click Calculate. The system displays the decision calculation in the respective field.

System Recommendation

The System Recommendation sub screen displays the system generated Score, Decision
and Grade. You will also be able to view the request details of the application under
'Requested' section itself.

A brief description of the fields in System Recommendation section are given below:

Field:

Do this:

Score

View the system recommended score.
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Field:

Do this:

Decision

View the system recommended decision.

Grade

View the system recommended grade.

A brief description of the fields in Requested section are given below:

Field

Do this

Requested Advance Amt

View the requested advance amount

Pmt Amt

View the requested payment amount.

Term

View the requested term (number of payments).

Requested Rate

View the requested rate of interest.

Down Pmt%

View the down payment percentage

Down Pmt View the down payment amount

Approx Prc View the approximate cash price

Promotion View the promotion type from the drop-down list.
Balloon Amt View the balloon amount.

Signing Dt View the signing date

Probable Delivery Dt

View the probable delivery date.

Stipulations Sub Tab

The Stipulations sub screen allows to add any stipulations or reasons for adverse action you
want to attach to the application. Stipulations are items that need to be addressed before the
Line of credit can be funded.

If the application was automatically rejected during the application entry edits, the system
displays the automatically generated adverse action codes in this sub screen. If the
application is manually rejected by the Underwriter due to adverse action reasons received
from bureau or otherwise, the same can be recorded for each of the applicant.

In addition, you can enter comments against specific stipulations as required. Whenever a
Stipulation is marked as 'Not Applicable' it becomes mandatory to specify the reason in
comments field. Else, system prompts for the reason while processing the application.

To add or view stipulations or reasons for adverse action

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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7.8.2.3

A brief description of the fields is given below.

Field: Do this:

Type Select the reason type. Type can be Stipulation Reasons or Adverse
Action Reasons and Adverse Action Reasons can also be those
received from Bureau.

Name The system displays all applicant’s name in the drop down list. You

can select the name of the applicant for whom adverse action reason
needs to be recorded. In case the stipulation reason is at the appli-

cation level, then select ALL.

Code Select the reason.

Description Specify the required description.

Stips Satisfied Use the Yes/No/NA buttons to indicate if you verified the stipula-
tion(s) in the Type field

Comment Specify the comment.

Verified By The system updates the user ID of the person who verified the
details

Verified Dt The system updates the date when the details are verified.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

If your system is set up to manually load predefined stipulations, click the Load Stipulations
button (For more information, refer the following section, Loading Stipulations.)

Add Multiple

The system enables you to add multiple records to stipulations using the 'Add Multiple' option.
To add multiple stipulations
1. Click the drop down list adjacent to the 'Add Multiple' button.

2. Select the check box against to the required stipulations. You can also select ’All’ to load
all the available stipulations.

Click Add Multiple.

4. If required, you can perform any of the Basic Actions mentioned in Navigation chapter.

Copying Stipulations

The system enables you to automatically transfer stipulations from previous decisions on the
Stipulations sub screen with the Copy Stipulations button. This is particularly useful when you
are rehashing an application and want to use the same stipulations as those in place for the
previous decision.

Loading Stipulations

The system supports the automatic generation of default stipulations on the Underwriting
screen’s Stipulations sub screen. The default stipulations can be maintained by company,
branch, product, state, application status and application sub-status. When the application
status changes (either manually and automatically), the system populates the maintained
stipulations with a Stips Satisfied indicator of ‘No’. You can review and update the stipulations
accordingly.
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You have the option to manually load predefined stipulations by clicking the Load Stipulations
button on the Stipulation screen.

To load predefined stipulations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations.

Click Load Stipulations. The system loads the default stipulations on the Stipulations
sub screen.

4. Use the Yes/No/NA buttons in the Stips Satisfied column to indicate if you verified the
stipulation(s) in the Type field.

5. Click Save on the Stipulations sub screen.

Itemization Sub Tab

The Itemizations sub screen enables you to add or verify any itemized amounts associated
with the application. The list of itemizations is determined by the product you selected in the
master screen during the application entry process. The Itemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the ltemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub screen on the Underwriting screen.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Itemizations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
ltemization View the itemization.
+/- View whether the itemized amount is added or subtracted

from the Line of credit amount.

Requested Amt Specify the requested amount.
Approved Amt Specify the approved amount.
Discount Rate Specify the discount rate.
Comment Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)
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To complete the Trade-In sub screen

1.

with.

2. Click Decision > Trade-In sub tab.

Open the Underwriting screen and load the underwriting application you want to work

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Trade-in section

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.

Identification #

Specify the identification number.

Body

Specify the body of the asset.

Description

View the asset description.

Valuation section

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.

Payoff Amt (-)

Specify the payoff amount.

Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supple-
ment

Specify the valuation supplement.

Edition

Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Rate Schedule Sub Tab

The Rate Schedule sub screen is only available for variable rate Line of credit and displays

the rate adjustment frequency information based on product setup.

To view the Rate Schedule sub screen

1.

with.
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2. Click Decision > Rate Schedule sub tab. Click View.

A brief description of the fields is given below:

Field: View this:

Seq The rate adjustment sequence number.

Adjustment Frequency Type The rate adjustment frequency type.

Period The rate adjustment period for the frequency.

# of Adjustments The number of rate adjustments for the frequency.

Subvention Sub Tab

With the Subvention sub tab, available only for Line of credit, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub tab

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Select the sub plan.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the
Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In Subvention Detail section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below.

Subvention Detail section:

Participant View the participant.
Participant Type View the participant type.
Collection Method View the collection method.

7-45 ORACLE



7.8.7

Rate

View the subvention rate.

Rent Factor

View the rent factor

Calculation Method

View the subvention calculation method.

Factor

View the factor.

Calculated Amount

View the calculated subvention amount.

Subvention Amount

Specify the subvention amount.

Include

View if the subvention is included in the application or not.

Total Subvention Rate

View the total subvention rate.

Total Subvention Amt

View the total subvention amount.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Select the Initialize button to reset the subvention amount to zero.

8. Select the Calculate button to calculate the subvention amount.

Multiple Offers sub tab

When you click Select Pricing on the Decision tab’s Pricing section, multiple offers appear on
the new Multiple Offers sub page. Use the Multiple Offer sub page to select the offer you want

to use.

Note

The Multiple Offers sub tab will be enabled only if the Multioffer company parameter is set

to Yes.

To view multiple pricing offers

1. Open the Underwriting screen and load the application you want to work with.

2. Click Decision, then click the Multiple Offers sub tab.

3. If you are underwriting a Line of credit, view the following information on the Multiple

Offers sub:
Field: Do this:
Pricing View the pricing.
Term Specify the approved term.
Rate Specify the approved rate.
Pmt Amt Specify the approved payment amount.
Index View the approved index.
Index Rate View the approved index rate.
Margin Rate Specify the approved margin.

Maturity Index

Specify the approved maturity index.
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Field: Do this:

Maturity Rate Specify the approved maturity rate.

Accepted If selected, indicates that the pricing is accepted. Only
one of the current pricings can be accepted.

Current If selected, indicates that the pricing is current.

Note: All the available pricings are selected as current.

4. On the Multiple Offers sub tab, select the offer once the application is move to Approved
status.

Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

If there are any adverse comments received from the Bureau, system displays them under
'Exceptions/ Comments' section against the specific Bureau record to alert the User.
Following are some of the reasons:

1. Application Indicates Potential Fraud

Bureau Indicates Social Security Number Variance
Duplicate Application Exists

Bureau Indicates a Possible Current Delinquency
Bureau Indicates Bankruptcy

Bureau Indicates Consumer Statement

Bureau Indicates a Possible Repossession

Bureau Reports OFAC hit

© N o o M 0N

9. Bureau Reports Applicant as Deceased

10. Potential Delinquencies for Auto Loans in Past 12 Months
11. Customer Rate (APR) Exceeds the State Usury Rate

12. Open Consumer Credit Counselling

The reasons will also be displayed in the Summary tab in 'Bureau' details under 'Exceptions
/Comments' section.

To verify the credit bureau data using the Bureau tab

1. Open the Underwriting screen and load the underwriting application you want to work
with.
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2. Click Bureau.
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3. Inthe Bureau Details section, view the following information:

Field:

View:

Type

The credit bureau request type.

Bureau

The credit bureau.

#

The credit bureau request number.

Status

The status of credit bureau request.

Dt

The credit bureau request date.

Report

The credit bureau report type.

Credit Bureau
Reorder#

The credit bureau reorder number.

App Ind

If selected, indicates that a bureau was pulled for an application.

4. In the Applicant/Customer Detail section, view the following information:

Field:

Do this:

Type

View the relation type.

First Name

Specify the first name.

Specify the middle name.

Last Name

Specify the last name.

Status

View the credit bureau request status.

7-48

ORACLE



Field:

Do this:

Birth Dt Specify the date of birth.

SSN Specify the social security number.
Note: If the organizational parameter UIX HIDE RESTRICTED _-
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Suffix Select the generation.

Include Debt | Select to include credit bureau information in the Liabilities section of
the Summary sub screen.

Populate Select to load debt information from the credit bureau in the Liabili-

Debt ties section of the Summary sub screen.

Address Type | Select the address type.

Country Select the country.

Address # Specify the building number.

City Specify the city.

State Select the state code.

Street Pre Select the street pre type.

Street Name

Specify the street name.

Street Type

Select the street type.

Street Post

Select the street post type.

Apt #

Specify the apartment number.

Address Line
2

Specify the address line 2.

Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
Phone Specify the phone number.

5. Inthe Report Header section, view the following information:

Field: View:

Bureau The bureau.
First Name The first name.
Mi The middle initial.
Last Name The last name.
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Field: View:

SSN The social security number.

Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Birth Dt The birth date.

Note: The SSN and Birth Dt fields in Report Header section are displayed in red if
there is a mismatch in the respective data present in the above Applicant/Customer
Details section.

Report Dt The report date.

Onfile Dt The on file date.

Credit Report | The credit report id.
id

Best Match The best match.

6. Click Bureau Report.

The system parcels out the details from the credit bureau report in the Bureau screen’s
sub tabs (Summary 1, Summary 2, Tradelines, Public Records, Collections, Fraud
Messages, Inquiries, Also Known As, Consumer Statements, and Credit Scores).

7. Click Summary 1 sub tab.

8. You can view the following information:

Field: View:

Trades Records of extended installment payments, mortgage and revolving
credit, as detailed in the credit bureau report.

Bankruptcy | The total number of times the applicant has applied for Chapter 7,
Chapter 11 and Chapter 13 bankruptcies, recently and throughout life.

Past Due The total number of times the applicant has been past due on pay-
ments by 30, 60, or 90 days in the last year, two years, and throughout
life.

Public Number of legal actions, including liens, public records, and judgments

Records over the course of the applicant’s life, as well as any that are currently
open.

Collection Trades referred to an outside vendor for collection.

Credit View the FICO and bankruptcy scores.

Scores

Statistical Ages of the oldest and newest trades, as well as the average age of

Trade Ages | the open and total trades.

Derogatory | Tradelines that an action other than being late was reported; this
Trades includes collections, repossessions, charge offs, and bankruptcies.

9. Click Summary 2 sub tab
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10. You can view the following information:

In this .

. View:

section:

Trades Records of extended credit for auto, bank, credit card, retail, Line of
creditfinance, and sales finance Line of credit, as detailed in the credit
bureau report.

Inquiries Requests for a credit report regarding Line of credit in the Trades sec-
tion over the last six months, as well as total requests over 6, 12, and
24-month periods, as well as the newest and oldest request.

Balance The total balance of retail and bank trades, as well as the high balance
of each.

Open The following information for all of the customer’s open trade lines: the

Derogatory | shortest and longest period of time (in months) since the customer’s
most recent minor derogatory (30-60 days late), major derogatory (90-
180 days late), and derogatory (bankruptcy, repossession, or charge
off).

Derogatory | The following information for all of the customer’s total trade lines

(open and closed): the shortest and longest period of time (in months)
since the customer’s most recent minor derogatory (30-60 days late),
major derogatory (90-180 days late), and derogatory (bankruptcy,
repossession, or charge off).

11. Click Tradelines sub tab to view information about trade lines, such as the creditor’s
name, trade’s status, type and code and balance information

12. View the following details:

Field: View:

Creditors The creditors name.

Name

Status The status of the tradeline.

Type The type of tradeline, such as bank, first mortgage, travel card, and
SO on.

Type Code The code for the type of tradeline.

Past Due Amt

The past due amount

Balance The balance of the tradeline.

Balance Dt The balance date.

Open Dt The date the tradeline was opened.

History Dt The trade line’s history date.

History Data The trade line’s history data.

30 The number of times the tradeline was 30 days past due.
60 The number of times the tradeline was 60 days past due.
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Field:

View:

920 The number of times the tradeline was 90 days past due.
Creditors The creditor’s subscriber number.

Subscriber #

Mop The method of payment.

Account # The account number.

Credit Limit The credit limit.

Term Pmt Amt

The term payment amount.

High Balance | The high balance of the tradeline.
Reported Dt The reported date.
Duplicate If selected, the tradeline is a duplicate.

Special Exclu-
sion

If selected, the tradeline is a special exclusion.

13. Click the Public Records sub tab to view information about public records, including each
one’s type, status, and amount, as well as the date the record was filed and resolved

14. View the following details:

Field: View:

Record The record type.
Type

Status The status.
Amount The amount.
Filed Dt The filed date.
Satisfied Dt | The satisfied date.

15. Click the Fraud Messages sub screen to view information about fraudulent attempts to
use the applicant’s credit.

16. Click the Inquiries sub screen to view all the credit reports for the applicant in reverse
chronological order

17. View the following details:

Field:

View:

Inquirer Name

The inquirer’s name.

Inquirer Subscriber | The inquirer’s subscriber number.

#

Inquirer Industry The inquirer’s industry code.
Code

Inquiry Dt The inquiry date.
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7.9.1

7.9.2

Field: View:

Rate Shopping If selected, the inquiry concerned rate shopping.

Duplicate If selected, if the inquiry was a duplicate.

18. Click the Also Known As sub screen to view other names used by the applicant.

19. Click the Consumer Statements sub screen to view statements that the applicant has
issued to the credit bureau.

20. Click the Credit Scores sub screen to view the score model, the score factor, and the
score returned from the credit bureau report.

Printing the Credit Bureau Data as a Text/PDF Report

To print the credit bureau data as a text or PDF report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. In the Underwriting screen, click Bureau.

3. Inthe Bureau Report tab, the system displays the report in text format. You can also view
the report in PDF format by selecting ‘PDF’ option as View Report.

Note

Google Chrome does not support search functionality in the PDF format of the report.
Hence you have to enable the ad-hoc plug-in in chrome to use the search facility.

4. In the Print Report section, click Print Report to send the information to the default
printer.

Requesting a Credit Bureau Report Manually

The Credit Bureau Summary screen enables you to manually request a credit pull.
Information from a manual credit pull can be used to validate an application.

To manually request a credit bureau report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Bureau tab.
In the Bureau Details section click Add.

4. Specify the following information:

Field: Do this:

Applicant Select the applicant.

Spouse Select the applicant’s spouse (if applicable).
Bureau Select the credit bureau.
Report Select the credit bureau report type.

5. Click Create Request.
The system displays this information in the Bureau Details section.

7-53 ORACLE



7.10

Note

If you are requesting a report from Experian Credit Bureau for Premier Attribute Consumer
report, you can do so without impacting the consumer FICO score. To facilitate the same,
the ‘Soft Pull’ check box is to be selected in Bureau Details section. This option is available
only when the system parameter ‘EXP_PA_SOFT_PULL_IND’ is enabled in the System
Parameters screen and Bureau is selected as ‘EXP’ with Report as ‘PREMIER ATTRIB-
UTE’ in the Bureau Details section.

6. Select Include Debt and Populate Debt in the Applicant/Customer Detail section to
populate the Liability section on the Applicants link’'s Summary sub screen with data from
the credit bureau pull.

7. If you want to receive a copy of a previously pulled credit bureau report, enter the credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
section. This enables you to receive a previously pulled credit report.

8. Inthe New Request section, click Submit Request.
The system displays the latest status of the currently requested bureau report in the Bureau

Details section. When the report pull process is complete, the Status field in the Bureau
Details section changes from PENDING to CO